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SECCION 1 Descripción general
El procesador de audio DFR22 con reductor de realimentación es un procesador digital de audio, de dos entradas y
dos salidas.  Es ideal para acoplarse a sistemas de sonido como los instalados en iglesias, teatros y salas de confer-
encias. El DFR22 puede servir además como poderosa herramienta de configuración en eventos con música en vivo.
Mediante la interface gráfica con función de arrastrar y colocar del DFR22, los procesadores pueden colocarse en
cualquier punto de la trayectoria de la señal. Mediante una matriz mezcladora de 2 x 2 es posible encaminar cual-
quiera de las entradas, o ambas, hacia cualquiera o ambas salidas, teniendo además controles de nivel y polaridad.

Convenciones usadas en este documento

La interface del software del DFR22 es tan intuitiva y fácil de usar que se sentirá tentado a pasar por alto la lectura de 
la documentación y empezar a programar la unidad de inmediato. No obstante, antes de hacerlo, le recomendamos 
por lo menos leer la descripción general y leer a fondo la Guía para el uso inicial en la página 12. Las preguntas que 
tenga en cuanto al software se responden en las secciones siguientes del documento. 

Organización de esta guía

• Descripción general . . . . . . . . . . . . . . . . . . Presenta las características principales del procesador de 
audio, y describe los modos de funcionamiento de la interface y la ventana principal.

• Guía para el uso inicialDescribe los pasos básicos que hay que llevar a cabo con el software para con-
figurar el procesador de audio para una instalación determinada.

• Cómo crear una configuración prefijada . Describe los elementos de la configuración del flujo de 
señales del DFR22, tales como la estructura de ganancia del dispositivo, la conexión de la señal entre 
entradas y salidas, cómo añadir procesadores a la trayectoria de la señal y cómo trabajar con ellos desde 
la ventana principal.

• Administración del dispositivo y configuraciones prefijadas Explica cómo guardar una configuración 
prefijada en la computadora, almacenarla en el DFR22, y hacer copias de respaldo del contenido del dis-
positivo en la computadora. Explica además las características del menú [Device].

• Características del procesador . . . . . . . . . Describe las características comunes entre muchos de los 
módulos del procesador de señales, tales como los controles de nivel, la captura de imágenes 
instantáneas de los ajustes de los parámetros y cómo guardar y recuperar valores de ajuste de la com-
putadora.

• Procesadores fijos . . . . . . . . . . . . . . . . . . . Explica las características de los bloques de ganancia de 
entrada y de salida y la matriz mezcladora.

• Procesadores modulares . . . . . . . . . . . . . . Explica las características específicas de cada uno de los 
procesadores de señal con función de arrastrar y colocar.

• Clavijas de control  . . . . . . . . . . . . . . . . . . . Describe la arquitectura interna del control por dispositivo 
externo del procesador de audio y explica cómo configurar las clavijas de control del DFR22 con el soft-
ware, una vez que se ha conectado el equipo físico externo.

• Seguridad  . . . . . . . . . . Describe las características de seguridad del procesador de audio que restringen 
el acceso a los parámetros de ajuste y controles del panel delantero del dispositivo.

Convenciones sobre anotaciones
• Texto en [corchetes] . . Indica una copia exacta del texto cómo aparece en la interface del software, tal 

como en las etiquetas de control, botones o comandos del menú.

• Teclas . . . . . . . . . . . . . .Como Mayús, Ctrl y Esc aparecen en negrita. Para indicar que se debe oprimir 
una combinación de teclas, o teclas junto con un clic del Mouse, se emplea el símbolo de suma de esta 
manera: Ctrl + Clic.
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Características del procesador de audio
Características del procesador de audio

El DFR22 es un procesador digital de audio con 2 entradas y 2 salidas, interface de software, sencillos controles en el 
panel delantero y capacidad para almacenar 16 configuraciones prefijadas. Proporciona conversión de 24 bits, mues-
treo a 48 kHz y un rango dinámico de 100 dB.

Interface de software con funciones de arrastrar y colocar
La interface de computadora del procesador de audio imita los diagramas en bloques funcionales utilizados
para el diseño de sistemas de sonido. Esto hace que el software sea sumamente fácil de aprender, puesto que
la interface se hace inmediatamente familiar a los profesionales del sonido. Las configuraciones prefijadas
pueden construirse y modificarse completamente con sólo hacer clic en un elemento, arrastrarlo y colocarlo en
el lugar deseado, con el Mouse. La trayectoria de señal puede configurarse arrastrando y colocando cualquier
combinación de procesadores de señal.

Procesadores modulares de señales
Cada módulo procesador de señales se representa gráficamente por un bloque que puede manipularse con el
Mouse. Después de colocar un procesador en el diagrama de flujo de señales, se puede acceder a sus ajustes
haciendo doble clic en cada bloque para abrir su ventana de parámetros. Los valores de ajuste pueden guard-
arse y recuperarse de la computadora, y pueden copiarse a otros módulos similares. Los ajustes de los proce-
sadores también pueden sincronizarse usando la función de enlace. El procesador de audio DFR22 incluye la
selección siguiente de módulos procesadores de señales.

Control por dispositivo externo
Después de la instalación y programación del DFR22 con la interface de software, el usuario podrá controlarlo
con una computadora o un controlador AMX o Crestron. Además, las clavijas de control del panel trasero
pueden conectarse a equipos externos que permiten al DFR22 responder al cierre de contactos, a poten-
ciómetros y a interruptores.

Seguridad
La función de seguridad le da al instalador la tranquilidad de saber que el dispositivo no puede ser alterado sin
autorización, después de haberlo instalado. El acceso puede restringirse completamente, al grado de que el
usuario no pueda cambiar ajustes ni usar los controles del panel delantero. Sólo se podría desplegar el ajuste
de los parámetros de la configuración prefijada seleccionada a través del software. El nivel de control del
usuario también puede personalizarse para otorgarle acceso a ciertos ajustes, pero no a otros.

Requisitos mínimos del software del DFR22

Para su funcionamiento adecuado, la versión 3 del software del DFR22 requiere una computadora con las siguientes 
especificaciones:

• Disco duro con 20 MB de espacio disponible
• Unidad lectora de CD-ROM
• Pantalla VGA con nivel de definición 640 x 480/256 colores, o superior
• Mouse u otro dispositivo de selección

• El poderoso reductor digital de realimentación 
de Shure, con procesadores monofónicos y 
estereofónicos.

• Control automático de ganancia
• Ecualizadores gráficos de 10 y 30 bandas con y 

sin combinación
• Ecualizadores paramétricos de 3 a 10 bandas 

con filtros atenuadores y limitadores

• Red de cruce y bifurcador de dos vías
• Subwoofer
• Compuerta/expansor de atenuación
• Compresor/limitador monofónico y estereofónico 

con opción de articulación suave
• Atenuador automático de música
• Limitador de tope de picos
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Modos de interface
La velocidad del procesador y la memoria requerida varían según la versión de Windows en uso y el número de pro-
gramas que se ejecuten simultáneamente. Si se usa el software del DFR22 simultáneamente con programas tales 
como SIA-Smaart® o Gold Line TEF™ se requiere un procesador más veloz y más RAM. La tabla siguiente indica los 
requisitos mínimos para ejecutar el software del DFR22 sin tener otros programas en ejecución, incluso los de protec-
ción contra virus, barreras de software, programas de mensajería o de correo electrónico.

Modos de interface

La interface tiene dos modos principales de funcionamiento: Modo de diseño y modo en vivo. Esto le brinda la alterna-
tiva de crear configuraciones para el DFR22, sin importar si la computadora está conectada al dispositivo o no lo está. 
Hay ciertas funciones que son específicas de cada modo, las cuales se explican en este manual.

Modo de diseño
Cuando se arranca el programa, siempre inicia en modo de diseño. Este es el modo que se utiliza para
crear configuraciones prefijadas que luego se almacenan en el DFR22. En este modo no es necesario que
la computadora esté conectada al dispositivo. Podrá crear y guardar en la computadora configuraciones
prefijadas, recuperándolas posteriormente para enviarlas al dispositivo a través de la conexión tipo RS-232.
Esto le da la capacidad de diseñar configuraciones prefijadas en un lugar diferente de aquél en donde se ha
instalado el equipo.

Modo en vivo
Este modo le permite hacer ajustes en tiempo real a las configuraciones prefijadas del equipo físico, mientras
la computadora está conectada al DFR22. Esto le permite escuchar instantáneamente los cambios hechos al
procesamiento de la señal luego de haber modificado los ajustes, lo cual facilita el ajuste final de las configura-
ciones prefijadas en el sitio. Todo lo que se hace en el modo en vivo se escribe directamente en la configu-
ración prefijada seleccionada en la actualidad.

Modo de presentación preliminar
Cuando se trabaja en el modo en vivo con un dispositivo que contiene varias configuraciones prefijadas, éstas
pueden recuperarse de modo individual para modificarlas en tiempo real. Cuando se selecciona una configu-
ración prefijada para cargarla en un diagrama de flujo de señales, la ventana pasa a modo de presentación
preliminar para darle la oportunidad de verificar su selección antes de designarla como la siguiente configu-
ración prefijada para uso en vivo. La interface retorna a modo en vivo cuando se carga la configuración prefi-
jada, o si se anula la operación.

Versión de Windows Velocidad del proce-
sador RAM

98 Second Edition Pentium 166 MHz 48 MB
NT Pentium 233 MHz 64 MB
ME Pentium 300 MHz 64 MB
2000 Professional Pentium 300 MHz 96 MB
XP Professional, Home Pentium 300 MHz 128 MB
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Descripción general
La ventana principal

Esta ventana, que aparece abajo en la Figura 1-1, es su principal espacio de trabajo en la interface del software. Se 
puede modificar su tamaño, o ampliarla al máximo para que ocupe toda la pantalla. Si se cierra esta ventana, se sale 
del programa.

1. Barra de títulos: En el modo en vivo, despliega datos 
específicos del dispositivo. Para una descripción más 
detallada, consulte la sección dada a continuación.

2. Menú principal: Brinda acceso a comandos de menú 
específicos para el dispositivo y el diagrama de flujo de 
señales.

3. Barra de control: Despliega controles específicos al dis-
positivo y el diagrama de flujo de señales. Para mayor 
información, consulte la sección en la página siguiente.

4. Diagrama de flujo de señales: El espacio usado para 
crear las configuraciones prefijadas. Para mayor infor-
mación, consulte la sección en la página siguiente.

5. Barra de estado: Despliega controles e indicadores 
para el diagrama de flujo de señales. Consulte la sección 
en la página 11 para mayor información.

Barra de títulos
La información que aparece en la barra de títulos de esta ventana cambia según el modo de funcionamiento.
En el modo de diseño, la barra de títulos indica: “DFR22: Offline” (fuera de línea), e indica el nivel de seguridad
por omisión. En el modo en vivo, despliega información correspondiente a la unidad específica a la cual está
conectado el sistema, como se muestra abajo en la Figura 1-2.

1. N° de identificación de dispositivo: El número de 
identificación del dispositivo se fija por medio de los inter-
ruptores DIP que están en la parte posterior del mismo. 
Consulte las instrucciones en la Guía de instalación.

2. Nombre del dispositivo: Para designar el nombre del 
dispositivo estando en el modo en vivo, seleccione 
[Devices>Name Device] (dispositivos>designar nombre de 

dispositivo) a partir del menú principal. Para mayor infor-
mación consulte la Guía para el uso inicial, paso 5, en la 
página 13.

3. Nivel de seguridad: En el modo en vivo, esto indica el 
nivel actual de seguridad que se ha fijado para el disposi-
tivo. Para mayor información consulte la sección 
Seguridad en la página 98.

FIGURA 1-1: Ventana principal

1

2

3

4

5

FIGURA 1-2: Barra de títulos

1 2 3
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La ventana principal
Barra de control
Como se ilustra más abajo, esta sección de la ventana cambia de apariencia y función, según el modo de fun-
cionamiento en el que se esté trabajando.

1. Botón [Live Mode] (modo en vivo): Haga clic en este 
botón para cambiar al modo en vivo, el cual le permite ver 
una presentación preliminar y editar cualquiera de las con-
figuraciones prefijadas guardadas en el dispositivo en la 
actualidad. La computadora deberá estar conectada al 
DFR22 para poder entrar a este modo.

2. Botón [Design Mode] (modo de diseño): Haga clic 
en este botón para cambiar al modo de diseño. La configu-
ración prefijada en la cual se estaba trabajando en el modo 
en vivo permanece cargada en el diagrama de flujo de 
señales.

3. Cuadro de información: Visualiza detalles acerca de la 
configuración prefijada que está cargada en la actualidad 
en la pantalla, incluyendo el nombre, la última fecha en la 
cual se guardó y su descripción. 

4. Botón [Store Preset] (guardar configuración pre-
fijada): Púlselo para guardar en el DFR22 la configu-
ración prefijada actual.

5. Botón [Recall Preset] (recuperar configuración 
prefijada): Púlselo para cargar en el diagrama de flujo de 
señales una configuración prefijada en el DFR22 y trabajar 
con ella en el modo de diseño.

6. Botón [Save As] (guardar como): Haga clic en este 
botón para guardar en la computadora la configuración 
prefijada actual.

7. Botón [Open] (abrir): Púlselo para cargar en el dia-
grama de flujo de señales una configuración prefijada 
guardada en la computadora.

8. Selector de configuración prefijada: Haga clic en 
este menú desplegable para seleccionar de la lista alguna 
de las configuraciones prefijadas almacenadas en el dis-
positivo.

9. Medidores LED: Estos medidores LED indican los nive-
les de la señal de audio en el dispositivo. Pueden desple-
garse y ocultarse haciendo clic sobre ellos, o 
seleccionando [View>Enable I/O Meters] (ver>activar 
medidores de E/S) en el menú principal..

10. Botón [Load] (cargar): Púlselo para cargar en el dia-
grama de flujo de señales la configuración prefijada prese-
leccionada.

11. Botón [Cancel] (anular): Púlselo para volver a la con-
figuración prefijada anterior.

Diagrama de flujo de señales
En el diagrama de flujo de señales se hace una representación gráfica del modo en que las señales de audio
atraviesan la estructura de ganancia del procesador, y los bloques procesadores que se hayan dispuesto en
las filas de canales de entrada y salida. Con cada configuración prefijada que se cree en el diagrama de flujo
de señales se almacenan la configuración de los bloques procesadores y las conexiones de encaminamiento
de señales que haya creado. Podrá crear configuraciones prefijadas en el modo en vivo o en el de diseño, y
almacenarlas ya sea en el dispositivo o en la computadora. En el modo en vivo, la configuración prefijada que
se ha cargado en el diagrama de flujo de señales corresponde a la configuración actualmente activa. Para
activar otra configuración prefijada, use el selector desplegable de éstas, que aparece en la información de la
casilla ( N° 8 más arriba).

1 2 3 4 5 6 7

9 10

11

Modo de diseño:

Modo en vivo:

Modo de presentación
preliminar:

8

FIGURA 1-3: Barra de control
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Descripción general
Indicador de modo
Despliega el modo actual de funcionamiento del diagrama de flujo de señales, como se ilustra a continuación.

Filas de canales de entrada y salida
Estas filas son representaciones gráficas de los canales de entrada y salida del DFR22. Contienen los
bloques de ganancia y mezcla que constituyen la estructura de ganancia del dispositivo, como se explica
en la sección Estructura de ganancia en la página 17. También contienen los espacios vacíos en los que
se ponen los bloques procesadores, que se podrán arrastrar y colocar a partir de la “Processor Toolbox”
(caja de herramientas de procesadores, consulte la página 11).

1. Bloque de ganancia de entrada: Esta es la etapa ini-
cial de la estructura de ganancia del procesador de audio. 
Si se hace doble clic en este bloque, se abre la ventana de 
“Input Gain” (ganancia de entrada), en la cual se brindan 
las alternativas de escalas de –10 dBV/+4 dBu, silen-
ciamiento de canal, control de polaridad, y un control de 
nivel de +10/-infinito dB para cada canal de entrada. Aquí 
también se designa el nombre de cada canal de entrada.

2. Rótulo de canal de entrada: Aquí se despliega el 
rótulo dado al canal en la ventana de “Input Gain” (ganan-
cia de entrada).

3. Espacio para procesador: Estos espacios sirven 
como recipientes para los bloques procesadores modu-
lares. Pueden ocuparse con procesadores, ya sea usando 
el método de arrastre y colocación desde la “Processor 
Toolbox”, con la función [Processor>Add] (añadir proce-
sador) del menú principal, o con el menú contextual 
que se despliega si se hace clic con el botón derecho 
del Mouse y se selecciona la opción [Add Processor].

4. Puntos de mezcla:Haga clic en estos puntos para 
encaminar la señal entre las filas de entradas y de salidas. 
Se despliegan líneas entre los puntos conectados entre sí, 
las cuales representan el flujo de señales. Cada fila de 
entradas puede estar conectada a cualquiera de las filas 
de salidas, o a ambas.

5. Números de canal: Estos números corresponden a 
cada uno de los canales de entrada y de salida.

6. Selectores de entrada: Haga clic en estos selectores 
de entrada numerados, en el punto de mezcla de cada fila 
de salidas, para encaminar instantáneamente la señal pro-
veniente del punto de mezcla del canal de entrada corre-
spondiente.

7. Bloque de mezcla: Esta es la etapa intermedia de la 
estructura de ganancia del procesador de audio. Cuando 
se hace doble clic en este bloque, se abre la ventana 
“Matrix Mixer” (matriz mezcladora), la cual permite encami-
nar la señal proveniente de cualquier fila de canales de 
entrada hacia cualquier fila de canales de salida, o hacia 
ambas, y ajustar los niveles con los controles de nivel. Esta 
ventana tiene una ficha por cada fila de canales de salida 
que contiene controles de ganancia, polaridad y silen-
ciamiento para ambos canales de entrada.

8. Bloque de ganancia de salida: Si se hace doble clic 
en este bloque, se abre la ventana “Output Gain” (ganancia 
de salida), en la cual se brindan las alternativas de escalas 
de –10 dBV/+4 dBu, silenciamiento de canal, control de 
polaridad, atenuadores de -12 dB y 18 dB y un control de 
nivel de +10/-infinito dB para cada canal de salida. Esta es 
la etapa final de la estructura de ganancia del procesador 
de audio. Aquí también se designa el nombre de cada 
canal de salida.

9. Rótulo de canal de salida: Aquí se despliega el rótulo 
dado al canal en la ventana “Output Gain”.

Modo de diseño Modo en vivo Modo de presentación preliminar

1

2 3 4 6 7

8

9

5

FIGURA 1-4: Filas de canales de entrada y salida
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“Processor Toolbox” (caja de herramientas de procesadores)
Barra de estado
Esta es la parte inferior de la “Main Window” (ventana principal).

1. Silenciar entradas: Haga clic en este control para silen-
ciar instantáneamente ambos canales de entrada.

2. Silenciar salidas: Haga clic en este control para silen-
ciar instantáneamente ambos canales de salida.

3. Medidor de utilización de DSP: Indica el porcentaje 
de los recursos digitales de procesamiento de señal (DSP) 
del DFR22 que se encuentran en uso por la configuración 
actual de bloques procesadores colocados en el diagrama 

de flujo de señales. El medidor despliega una barra verde 
que se agranda según aumenta la utilización de DSP

4. Medidor de memoria de retardo: Indica el porcentaje 
de memoria de retardo utilizado por los procesadores de 
retardo colocados en el diagrama de flujo de señales. El 
medidor despliega una barra azul que se agranda según 
aumenta la utilización.

“Processor Toolbox” (caja de herramientas de procesadores)

La “Processor Toolbox” aparece junto a la ventana principal luego de lanzar la aplicación, como se ilustra en la 
Figura 1-6. Esta ventana despliega la biblioteca de procesadores que se pueden arrastrar y colocar en espacios 
vacíos del diagrama de flujo de señales. Su tamaño vertical puede ajustarse arrastrando el borde inferior o superior 
hacia arriba o hacia abajo. Una barra de desplazamiento aparece en el lado derecho, la cual le permite acceder a 
todos los bloques procesadores, sin importar la altura de la ventana.

Mostrar y ocultar
Podrá cerrar la “Processor Toolbox” haciendo clic en la [X] de la esquina
derecha de la barra de títulos, o bien seleccionando [View>Show Proces-
sor Toolbox] (ver>mostrar caja de herramientas de procesadores) a
partir del menú principal. Para volver a abrir la “Processor Toolbox”,
vuelva a seleccionar [View>Show Processor Toolbox]. Una marca de
verificación aparece junto a esta función del menú cuando la “Processor
Toolbox” está abierta. 

Características
1. Botones de menús desplegables: Un botón de menú desplegable 

aparece sobre cada categoría de procesadores en la “Processor Tool-
box”. Haga clic en un botón para ocultar o desplegar todos los bloques 
procesadores de la categoría correspondiente.

2. Bloques procesadores: Los bloques procesadores son representa-
ciones gráficas de los módulos procesadores. Después de haberlos 
colocado en el diagrama de flujo de señales, se puede acceder a sus 
ajustes haciendo doble clic en cada bloque para abrir su ventana de parámetros. El porcentaje de recur-
sos de procesamiento de señales digitales que cada módulo procesador está empleando aparece a la 
derecha de los bloques, en la “Processor Toolbox”.

1 2 3 4

FIGURA 1-5: Barra de estado

1

2

FIGURA 1-6: “Processor Toolbox”
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SECCION 2 Guía para el uso inicial
La guía para el uso inicial describe los pasos básicos requeridos para la configuración completa del procesador de
audio. Antes de intentar seguir estas instrucciones, familiarícese con la sección Descripción general, la cual presenta
algunas funciones básicas de la interface de software.

Muchos de estos pasos pueden llevarse a cabo sin tener la computadora conectada al dispositivo, guardando sus
configuraciones prefijadas en la computadora y transfiriéndolas posteriormente al equipo físico. Para familiarizarse
completamente con las funciones del DFR22, estas instrucciones se han redactado suponiendo que se satisfacen las
condiciones siguientes:

• Se está trabajando con la computadora conectada al dispositivo.
• La instalación incluye el control por dispositivos externos.
• Se requiere seguridad para los dispositivos.

Estas instrucciones incluyen pasos que pueden no corresponder a su instalación particular. No obstante, sugerimos
que lea toda la Guía para el uso inicial con el fin de familiarizarse con el proceso recomendado de configuración del
dispositivo, para referencia futura.

Instalación del software

Si no se ha instalado el software previamente, siga estas instrucciones para instalar el programa contenido en el disco 
de CD-ROM.

Para instalar el software del disco de CD-ROM:
1. Inserte el CD-ROM en la unidad lectora correspondiente de la computadora.
2. El programa de instalación arranca automáticamente. Siga las indicaciones dadas en la pantalla.

Si el programa de instalación no se inicia automáticamente:
1. Haga clic en el botón [Inicio] de la barra de tareas de Windows, y seleccione [Ejecutar...] del menú que 

aparece
2. Escriba “D:\setup” (siendo “D” la letra que identifica a la unidad lectora de CD-ROM). El programa de 

instalación arranca automáticamente. Siga las indicaciones dadas en la pantalla.
3. Haga clic en [Aceptar] y siga las instrucciones dadas por el programa de instalación.

Si ha descargado una copia del software, ubique el archivo con extensión “.exe” usando el Explorador de Windows, y 
ábralo. Siga las instrucciones dadas por el programa de instalación.

Establecimiento de comunicación con el dispositivo

Este es el procedimiento que debe usarse cuando se conecta la computadora inicialmente al dispositivo. Es su prim-
era oportunidad para verificar que la computadora se comunica correctamente con el DFR22. Para más información 
en cuanto a la conexión de su computadora con el dispositivo y la designación del número de identificación del dispos-
itivo, vea la  Guía de instalación.

1. Conecte la computadora al procesador de audio DFR22
Conecte el puerto COM de su computadora al puerto RS-232 en el panel
delantero o trasero del DFR22.

2. Inicie el programa de software

3. Seleccione el puerto COM
a) Seleccione [Devices>Select COM Port] (dispositivos>selección de 

puerto COM) del menú principal. FIGURA 2-1: Cuadro de diálogo 
“COM Port”
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Configuración de controles externos
b) Se despliega el cuadro de diálogo “COM Port” (puerto COM), como se ilustra en la Figura 2-1.
c) Seleccione el puerto COM al cual se ha conectado el cable RS-232 y haga clic en [OK].

4. Haga clic en el botón [Live Mode] (modo en vivo) de la barra de control

5. Designe el nombre del dispositivo
a) Seleccione [Devices>Name Device] (dispositivos>designar dispositivo) 

del menú principal.
b) Se visualiza el cuadro de diálogo “Name Device” (designar dispositivo) 

como se ilustra en la Figura 2-2.
c) Escriba un nombre para el dispositivo, de hasta quince caracteres de 

largo, y haga clic en [Name].
d) El nombre del dispositivo aparece en la barra de títulos de la ventana 

principal cuando se está en modo en vivo, y se indica en el menú [Devices].

Configuración de controles externos

Si hay dispositivos externos de control conectados a las clavijas de control, es necesario configurar el DFR22 para que 
los reconozca. Esta configuración se almacena a nivel del dispositivo y debe definirse antes de crear configuraciones 
prefijadas. Si no está conectado al dispositivo, se puede crear una configuración y guardarla en la computadora para 
transferirla posteriormente al DFR22 por medio de la conexión RS-232. Consulte la sección Clavijas de control en la 
página 87 para instrucciones detalladas paso a paso.

1. Entre al modo de diseño
Es necesario estar en el modo de diseño para configurar los controles externos. Si está en modo en vivo, haga
clic en el botón [Design Mode] de la barra de control de la ventana principal.

2. Configure las clavijas de control
Seleccione [Devices>Control Pin Configuration] (dispositivos>configuración de clavijas de control) del menú
principal. Esto abrirá la ventana “Control Pins”.

a) Especifique el número de configuraciones prefijadas que podrán seleccionarse por el equipo de control 
externo a partir del campo [# Presets].

b) Seleccione el tipo de codificación que el DFR22 deberá emplear para reconocer los mensajes del equipo 
físico externo en el campo [Encoding Type] (tipo de codificación).

c) Indique, según sea necesario, los demás equipos físicos conectados para silenciamiento de canales y 
control de ganancia, tales como potenciómetros e interruptores.

3. Guarde la configuración en el dispositivo o en la computadora
Seleccione la opción de menú [Configuration>Store to Device] (configuración>guardar en el dispositivo) o
[Configuration>Save to PC] (configuración>guardar en la computadora).

Nota: Por omisión, podrá seleccionar configuraciones prefijadas mediante el selector de éstas, en el 
panel delantero del DFR22.

Nota: Si es necesario cambiar la configuración prefijada seleccionada en la computadora después de 
haber configurado las conexiones de entradas de control, será necesario desactivar las conexiones 
de la ventana “Control Pins” antes de proseguir. Haga clic en la flecha que está a la derecha del 
bloque de control de configuraciones prefijadas, y seleccione [Disable] (desactivar) del menú 
desplegable.

FIGURA 2-2: Cuadro de diálogo 
“Name Device”
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Creación de una plantilla de configuración prefijada
Creación de una plantilla de configuración prefijada

Esto puede hacerse en modo en vivo o en modo de diseño. Cuando se guardan varias configuraciones prefijadas en el 
procesador de audio, se ahorra mucho tiempo si se confecciona una plantilla de configuración prefijada que contenga 
las características que las mismas tengan en común. Esta plantilla entonces puede recuperarse del dispositivo, o abr-
irse desde la computadora, modificarse según sea necesario, y guardarse en el dispositivo como una configuración 
prefijada nueva.

1. Seleccione una plantilla de configuración prefijada
Cuando se lanza la aplicación del DFR22 aparece una configuración prefijada en blanco en el diagrama de
flujo de señales. Si desea emplear como plantilla una de las otras configuraciones prefijadas por omisión,
seleccione primero [File>New] del menú principal, y luego [Dual Mono] (monofónico doble), [Stereo] (estere-
ofónico), o [Dual Mono Split] (monofónico doble dividido). Podrá también pasar a modo en vivo y seleccionar,
para editarla, una de las configuraciones prefijadas que han sido cargadas anteriormente. Para mayor infor-
mación consulte la sección Configuraciones prefijadas por omisión en la página 28.

2. Designe los canales de entrada y salida
Haga doble clic en los bloques de entrada y de salida para abrir las ventanas de parámetros del procesador, y
edite los rótulos de canales que aparecen debajo de los controles de ganancia. Para mayor información con-
sulte la sección Rotulación de entradas y salidas en la página 18.

3. Llene el diagrama de flujo de señales
Arrastre y coloque en el diagrama de flujo de señales los bloques procesadores de señales seleccionados de
la “Processor Toolbox”. Si emplea una red de cruce, ésta será el primer tipo de procesador que se coloca en la
configuración, seguida de limitadores, para evitar dañar los altavoces. Para mayor información consulte la sec-
ción Adición de procesadores modulares en la página 21.

4. Forme los grupos de enlace
Pulse la tecla Ctrl  y haga clic para seleccionar varios procesadores del mismo tipo con el fin de controlarlos
como un solo grupo, por ejemplo, para pares estereofónicos, grupos de altavoces, zonas, etc. También se
pueden enlazar bloques de ganancia para controlar el nivel total del sistema. Seleccione [Processor>Link]
(procesador>enlazar) del menú principal. Para mayor información consulte la sección Enlace en la página 24.

5. Active los atenuadores en las salidas
Puede ser necesario activar el atenuador de 12 dB ó 18 dB para lograr una mejor alineación del nivel de limit-
ación de salida del DFR22 con el nivel de limitación de entrada del equipo al que está conectado. Haga doble
clic en cualquiera de los bloques de ganancia de salida para abrir la ventana “Output Gain”. Haga clic para
activar los atenuadores que necesite.

6. Encamine las señales de los canales de entrada a los de salida
Haga clic en los puntos de conexión de las filas de entrada y arrástrelos hasta los puntos de conexión de las
filas de salida para encaminar la señal a través de la matriz mezcladora. Para mayor información consulte la
sección Encaminamiento de señales en la página 19.

7. Ajuste los parámetros del procesador
Haga doble clic en cada uno de los bloques procesadores para abrir su ventana de parámetros. Si se trabaja
desconectado de la unidad, en modo de diseño, se pueden fijar niveles preliminares para luego ajustarlos
cuando se tiene el dispositivo conectado. Para más información sobre cómo trabajar con los procesadores,
consulte la sección Características del procesador en la página 34, al igual que la sección de referencia de
cada procesador.
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Administración de configuraciones prefijadas
8. Asigne las configuraciones prefijadas a las conexiones de los controles
Este paso sólo debe realizarse si el control de ganancia o silenciamiento de canales se realiza mediante las
clavijas de control. Seleccione [Devices>Control Pin Configuration] del menú principal. Esto abrirá la ventana
“Control Pins”. Seleccione [Configuration>Recall From Device] (configuración>recuperar del dispositivo) para
llenar la ventana con la configuración de clavijas actual. Los canales de entrada y salida aparecen listados en
una columna debajo de cada bloque de conexión. Haga clic en las casillas correspondientes a los canales de
entrada o salida que desee designar para las conexiones de control. Para mayor información consulte la sec-
ción “Processor Mapping” (designación de procesador) en la página 95.

9. Enclave los procesadores para acceso de sólo lectura
Este paso se usa sólo cuando se está personalizando el nivel de seguridad para los usuarios que acceden al
DFR22 a partir del software. Este tipo de seguridad se guarda con cada procesador, al nivel predefinido.
Seleccione los procesadores que el usuario no deberá modificar, y seleccione [Security>Level 2>Lock
Selected] (seguridad>nivel 2>bloqueo seleccionado) del menú principal. Para una explicación completa y más
instrucciones, consulte la sección Seguridad de procesadores individuales en la página 101.

10. Designe el nombre de la configuración prefijada
Haga clic una vez con el botón izquierdo del Mouse en cualquier
punto del cuadro de información, en la parte central de la barra de
control, para abrir el cuadro de diálogo “Preset Information” (infor-
mación de configuraciones prefijadas), como se ilustra en la
Figura 2-3. Escriba el nombre de la configuración prefijada, de hasta
15 caracteres de largo, y una descripción, y luego haga clic en [OK].
Para mayor información consulte la sección Cómo designar el nom-
bre de una configuración prefijada en la página 20.

Administración de configuraciones prefijadas

1. Guarde la configuración prefijada en el dispositivo
Si se está trabajando en el modo en vivo, la configuración prefijada ya ha sido guardada en el dispositivo. Si
está trabajando en modo de diseño, haga clic en el botón [Store Preset] (guardar configuración prefijada) de la
barra de control de la ventana principal. Para mayor información consulte la sección Configuraciones prefija-
das del dispositivo en la página 30. Para crear un duplicado de esta configuración prefijada, es necesario estar
en modo de diseño. Sencillamente continúe haciendo clic en el botón [Store Preset] para crear y guardar tan-
tos duplicados de la configuración prefijada como se requieran en el dispositivo.

2. Borre del dispositivo las configuraciones prefijadas que no estén en uso
El dispositivo viene con tres configuraciones prefijadas en fábrica. Si no las piensa emplear, le recomendamos
borrarlas del dispositivo para que el usuario no pueda acceder a ellas. (Si las necesita más adelante, podrá
recuperarlas a partir del menú [File>New].) Consulte las instrucciones en la sección Eliminación de una config-
uración prefijada en la página 31.

3. Active el control externo
Una vez que se ha terminado de crear y editar las configuraciones prefijadas, si previamente se habían desac-
tivado las conexiones de control para controlar el procesador de audio desde la computadora, abra la ventana
de clavijas de control y actívelas. Para mayor información consulte la sección NOTA IMPORTANTE SOBRE
LA CONMUTACION DE CONFIGURACIONES PREFIJADAS: en la página 89.

FIGURA 2-3: Cuadro de diálogo 
“Preset Information”
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Establezca los controles de seguridad
Establezca los controles de seguridad

Este es el paso final de la configuración del dispositivo. Antes de continuar, lea detenidamente la sección Seguridad en 
la página 98. Estas instrucciones tienen el propósito de dar una descripción general del proceso.

1. Ponga el DFR22 en modo en vivo
Es necesario activar el modo en vivo para fijar los controles de seguridad del dispositivo. Si está en modo de
diseño, haga clic en el botón [Live Mode] de la barra de control de la ventana principal.

2. Configure el bloqueo de panel delantero
Seleccione [Security>Front Panel Lockout] (seguridad>bloqueo del panel delantero) del menú principal. Esto
abrirá el cuadro de diálogo “Front Panel Lockout”. Haga clic en las casillas correspondientes a las funciones
del panel delantero cuyo acceso desea bloquear a los usuarios. Mediante esta función del software podrá blo-
quear los controles que seleccione del panel delantero. Para bloquear todos los controles del panel delantero
podrá también colocar hacia abajo el quinto interruptor DIP en la parte posterior del dispositivo. 

3. Fije una contraseña
Seleccione [Security>Set Password] (seguridad>establecer contraseña) del menú principal. Esto abrirá el
cuadro de diálogo “Create Password” (crear contraseña). Escriba una contraseña, pulse Tab, y vuelva a escri-
bir la contraseña para confirmarla. Haga clic en [OK].

4. Fije el nivel de acceso del usuario
Seleccione [Security>Set Level] (seguridad>fijar nivel) del menú principal. Esto abrirá el cuadro de diálogo “Set
Security” (fijar seguridad). Seleccione el nivel de acceso que se desea otorgar al usuario. Haga clic en [OK].
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SECCION 3 Cómo crear una configuración prefijada
Una configuración prefijada es una combinación individual de conexiones de señales, junto con la colocación de diver-
sos procesadores modulares y la fijación de sus parámetros de ajuste. La configuración se crea usando el diagrama
de flujo de señales de la ventana principal, y se guarda ya sea como una configuración prefijada en el dispositivo, o en
la computadora como un archivo que puede enviarse luego al dispositivo.

Configuración del flujo de señales

Para que las señales de audio puedan pasar por el dispositivo, es necesario encaminar la señal desde las entradas 
hasta las salidas, por medio de la conexión de los puntos de mezcla. En esta sección se explican los fundamentos del 
diseño del flujo de señales usando la interface del usuario del DFR22.

Estructura de ganancia
El procesador de audio DFR22 ofrece controles de ganancia en tres etapas del flujo de señales: ganancia de
entrada, matriz mezcladora y ganancia de salida. Es imprescindible comprender esta estructura de ganancia
antes de hacer pasar señales de audio por la unidad, para evitar dañar el equipo conectado posteriormente al
procesador de audio, debido a niveles excesivos de ganancia. La ilustración siguiente brinda una vista general
de la estructura de ganancia del DFR22.

1) Ganancia de entrada
Si se hace doble clic en uno de los bloques de ganancia de entrada, se abre la ventana “Input Gain”, la cual
despliega los controles para ambos canales. Ofrece control de sensibilidad de entrada, ganancia y polar-
idad para cada canal, y le permite designar las filas de canales de entrada con nombres personalizados.

Este es el punto de entrada de una señal al diagrama de flujo de señales. Después del procesador de
ganancia de entrada, la señal pasa en orden por los espacios para procesador de la fila de canal de
entrada. Al final de la fila de canales, la señal llega a un punto de mezcla, desde donde puede encami-
narse a cualquiera de las salidas o a ambas, por medio de la matriz mezcladora. 

2) Matriz mezcladora
Una vez que la señal ha sido encaminada al punto de mezcla de un canal de salida, entra a la etapa de
matriz mezcladora de la estructura de ganancia. Si se hace doble clic en cualquiera de los bloques de
mezcla se abre la ventana “Matrix Mixer”, la cual muestra una sección por cada fila de canales de salida.
Cuando se coloca una red de cruce o bifurcador sobre ambos canales de salida, las secciones de esos
canales se combinan en uno solo. Usar esta ventana para ajustar la polaridad y niveles relativos de las
señales de entrada encaminadas hacia el canal de salida deseado.

Después de la matriz mezcladora, la señal pasa en orden por los espacios para procesador de la fila de
canales de salida elegida. Al final de la fila de canales, la señal llega al bloque de ganancia de salida.

Nota: Si los niveles de la señal de entrada exceden el umbral de limitación del procesador de audio, será nece-
sario ajustarlos con medios externos para evitar la distorsión por limitación en los convertidores A/D. 

1 2 3

4

FIGURA 3-1: Diagrama de estructura de ganancia
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Configuración del flujo de señales
3) Ganancia de salida
Esta es la etapa final de controles de ganancia del procesador de audio. Haga doble clic en cualquiera de
los bloques de ganancia de salida para abrir la ventana de ganancia de salida. Ofrece sensibilidad de sal-
ida, ganancia, control de polaridad y un atenuador opcional de 12 dB y 18 dB para cada canal. Esta ven-
tana también le permite designar a cada fila de canales de salida con un nombre personalizado. Después
del procesador de ganancia de salida, la señal pasa por el convertidor de D/A, luego pasa por los atenua-
dores analógicos (si están activados) y es enviada a la salida de audio.

4) Conexión para encaminamiento de señales
Puede crearse en el diagrama de flujo de señales haciendo clic en los elementos y arrastrándolos entre
puntos de mezcla, haciendo clic en uno de los selectores de entrada justo a la izquierda del bloque MIX, o
abriendo la ventana “Matrix Mixer” para seleccionar la entrada.  Para mayor información consulte la sec-
ción Encaminamiento de señales en la página 19.

Silenciamiento de canales
Hay varias formas de silenciar los canales de entrada y de salida del procesador de audio. Los canales silen-
ciados se identifican en el diagrama de flujo de señales, de la forma indicada en la tabla siguiente.

Silenciamiento de todos los canales de entrada o salida
• Haga clic en los controles “Mute All Inputs” (silenciar todas las entradas) o de “Mute All Outputs” (silen-

ciar todas las salidas), ubicados en la barra de estado de la ventana principal.

• Seleccione en el menú la opción [Processor>Mute All Inputs] (procesador>silenciar todas las entra-
das) o [Processor>Mute All Outputs] (procesador>silenciar todas las salidas).

• Apague el dispositivo para silenciar automáticamente todas las salidas.

Silenciamiento de canales individuales
1. Abra la ventana “Input Gain” (ganancia de entrada), “Matrix Mixer” (matriz mezcladora), “Crossover” 

(red de cruce) o “Output Gain” (ganancia de salida), haciendo doble clic en el bloque procesador cor-
respondiente.

2. Haga clic en el botón de silenciamiento del canal deseado.
3. El bloque se identifica por medio de una “M” roja para indicar que está silenciado.

Rotulación de entradas y salidas
Los canales de entrada y salida no tienen rótulo cuando se crea una nueva configuración prefijada, pero los
rótulos pueden cambiarse fácilmente a partir de las ventanas “Input Gain” o “Output Gain”. Los rótulos de
canales se guardan junto con la configuración prefijada, de modo que se pueden crear rótulos especializados
para las entradas y salidas de todas las configuraciones prefijadas.

Bloque de ganancia Entradas a matriz 
mezcladora

Canales de salida 
de redes de cruce

Entradas y salidas silen-
ciadas
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Configuración del flujo de señales
Para cambiar el rótulo de un canal:
1. Haga doble clic en el bloque de ganancia del canal.
2. En la ventana del procesador, ubique el cuadro de rótulo del canal.
3. Haga clic y arrastre el Mouse sobre el texto para seleccionarlo.
4. Escriba un rótulo nuevo de no más de quince caracteres.
5. Aplique las modificaciones hechas haciendo clic sobre otro control o cerrando la ventana.

Encaminamiento de señales
El DFR22 le permite encaminar una señal desde cualquiera de las dos entradas hacia cualquiera o ambas sal-
idas. Para que la señal pase de las filas de los canales de entrada a las filas de los canales de salida, es nec-
esario encaminarla a través de la matriz mezcladora. Los canales de entrada pueden conectarse a los de
salida usando cualquiera de los métodos descritos a continuación.

Establecimiento de conexiones en el diagrama de flujo de señales
Para un sistema con configuraciones sencillas, la forma más fácil de conectar los canales de entrada a los
de salida es utilizar el Mouse en el diagrama de flujo de señales.

Haga clic en los puntos de mezcla:
1. Haga clic en un punto de mezcla de entrada.
2. El cursor cambia de forma para indicar que 

espera a que se indique una conexión de salida:
3. Haga clic en un punto de mezcla de salida.

Haga clic y arrastre el Mouse entre puntos de mezcla:
1. Haga clic en un punto de mezcla de entrada y arrastre el Mouse hasta un punto de salida de mezcla. 
2. Se dibuja una línea de conexión a lo largo de la trayectoria de la señal. Se torna verde cuando la con-

exión es válida.
3. Suelte el botón del Mouse para establecer la conexión.

Haga clic en los selectores de entrada:
1. Haga clic en el selector de entrada de un canal de salida cuyo número corre-

sponda al canal de entrada deseado.
2. Se dibuja una línea de conexión en el diagrama de flujo de señales, entre los 

puntos de mezcla, y el selector numerado de entrada se muestra resaltado.

Establecimiento de conexiones en la ventana “Matrix Mixer”
Para configuraciones más complejas con muchas líneas de conexión que se entrecruzan entre sí, la ventana
“Matrix Mixer” proporciona un método más sencillo para conectar los canales de entrada a los de salida.

Para establecer conexiones en la matriz mezcladora:
1. Haga doble clic en el bloque mezclador del canal de salida que se desea conectar.
2. Se abrirá la ventana “Matrix Mixer”.
3. En el lado izquierdo de esta ventana, haga clic en el botón de entrada de cada canal de entrada que 

desea conectar a la salida seleccionada. El botón de entrada se ilumina en verde cuando se establece 
la conexión.

4. Se dibuja una línea de conexión en el diagrama de flujo de señales, entre los puntos de mezcla, y el 
selector numerado de entrada de cada conexión activa se muestra resaltado. 

Sugerencia Se puede usar la tecla Esc para interrumpir la función de conexión si cambia de parecer 
después de haber hecho clic en un punto de entrada de mezcla, pero antes de hacer clic 
en el punto de salida de mezcla.
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Configuración de procesadores
Eliminación de conexiones
• Haga clic en una línea de conexión y pulse la tecla Supr. 
• Haga clic en el selector de entrada que corresponde a la conexión deseada. Esto desactiva la conexión.
• Haga clic en una línea de conexión con el botón derecho del Mouse para desplegar el menú contextual.
• Seleccione varias conexiones manteniendo pulsada la tecla Ctrl mientras se hace clic en las mismas, 

y luego pulse la tecla Supr.

Cómo designar el nombre de una configuración prefijada
Puesto que es posible guardar hasta 16 configuraciones diferentes en el DFR22, es útil distinguirlas por medio
de un nombre y una descripción breve. El cuadro de información que aparece en el centro de la barra de con-
trol de la ventana principal despliega estos detalles, como se ilustra en la Figura 3-2.

El nombre que se introduce aquí se convierte en el nombre de la configuración prefijada al guardarla en el dis-
positivo, y en el nombre del archivo al guardarlo en la computadora. La descripción también se despliega en
todos los cuadros de diálogo que presentan listas de configuraciones prefijadas. Esta información puede mod-
ificarse en cualquier momento, ya sea en modo en vivo o en modo de diseño.

Para designar el nombre de una configuración prefijada:
1. Haga clic una vez con el botón izquierdo del Mouse en cualquier 

punto del cuadro de información.
2. Aparecerá el cuadro de diálogo “Preset Information” (información 

de configuraciones prefijadas).
3. Escriba un nombre con un máximo de 15 caracteres, y una 

descripción con un máximo de 80 caracteres.
4. Haga clic en [OK].
5. El cuadro de información se actualiza para reflejar los cambios 

hechos.

Configuración de procesadores

Hay dos niveles de trabajo con los procesadores: al nivel de configuración, en el diagrama de flujo de señales, y a 
través de la ventana de parámetros de cada procesador individual, al cual se accede haciendo doble clic en el bloque 
procesador. En esta sección se describe el manejo de los procesadores en el diagrama de flujo de señales y se expli-
can las diferencias entres las dos categorías principales de procesador.

Tipos de procesador
Se utilizan dos tipos principales de procesador en el diagrama de flujo de señales: fijos y modulares. La difer-
encia principal entre ellos es que los procesadores fijos forman parte de la estructura de ganancia del DFR22,
y por lo tanto forman parte de todas las configuraciones de flujo de señales. Los procesadores modulares son
bloques procesadores que se listan en la “Processor Toolbox” (caja de herramientas de procesadores), y que
se pueden seleccionar y colocar en la forma que se desee, según los requisitos del sistema en particular.

Procesadores fijos
Los bloques de ganancia y de mezcla se denominan procesadores fijos porque sus posiciones en las filas
de canales son permanentes. No es posible eliminarlos, moverlos, copiarlos ni pegarlos. Sin embargo, es
posible enlazarlos, y sus parámetros de ajuste pueden guardarse y recuperarse.

FIGURA 3-2: El cuadro de información

FIGURA 3-3: Cuadro de diálogo 
“Preset Information”
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Configuración de procesadores
Procesadores modulares
Los bloques procesadores modulares se denominan modulares porque pueden colocarse en cualquier
espacio vacío (salvo las redes de cruce, bifurcadores, subwoofer y el atenuador automático), y pueden
desplazarse, copiarse, pegarse y eliminarse sin restricciones. Cada bloque procesador del diagrama de
flujo de señales funciona de modo completamente autónomo. Cuando se abre la ventana de parámetros
de un procesador modular, se cambian los parámetros de ajuste de ese procesador solamente, salvo en
las condiciones siguientes.

• Forma parte de un par estereofónico.
• Ha sido asignado a un grupo enlazado.

Adición de procesadores modulares
Cada fila de canales tiene una fila de espacios vacíos que pueden contener cualesquiera de los bloques proc-
esadores modulares. Salvo en el caso de las redes de cruce, subwoofer, bifurcadores y atenuador automático,
no existen restricciones en cuanto a la posición en la cual se pueden colocar procesadores en el diagrama de
flujo de señales, ni sobre las veces que un procesador particular puede ser utilizado en la misma fila de
canales. Los espacios vacíos entre bloques procesadores no afectan el flujo de la señal, de modo que no es
necesario que los procesadores estén adyacentes uno al otro en la fila de canales.

Cuando los bloques procesadores se añaden por primera vez al diagrama de flujo de señales, sus parámetros
están ajustados a los valores predeterminados en fábrica. Los parámetros de cada procesador individual
pueden modificarse abriendo su ventana de parámetros. Los bloques retienen los valores de sus parámetros
aun si se los copia o desplaza a un espacio diferente.

Se pueden añadir bloques procesadores al diagrama de flujo de señales ya sea usando la “Processor Tool-
box”, o con las funciones de menú. Cada uno de estos métodos se describe a continuación.

Uso de la “Processor Toolbox”
Se puede usar el Mouse para seleccionar un bloque procesador a partir de la “Processor Toolbox”. El cur-
sor del Mouse cambia de forma para indicarle que su siguiente acción colocará el bloque seleccionado en
el diagrama de flujo de señales. La apariencia del cursor depende de su posición, según se ilustra en la
tabla siguiente.

Para añadir un bloque procesador a partir de la “Processor Toolbox”:
1. Ponga el cursor sobre un bloque procesador de la “Processor Toolbox”, y haga clic en él.
2. Mantenga oprimido el botón del Mouse y arrastre el bloque hasta el diagrama de señales.
3. Suelte el botón del Mouse para colocar el bloque en la posición actual del cursor.

- O -

1. Ponga el cursor sobre un bloque procesador de la “Processor Toolbox”, y haga clic en él.
2. Haga clic en el espacio vació apropiado, en el diagrama de flujo de señales.

Uso de un comando de menú
Se pueden añadir procesadores al diagrama de flujo de señales sin necesidad de abrir la “Processor Tool-
box”, usando ya sea el menú principal o el menú contextual de acceso por clic con el botón derecho del
Mouse, de la forma descrita a continuación.

Posición en la cual se puede 
colocar el procesador.

Posición no apropiada para el 
procesador seleccionado.

Sugerencia Si cambia de parecer después de haber hecho clic en el bloque procesador de la “Processor 
Toolbox”, utilice la tecla Esc para anular esta operación antes de colocar el procesador en el 
diagrama de flujo de señales.
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Para añadir un bloque procesador usando el menú:
1. Haga clic en un espacio vacío para seleccionarlo.
2. Haga clic con el botón derecho del Mouse para seleccionar un procesador.

- O -
Use la opción [Processor>Add] (procesador>añadir) de la barra de menú principal.

Otra ventaja que ofrece el uso del comando de menú para colocar bloques procesadores es que permite
colocar un mismo tipo de procesador en varios espacios, con ejecutar el comando del menú una sola vez.

Para añadir simultáneamente varios bloques procesadores:
1. Mantenga pulsada la tecla Ctrl y haga clic en varios espacios vacíos para seleccionarlos.
2. Haga clic con el botón derecho del Mouse para seleccionar un procesador.

- O -
Use la opción [Processor>Add] (procesador>añadir) de la barra de menú principal.

3. El procesador llenará todos los espacios que se hayan seleccionado.

Procesadores estereofónicos
Los procesadores estereofónicos se colocan en el diagrama de flujo de señales del mismo modo que se
hace con los otros bloques procesadores modulares. Sin embargo, cada uno de los canales estereofóni-
cos se despliega como un bloque separado. Si se hace doble clic en uno de los bloques, se abre la ven-
tana de parámetros de ambos canales.

Cada uno de los procesadores siguientes funciona como un par estereofónico:

Para añadir un bloque procesador estereofónico de la “Processor Toolbox”:
1. Haga clic sobre un bloque procesador estereofónico de la “Processor Toolbox”.

Cuando se selecciona un procesador estereofónico de la “Processor Toolbox”, el cursor adquiere una
apariencia ligeramente diferente que en el caso de otros procesadores, según se indica en la tabla
siguiente.

2. Añada el primer canal del par estereofónico, mediante uno de los métodos siguientes.
a) Haga clic con el botón izquierdo del Mouse sobre un bloque procesador de la “Processor Toolbox” 

y manténgalo pulsado mientras se lo arrastra hacia el diagrama de flujo de señales.
b)  Suelte el botón del Mouse para colocar el primer canal del procesador en la posición actual del 

cursor.
- O -

a) Haga clic una vez sobre un bloque procesador de la “Processor Toolbox”.
b) Haga clic de nuevo en el espacio vacío apropiado, en el diagrama de flujo de señales.

Nombre del 
bloque Descripción

ST DFR 5 DFR estereofónico de 5 bandas
ST DFR 10 DFR estereofónico de 10 bandas
ST DFR 16 DFR estereofónico de 16 bandas
ST COMP Compresor estereofónico

Sft ST COMP Compresor estereofónico de 
articulación suave

ST LIM Limitador estereofónico

Sft ST LIM Limitador estereofónico de articu-
lación suave

Posición en la cual el primer canal del proce-
sador estereofónico puede colocarse.

Posición en la cual el segundo canal del 
procesador estereofónico puede colocarse.
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Configuración de procesadores
3. El cursor cambia de forma para indicar que es necesario colocar el segundo canal del procesador.
4. Haga clic en el espacio apropiado para añadir el segundo canal estereofónico. 

Para añadir un procesador estereofónico usando el menú:
1. Mantenga pulsada la tecla Ctrl y haga clic para seleccionar espacios vacíos en dos canales 

diferentes.
2. Utilice el menú contextual de acceso por clic con botón derecho para colocar los dos canales del par 

estereofónico.
- O -
Use la opción [Processor>Add] (procesador>añadir) de la barra de menú principal.

Sustitución de procesadores
Sólo un bloque procesador puede ocupar un espacio particular a la vez. Para sustituir un bloque procesa-
dor existente por otro, elimínelo primero del espacio y después añada el procesador nuevo utilizando cual-
quiera de los métodos arriba descritos.

Red de cruce, bifurcador y subwoofer
Puesto que son procesadores de salida, la red de cruce, bifurcador y subwoofer sólo pueden colocarse en
filas de canales de salida. Pueden añadirse a las filas de salida como cualquier otro bloque procesador,
pero es necesario tomar en cuenta los factores siguientes:

• La red de cruce se expande hacia abajo para abarcar ambas salidas, por lo que debe ponerse en 
el canal uno.

• El punto de mezcla desaparecerá del segundo canal luego de haber puesto sobre éste la red de cruce.
• Los espacios para procesador desaparecerán del segundo canal, a la izquierda del bloque de la 

red de cruce.
• El bifurcador afectará al diagrama de señales del mismo modo que se mencionó anteriormente 

para la red de cruce.

El atenuador automático de música
El atenuador automático debe colocarse únicamente en el canal de entrada que lleva la señal de buscap-
ersonas. El atenuador automático no puede colocarse en una fila de canales de salida.

Copiar y pegar
Los comandos tradicionales de copiar, cortar y pegar funcionan únicamente con los bloques procesadores
modulares. Esta es una forma conveniente de duplicar bloques procesadores, junto con sus valores de ajuste,
en varios canales.

Para copiar y pegar un bloque procesador:
1. Ponga el cursor sobre un bloque procesador y haga clic para seleccionarlo.
2. Seleccione el comando de copiar usando uno de los métodos siguientes:

• Utilice el menú contextual haciendo clic con el botón derecho del Mouse.
• Seleccione [Edit>Copy] (editar>copiar) del menú principal.
• Pulse Ctrl + C en el teclado.

3. Ponga el cursor sobre un espacio vacío y haga clic en él para seleccionarlo.
4. Seleccione el comando de pegar usando el menú principal o el menú contextual de acceso por clic en el 

botón derecho, o bien pulse Ctrl + V.

Nota: Si la configuración utiliza una red de cruce o bifurcador, éste debe añadirse al dia-
grama de flujo de señales antes de conectar los puntos de mezcla o de añadir otros 
procesadores a las filas de canales de salida.

Nota: Estos comandos no funcionan con selecciones múltiples.
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Eliminación de procesadores de los espacios
Los bloques procesadores modulares pueden quitarse fácilmente de una configuración sin afectar los demás
aspectos del flujo de la señal. 

Para eliminar un bloque procesador:
1. Ponga el cursor sobre un bloque procesador y haga clic para seleccionarlo.
2. Seleccione el comando de eliminar usando uno de los métodos siguientes:

• Utilice el menú contextual haciendo clic con el botón derecho del Mouse.
• Seleccione [Edit>Delete] (editar>suprimir) del menú principal.
• Pulse la tecla Supr.

Enlace
Se pueden enlazar varios bloques procesadores del mismo tipo para controlarlos como si fueran uno solo. Las
modificaciones hechas en la ventana de parámetros de cualquier bloque de un grupo de enlace modifican
simultáneamente los parámetros de todos los bloques que pertenecen al grupo. No obstante, hay algunas
actividades que todavía funcionan de modo independiente en bloques enlazados:

• Eliminar, copiar, cortar y pegar,
• Desplazar el bloque a un espacio diferente en la fila de canales,
• Designar el nombre en la ventana de parámetros del procesador.

Los procesadores fijos de una misma etapa de la estructura de ganancia también pueden agruparse, lo cual
sincroniza los controles de nivel de todos los canales agrupados. Por ejemplo, se pueden agrupar los bloques
de ganancia de dos canales de entrada para controlarlos como un par estereofónico. También se pueden
enlazar ambos bloques de ganancia de salida para poder ajustar los niveles de todos los canales de salida con
un solo control.

Creación de un grupo de enlace
Al crear un grupo de enlace, todos los procesadores de ese grupo se sincronizarán a los mismos ajustes.
Si ya se han especificado valores de ajuste de uno de los procesadores antes de crear el grupo de enlace,
es posible designarlo como fuente cuando se crea el grupo, lo cual hace que los demás bloques procesa-
dores adopten esos valores de ajuste. Como alternativa, si se desea eliminar los valores de ajuste exis-
tentes en el procesador, se puede seleccionar los valores predeterminados en fábrica como fuente.
Después de haber creado el grupo de enlace, las modificaciones hechas a los valores de ajuste de uno de
los bloques enlazados afectan a todos los bloques de ese grupo.

Para crear un grupo de enlace:
1. Mantenga pulsada la tecla Ctrl y haga clic en varios bloques 

procesadores para seleccionarlos.
2. Seleccione [Processor>Link>New Link Group] (procesa-

dor>enlace>nuevo grupo de enlace) del menú principal, o 
[Link>New Link Group] (enlace>nuevo grupo de enlace) del 
menú contextual de acceso por clic con el botón derecho.

3. Se visualiza el cuadro de diálogo “Create Link Group” (crear 
grupo de enlace), como se ilustra a la derecha en la 
Figura 3-4.

4. Introduzca un nombre de dos caracteres para identificar al 
grupo.

5. Elija una fuente que defina los valores de ajuste iniciales del 
grupo de enlace.

6. Haga clic en [OK] para aceptar los valores.

Nota: Solamente es posible enlazar procesadores de precisamente el mismo tipo.

FIGURA 3-4: Cuadro de diálogo 
“Create Link Group”
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Configuración de procesadores
El nombre de dos caracteres del grupo aparece tanto en el bloque procesador, en el diagrama de flujo de
señales, como en el indicador de enlace en la esquina inferior derecha de la ventana de parámetros del
procesador, de la forma ilustrada en la tabla siguiente.

Adición de elementos a un grupo de enlace
Se pueden añadir bloques procesadores a un grupo de enlace existente, siempre que se trate de procesa-
dores exactamente del mismo tipo y que no formen parte de ningún grupo de enlace. Los procesadores
añadidos a un grupo de enlace adoptan los valores de ajuste vigentes del grupo.

Para añadir bloques a un grupo de enlace existente:
1. Haga clic sobre un bloque procesador para seleccionarlo, o 

mantenga pulsada la tecla Ctrl y haga clic sobre varios 
bloques para seleccionarlos.

2. Seleccione [Processor>Link>Add To] (procesa-
dor>enlace>añadir a) del menú principal, o [Link>Add To] 
(enlace>añadir a) del menú contextual de acceso por clic con 
el botón derecho.

3. Se visualiza el cuadro de diálogo “Add to Link Group” (añadir 
a grupo de enlace), como se ilustra en la Figura 3-5. Sólo se 
listan los grupos de enlace que contienen procesadores 
idénticos a los del bloque seleccionado.

4. Seleccione un grupo de enlace.
5. Haga clic en [OK]

Desenlace de bloques procesadores
Un bloque procesador puede retirarse de un grupo de enlace sin afectar los demás bloques enlazados.
También se puede eliminar un grupo de enlace desenlazando todos los bloques del grupo. 

Para quitar bloques de un grupo de enlace existente:
1. Haga clic sobre un bloque procesador para seleccionarlo, o mantenga pulsada la tecla Ctrl y haga clic 

sobre varios bloques para seleccionarlos.
2. Seleccione [Processor>Link>Unlink] (procesador>enlace>desenlazar) del menú principal, o 

[Link>Unlink Selected] (enlace>desenlazar selección) del menú contextual de acceso por clic con el 
botón derecho.

Ventana de parámetros del procesa-
dor

Diagrama de flujo de 
señales

Nota: Los procesadores sólo pueden pertenecer a un grupo de enlace a la vez.

Nota: Un grupo de enlace deberá contener por lo menos dos bloques procesadores. Si se retiran todos 
los bloques menos uno de un grupo de enlace, se elimina el grupo.

FIGURA 3-5: Cuadro de diálogo 
“Add to Link Group” 
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Derivación
A partir de la ventana principal, es posible derivar cualquier bloque procesador modular. Esto le permite evaluar
la trayectoria de la señal, mientras se excluye temporalmente un procesador. Los bloques derivados se denotan
en el diagrama de flujo de señales por medio de un indicador amarillo, como se ilustra en la Figura 3-6.

Para activar o desactivar la derivación:
1. Haga clic sobre un bloque procesador para seleccionarlo, o mantenga pulsada 

la tecla Ctrl y haga clic sobre varios bloques para seleccionarlos.
2. Active la derivación usando cualquiera de los métodos siguientes:

• Pulse Ctrl + B en el teclado.
• Seleccione [Processor>Bypass Selected] (procesador>derivar selección) 

del menú principal.
• Seleccione [Bypass Selected] del menú contextual de acceso por clic con el botón derecho.

Administración de recursos de DSP
Aunque el DFR22 tiene suficiente poder de procesamiento para muchas situaciones, es posible llenar el dia-
grama de flujo de señales con más bloques procesadores que los que los recursos de DSP (procesamiento
digital de señales) del dispositivo pueden manejar. En esta sección se describe en términos generales cómo el
procesador de audio maneja los requisitos de procesamiento de señales de una configuración dada, y se pre-
sentan algunas sugerencias para obtener el provecho máximo de los recursos de DSP.

Asignación de recursos
Al colocar un bloque procesador en una fila de canales, se están asignando los recursos de DSP necesa-
rios para que funcione a su capacidad máxima. Por esta razón es que se han provisto tantas variedades
de un mismo tipo de bloque procesador, para que pueda seleccionar solamente la cantidad de procesa-
miento que realmente se necesitará para un módulo en particular. Cuando se está diseñando una configu-
ración sencilla, no es tan importante prestar atención a la cantidad de recursos de DSP en uso. Sin
embargo, en configuraciones más complejas, es más importante seleccionar bloques procesadores que
utilicen la cantidad mínima de recursos de procesamiento necesarios para cumplir la tarea deseada.

Por ejemplo: cuando se coloca un ecualizador paramétrico de diez bandas en la fila de un canal,
instantáneamente se asigna el poder de procesamiento requerido por los diez filtros, aun cuando sólo se
vayan a utilizar cuatro de ellos. En este caso, la mejor alternativa sería usar el PEQ5.

Memoria de retardo
El DFR22 tiene un búfer que retiene hasta 10 segundos de retardo, los cuales pueden dividirse entre cual-
quier combinación de procesadores de retardo. Al igual que sucede con los recursos de DSP, la memoria
de retardo se asigna al bloque procesador según el tiempo máximo de retardo indicado en el nombre que
lo identifica. 

Por ejemplo, si sólo se necesita un retardo de 45 milisegundos, no utilice el retardo de 2 segundos, ya que
el de 150 ms le dará los mismos resultados. Aunque ambos procesadores pueden ajustarse al mismo
valor, el bloque DLY 2s todavía agota dos segundos completos de memoria de retardo.

Medidores de utilización de DSP
Estos medidores ubicados en la barra de estado, en la parte inferior de la ventana principal, indican la can-
tidad de recursos de DSP y de memoria de retardo que se utilizan en la configuración actual. Si conoce la
cantidad de recursos disponibles de DSP y de memoria de retardo podrá seleccionar los procesadores de
modo más eficientemente. Cuando se añade o se quita un bloque procesador del diagrama de flujo de
señales, el medidor de DSP instantáneamente calcula los resultados, e indica los recursos del sistema
que están siendo utilizados en la configuración actual de procesadores.

Nota: No confunda la memoria de retardo con los recursos de DSP. Cada retardo utiliza la misma can-
tidad de recursos de DSP, sin importar la duración su retardo máximo.

FIGURA 3-6: Bloque 
procesador derivado
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Configuración de procesadores
Sugerencias para la optimización del DSP
Si se despliega el cuadro ilustrado en la Figura 3-7 cuando se
intenta añadir un procesador, se puede optimizar la configuración
para liberar alguna parte de los recursos de DSP, y después aña-
dir el procesador. Las siguientes sugerencias le ayudarán a opti-
mizar los recursos de DSP.

• Sustituya los DFR por ecualizadores paramétricos después 
de haber eliminado la realimentación en el sistema.

Por ejemplo: en una configuración que requiere varios DFR
en varios canales de entrada para obtener un mejor ren-
dimiento de ganancia antes de la realimentación, se puede
usar un DFR inicialmente en cada entrada para eliminar la
realimentación. Después de haber colocado los filtros, copie
los filtros DFR y péguelos en un PEQ, luego elimine el DFR.
Podrá repetir esta operación para la otra entrada, y dejar sólo los DFR necesarios para la detección
automática de realimentación después de que el sistema ha sido configurado. Para mayor información
sobre la copia y pegado de filtros entre los procesadores, consulte la sección Copiar y pegar en la
página 71.

• Reduzca a un solo módulo varios ecualizadores que se encuentren en una misma trayectoria de 
señales, cuando sea posible.

Ejemplo: dos PEQ3 consumen más DSP que un PEQ7. Obsérvese que todos los ecualizadores
paramétricos (PEQ) se ofrecen con filtros atenuadores y limitadores, para ahorrar recursos de DSP. Si
no se requieren las pendientes adicionales que ofrece el procesador atenuador/limitador, no es nece-
sario tener filtros atenuadores y limitadores en un módulo aparte en la misma trayectoria de señales.

• Reduzca a un solo módulo varios retardos que se encuentren en una misma trayectoria de señales, 
cuando sea posible. Si se emplean dos bloques de DLY5ms para lograr 7 ms de retardo, se consume 
el doble de DSP en comparación con un solo bloque de DLY150ms, a pesar de que se consume 
menos memoria de retardo.

• Quite los procesadores de todos los canales no utilizados.
• Utilice el bifurcador para aplicar procesos idénticos de señal a ambos canales de salida.
• Utilice un ecualizador paramétrico PEQ10 en lugar de un ecualizador GEQ30. En la mayoría de los 

casos no se utilizan los treinta filtros del GEQ30, y el PEQ10 utiliza menos de la mitad de los recursos 
de DSP.

FIGURA 3-7: Recursos de DSP excedidos
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Configuraciones prefijadas por omisión
Configuraciones prefijadas por omisión

Para ayudarle a empezar a trabajar con configuraciones básicas, el DFR22 se envía de fábrica con tres configura-
ciones prefijadas por omisión. Estas configuraciones prefijadas se listan también en el submenú [File>New], de modo 
que podrá emplear cualquiera de ellas como plantilla para crear una nueva.

Configuración prefijada uno – [Dual Mono]
En esta configuración la entrada uno se encamina hacia la salida uno, y la entrada dos hacia la salida dos.
Cada fila de entradas se llena con los siguientes procesadores:

• DFR16 - se asigna a los controles del panel delantero
• PEQ10+CS
• GEQ30
• LIM

Existe además en cada fila de salidas un retardo de 2 segundos, que se fija a 0 ms por omisión. 

Configuración prefijada dos – [Stereo]
En esta configuración la entrada uno se encamina hacia la salida uno, y la entrada dos hacia la salida dos. Los
canales de entrada están enlazados, así como los de salida, de modo que se puede controlar la ganancia en
ambos canales simultáneamente en las etapas de entrada y de salida de la estructura de ganancia.

Las filas de entradas se llenan con los siguientes procesadores:

• DFR16 estereofónico - se asigna a los controles del panel delantero
• PEQ10+CS enlazados
• GEQ30 enlazados
• Limitador estereofónico

Las filas de salidas se llenan con retardos enlazados de 2 segundos, que se fijan a 0 ms por omisión

Configuración prefijada tres – [Dual Mono Split]
En esta configuración la entrada uno y la entrada dos se encaminan cada una hacia ambas salidas, la uno y la
dos. La fila de entradas se llena con los siguientes procesadores:

• DFR16 - se asigna a los controles del panel delantero
• PEQ10+CS
• GEQ30
• LIM

Existe además en cada fila de salidas un retardo de 2 segundos, que se fija a 0 ms por omisión.

Nota: Para evitar que algún usuario las abra por error, se recomienda bloquear el selector de config-
uraciones prefijadas del panel delantero o borrar las configuraciones prefijadas por omisión del 
dispositivo que no esté empleando.
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SECCION 4 Administración del dispositivo y configuraciones 
prefijadas
En modo de diseño, después de haber creado una configuración prefijada, es posible guardarla en la computadora o
en el dispositivo, dependiendo de si se está conectado al DFR22 ó no. Sólo una configuración prefijada se mantiene
activa en el DFR22 en un momento dado. Se conoce como la configuración prefijada activa. En el modo en vivo, esta
configuración prefijada activa corresponde a la que se está viendo o modificando. Es posible guardarla en la computa-
dora en cualquier momento haciendo clic en el botón [Save As] de la barra de control de la ventana principal.

Archivos de configuración prefijada

Es posible diseñar una biblioteca completa de configuraciones prefijadas con el software del DFR22, sin necesidad de 
tener la computadora conectada al dispositivo. Las configuraciones prefijadas que se guardan en la computadora 
pueden recuperarse posteriormente, modificarse y luego enviarse al dispositivo. Se guardan con la extensión de 
archivo “.d22”.

Cómo guardar en la computadora una nueva configuración prefijada
Si la computadora no está conectada al dispositivo, cada nueva configuración prefijada se guarda en la com-
putadora.

Para guardar una nueva configuración prefijada en la computadora:
1. En la ventana principal, seleccione [File>Save As] del menú principal, o haga clic en el botón [Save As] de 

la barra de control.
2. Se visualiza el cuadro de diálogo “Save As”. 
3. Seleccione la unidad de disco y el directorio en donde se desea guardar el archivo nuevo.
4. Escriba el nombre y, si se desea, una descripción.
5. Haga clic en [Save].

Modificación de archivos de configuración prefijada
Cuando se modifica una configuración prefijada existente, podrá guardarla en una computadora cambiando el
nombre de archivo, o sobreescribir la versión anterior del archivo.

Para modificar una configuración prefijada guardada en la computadora:
1. En la ventana principal, seleccione [File>Open File] (archivo>abrir archivo) del menú principal, o haga clic 

en el botón [Open] (abrir) de la barra de control.
2. Se visualiza el cuadro de diálogo “Open”.
3. Seleccione la unidad de disco y el directorio que contiene el archivo de la configuración prefijada que 

desea abrir.
4. Haga clic en el archivo para seleccionarlo, y luego haga clic en el botón [Open].
5. Haga las modificaciones que sean necesarias.
6. Seleccione [File>Save As] del menú principal, o haga clic en el botón [Save As] de la barra de control.
7. Se visualiza el cuadro de diálogo “Save As”. 
8. Haga clic en el nombre del archivo original para seleccionarlo, y después haga clic en [Save].
9. Aparece un cuadro de diálogo que solicita verificación de que se desea sobreescribir el archivo anterior de 

configuración prefijada.
10. Haga clic en [Yes] para sobreescribir el archivo.

Nota: Los primeros quince caracteres del nombre del archivo y los primeros 80 de su 
descripción aparecerán en el cuadro de información de la barra de control.
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Configuraciones prefijadas del dispositivo
Configuraciones prefijadas del dispositivo

El DFR22 puede guardar 16 configuraciones prefijadas en su memoria. Una vez que se han guardado las configura-
ciones prefijadas en el dispositivo, éstas pueden redesignarse, borrarse o guardarse en una copia de respaldo.

Cómo guardar una configuración prefijada en el dispositivo
Cuando se está conectado al dispositivo, el modo de diseño le permite almacenar en él nuevas configura-
ciones prefijadas, o abrir archivos de configuraciones prefijadas existentes y guardarlas en el dispositivo.

Para guardar una configuración prefijada en el dispositivo:
1. En la ventana principal, seleccione [File>Store As Preset] 

(archivo>guardar como configuración prefijada) del menú 
principal, o haga clic en el botón [Store Preset] (guardar 
configuración prefijada) de la barra de control.

2. Si aparece el cuadro de diálogo “Select Devices” (seleccio-
nar dispositivos), como se ilustra en la Figura 4-1, selec-
cione un dispositivo de la lista y haga clic en [Connect] 
(conectar).

3. Se visualiza el cuadro de diálogo “Store Preset” (guardar 
configuración prefijada) como se ilustra abajo en la 
Figura 4-2.

4. Escriba un nombre nuevo para la configuración prefijada 
de no más de quince caracteres.

5. Escriba el número de la configuración prefijada, o acepte el dado por omisión.
6. Escriba una descripción (opcional) que le ayude a identificar el contenido de la configuración prefijada 

para operaciones futuras.
7. Haga clic en [Store].

FIGURA 4-1: Cuadro de diálogo 
“Select Devices”

FIGURA 4-2: Cuadro de diálogo “Store Preset”
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Configuraciones prefijadas del dispositivo
Redesignación de una configuración prefijada
Después de haber guardado una configuración prefijada en el dispositivo, se puede cambiar su nombre y su
descripción en el modo en vivo. También es posible, en el modo de diseño, cambiar el nombre de una config-
uración prefijada almacenada en la computadora.

Para redesignar una configuración prefijada guardada en el dispositivo:
1. Haga clic en el botón [Live Mode] de la barra de control.
2. Seleccione la configuración prefijada cuyo nombre se desea redesignar 

del menú que aparece en el cuadro de información de la barra de control.
3. La ventana principal entra en modo de presentación preliminar para la 

configuración prefijada que se ha seleccionado.
4. Haga clic en el botón [Load] (cargar) de la barra de control para activar la 

configuración prefijada.
5. Haga clic una vez en cualquier punto del cuadro de información.
6. Se visualiza el cuadro de diálogo “Preset Information” como se ilustra a la derecha en la Figura 4-3.
7. Escriba el nombre y/o descripción nuevos.
8. Haga clic en [OK].

Para redesignar una configuración prefijada guardada en la computadora:
1. Entre al modo de diseño.
2. Abra el archivo de la configuración prefijada.
3. Haga clic una vez en cualquier punto del cuadro de información.
4. Se visualiza el cuadro de diálogo “Preset Information”, como se ve arriba.
5. Escriba el nombre y/o descripción nuevos.
6. Haga clic en [OK].
7. Guarde la configuración prefijada en la computadora.

Eliminación de una configuración prefijada
La configuración prefijada que está activa en el
modo en vivo no se presenta para eliminarla. Si es
necesario eliminar esta configuración prefijada,
primero hay que seleccionar una configuración
diferente en vivo.

Para eliminar una configuración prefijada:
1. Haga clic en el botón [Design Mode] de la barra 

de control.
2. Seleccione [File>Delete Preset] (archivo>elimi-

nar configuración prefijada).
3. Si aparece el cuadro de diálogo “Select 

Devices”, seleccione uno de la lista de dispositi-
vos disponibles y haga clic en [Connect].

4. Se visualiza el cuadro de diálogo “Select Preset 
to delete” (seleccionar configuración prefijada a 
ser eliminada), como se ilustra abajo en la 
Figura 4-4.

5. Seleccione la configuración prefijada que se 
desea eliminar, o mantenga pulsada la tecla 
Mayús y haga clic para seleccionar más de una 
configuración prefijada.

6. Haga clic en [Delete] (eliminar).

FIGURA 4-3: Cuadro de diálogo 
“Preset Information” 

FIGURA 4-4: Cuadro de diálogo “Select Preset to Delete”
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Copias de respaldo del dispositivo
Copias de respaldo del dispositivo

Se pueden hacer copias de respaldo de todas las configuraciones prefijadas y ajustes guardados en el dispositivo en 
un solo archivo, y se puede restaurar esta copia de respaldo en el dispositivo en una fecha posterior. Es necesario 
estar en modo de diseño para restaurar una copia de respaldo.

Para hacer una copia de respaldo de todas las configura-
ciones prefijadas del dispositivo:
1. Seleccione [File>Backup Device] (archivo>crear copia 

de respaldo del dispositivo) del menú principal.
2. Si aparece el cuadro de diálogo “Select Devices”, selec-

cione uno de la lista de dispositivos disponibles y haga 
clic en [Connect].

3. Se visualiza el cuadro de diálogo “Save As Backup” 
(guardar como copia de respaldo), como se ilustra a la 
derecha en la Figura 4-5.

4. Haga clic en [Backup Entire Device] (crear copia de 
respaldo de todo el dispositivo).

5. Se visualiza el cuadro de diálogo “Save Backup As” 
(guardar copia de respaldo como), como se ilustra 
abajo a la derecha en la Figura 4-6.

6. Seleccione el directorio deseado y escriba un nombre 
para el archivo.

7. Haga clic en [Save].

Para crear copias de respaldo de configuraciones prefijadas 
específicas:
1. Efectúe los pasos 1-3 anteriores.
2. Haga clic para seleccionar una de las configuraciones 

prefijadas de la lista: Mantenga pulsada la tecla Mayús 
y haga clic o la tecla Ctrl y haga clic para seleccionar 
varias configuraciones prefijadas.

3. Haga clic en el botón [Backup Selected Presets] (crear 
copia de respaldo de configuraciones prefijadas selec-
cionadas).

4. Se visualiza el cuadro de diálogo “Save As”. 
5. Seleccione el directorio deseado, escriba un nombre 

para el archivo y haga clic en [Save].
6. Siga los pasos 4 y 5 para cada configuración prefijada 

que haya seleccionado para hacerle copia de respaldo.

Para restaurar una copia de respaldo en el dispositivo:
1. Haga clic en el botón [Design Mode] de la barra de control.
2. Seleccione [File>Restore Device] (archivo>recuperar 

dispositivo) del menú principal.
3. Se visualiza el cuadro de diálogo “Open Backup” (abrir 

copia de respaldo), semejante al cuadro “Save Backup 
As” ilustrado a la derecha en la Figura 4-6.

4. Seleccione el directorio correcto y la copia de respaldo 
apropiada de la lista.

5. Haga clic en [Open].
6. Si aparece el cuadro de diálogo “Select Devices”, seleccione uno de la lista de dispositivos disponibles y haga clic 

en [Connect].
7. La copia de respaldo se envía al dispositivo.

FIGURA 4-5: Cuadro de diálogo “Save As Backup” 

FIGURA 4-6: Cuadro de diálogo “Save Backup As”
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Menú de dispositivos
Menú de dispositivos

Lista de programas de Shure Link
Se lista aquí todo el software de Shure Link instalado en su computadora. Para pasar a otro programa, selec-
ciónelo del menú; el programa se lanzará en modo de diseño.

Modo global de configuración prefijada 
Cuando se activa este modo en cada dispositivo Shure Link conectado a la red, un cambio de configuración
prefijada de uno de los dispositivos afectará las configuraciones prefijadas de todos ellos. Una marca de verifi-
cación aparece junto a esta función del menú cuando está activa en el DFR22.

Configuración de clavijas de control
Seleccione esta función del menú para configurar las clavijas de control para controlar el dispositivo mediante
un equipo físico externo. Esta función abre la ventana “Control Pins”, que se explica en detalle en el capítulo
que empieza en la página 87.

Selección del puerto COM
Seleccione esta función del menú para indicar el puerto COM en el que se
conecta al DFR22 ó la red Shure Link. La función abre el cuadro de diálogo
“COM Port” (seleccionar puerto COM), en el que se listan todos los puertos
COM de su computadora.

Para seleccionar el puerto COM
1. Seleccione [Devices>Select COM Port] (dispositivos>selección de 

puerto COM) del menú principal.
2. Se despliega el cuadro de diálogo “COM Port”, como se ilustra en la 

Figura 4-7.
3. Seleccione el puerto COM al cual se ha conectado el cable RS-232 y 

haga clic en [OK].

Designación del nombre del dispositivo
Esta función del menú le permite designar un nombre único para el DFR22,
con el fin de distinguirlo más claramente en la lista de dispositivos.

Para designar el nombre del dispositivo:
1. Seleccione [Devices>Name Device] del menú principal.
2. Se visualiza el cuadro de diálogo “Name Device” como se ilustra en la 

Figura 4-8.
3. Escriba un nombre para el dispositivo, de hasta quince caracteres de 

largo, y haga clic en [Name].
4. El nombre del dispositivo aparece en la barra de títulos de la ventana principal cuando se está en modo en 

vivo, y se indica en el menú [Devices].

Lista de dispositivos
Cuando está en modo en vivo, aparecen en la lista todos los dispositivos Shure Link conectados a la red.
Seleccione un dispositivo para acceder a él directamente y lanzar su software de control en el modo en vivo.

FIGURA 4-7: Cuadro de diálogo 
“COM Port”

FIGURA 4-8: Cuadro de diálogo 
“Name Device”
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SECCION 5 Características del procesador
En esta sección se describen funciones del software que son comunes entre muchas de las ventanas de parámetros de
procesadores. Para las características específicas de procesadores individuales, consulte la sección Procesadores
fijos en la página 41 y la sección Procesadores modulares en la página 47.

Controles de nivel

Los controles de nivel aparecen en muchas de las ventanas de procesadores, como en el ejemplo ilustrado abajo a la 
derecha, en la Figura 5-1. Le permiten ajustar el nivel de ganancia moviendo el Mouse hacia arriba o hacia abajo, tal 
como se desliza un control de ganancia en una consola mezcladora. También se puede especificar el nivel escribi-
endo un número en el cuadro de valores. Primero seleccione el control de nivel, después ajuste el nivel usando cual-
quiera de los métodos descritos a continuación.

Selección
Seleccione un control de nivel colocando el cursor del Mouse sobre la perilla del control y haciendo clic con el
botón izquierdo del Mouse, o haciendo clic en el cuadro de valores ubicado debajo del control de nivel. La
perilla de control de nivel se resalta para indicar que ha sido seleccionada. Si la ventana contiene varios con-
troles de nivel, es posible avanzar entre ellos de izquierda a derecha usando la tecla Tab, y de derecha a
izquierda usando la combinación de teclas Mayús + Tab.

Ajuste del nivel

Para ajustar el nivel con el Mouse:

• Haga clic sobre la perilla del control de nivel y mantenga 
oprimido el botón del Mouse para arrastrarla hacia arriba o 
hacia abajo.

• Haga clic en las graduaciones del control al nivel que se 
desea fijar.

• Haga clic con el botón derecho del Mouse sobre la perilla 
del control de nivel para fijarlo en 0 dB.

Para ajustar el nivel con el teclado:
1. Seleccione el control de nivel que se desea ajustar.
2. Utilice cualquiera de las teclas siguientes para ajustar el valor.

Cuadro de valores
El cuadro de valores le permite especificar el nivel con una precisión de una décima de decibelio. Todos
los controles de nivel tienen un cuadro de valores correspondiente. En la mayoría de las ventanas de
procesador, cada control de nivel tiene un cuadro de valores directamente debajo del mismo. Las dos
excepciones son las ventanas de GEQ10 y GEQ30, las cuales tienen un solo cuadro de ganancia para

Control de nivel seleccionado

Control de nivel no seleccionado

Tecla Resultado
Flecha arriba Aumentar 0,5 dB

Flecha abajo Disminuir 0,5 dB

Re Pág Aumentar 3 dB

Av Pág Disminuir 3 dB

Barra espaciadora Ajusta el valor a 0 dB

1

2

3

4

1. Fila graduada de 
control de nivel

2. Perilla de control 
de nivel

3. Cuadro de valores
4. Botones de flecha

FIGURA 5-1: Controles estándar
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Cómo guardar y recuperar valores de ajuste
todo el juego de controles de nivel. En este caso, seleccione primero la perilla que se desea ajustar y
luego escriba un valor en el cuadro.

Botones de flecha
Hay botones de flecha junto a todos los cuadros de valores. Proporcionan un medio cómodo de aumentar
el valor sin tener que escribir un valor específico.

Para ajustar el valor con los botones de flecha:

• Haga clic en el botón con flecha arriba o flecha abajo para variar el nivel en +/– 0,5 dB. 
• Mantenga un botón de flecha pulsado para aumentar o reducir el nivel de modo continuo. Si se man-

tiene pulsado por más tiempo, la velocidad de cambio aumenta.

Cómo guardar y recuperar valores de ajuste

Los valores de ajuste de cualquier ventana de parámetros de procesador pueden guardarse en un archivo de com-
putadora y recuperarse la siguiente vez que se necesite una configuración similar para un procesador del mismo tipo. 
Esto le permite crear valores de ajuste personalizados o para una instalación específica para procesadores común-
mente utilizados. Si se van a guardar muchos valores de ajuste en la computadora, es buena idea crear un directorio 
específicamente para los valores de ajuste de procesadores o para una instalación particular.

Para guardar los valores de ajuste de un procesador:
1. Haga doble clic en el bloque procesador para abrir su ventana de parámetros.
2. Seleccione [File>Save Settings] (archivo>guardar valores de ajuste) del menú principal o pulse Ctrl + S en 

el teclado.
3. Seleccione el directorio deseado y escriba un nombre para el archivo.
4. Haga clic en [Save].
5. El programa agrega una extensión al archivo que identifica el tipo de procesador que lo creó. Consulte el 

Apéndice C: Extensiones de archivos para una lista completa de extensiones de archivo para ajustes de 
procesador.

Para recuperar valores de ajuste de un procesador:
1. Haga doble clic en el bloque procesador para abrir su ventana de parámetros.
2. Seleccione [File>Recall Settings] (archivo>recuperar valores de ajuste) del menú o pulse Ctrl + R en 

el teclado.
3. Seleccione el directorio correspondiente y el archivo de valores ajuste deseado.
4. Haga clic en [Open].

Designación de ventanas de procesador

La ventana de parámetros de cada bloque procesador modular en el diagrama de flujo de señales puede recibir un 
nombre individual, lo cual es útil cuando se abren varias ventanas simultáneamente. Por omisión, los títulos de venta-
nas de procesador incluyen el nombre de la categoría general del procesador, el rótulo de la fila de canales en la cual 
ha sido colocado, el número de espacio y el estado del bloqueo de seguridad.

Para distinguir entre procesadores similares, es posible personalizar el nombre de la ventana para reflejar la función 
particular o los valores de ajuste del procesador. El nombre nuevo de la ventana aparece tanto en la barra de títulos de 
la ventana de parámetros del procesador, como en la barra de tareas de Windows, cuando se minimiza la ventana de 
parámetros.

Para redesignar una ventana de parámetros de procesador:
1. Haga doble clic en el bloque para abrir su ventana de parámetros.
2. Seleccione [Options>Name] (opciones>designar) del menú.

Nota: Sólo es posible recuperar los valores de ajuste correspondientes a un procesador idéntico 
al que creó el archivo de valores de ajuste.
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Imágenes instantáneas
3. Escriba un nombre nuevo, de hasta quince caracteres.
4. Haga clic en [OK].

Imágenes instantáneas

La función de imágenes instantáneas se ofrece para todas las ventanas de parámetros de procesador que muestran la 
gráfica de una curva de respuesta o de transferencia. Le permite capturar una imagen de la curva actual para luego 
desplegarla con fines de referencia cuando se modifican los valores de ajuste del procesador. El procesador guarda 
esta imagen instantánea en memoria hasta que se capture una imagen nueva de la misma ventana de procesador, o 
hasta que se salga del programa.

Las curvas de respuesta siguientes son ejemplos tomados de la ventana de parámetros de un ecualizador paramétrico 
de cinco bandas con filtros atenuadores y limitadores (PEQ5+CS).

Para usar la función de imágenes instantáneas:
1. Haga clic en el botón [TAKE] (tomar) 

como se ilustra en la Figura 5-2. Esto 
captura la curva actual de respuesta o de 
transferencia.

2. Haga clic en el botón [SHOW] (mostrar). 
Esto despliega la imagen instantánea detrás de la 
curva actual. El botón se ilumina en verde cuando se despliega la imagen instantánea.

3. Modifique los valores de ajuste del procesador. 
A medida que se modifica la curva, es posible 
compararla con la imagen instantánea de la 
curva anterior, la cual aparece en el fondo, 
como se ilustra en la Figura 5-3.

4. Haga clic en el botón [SHOW] nuevamente para ocultar 
o mostrar la imagen instantánea, como se ilustra a la 
derecha en la Figura 5-4.

Nota: Esto solamente cambia el nombre de la ventana de parámetros del procesador. El título 
del bloque procesador en el diagrama de flujo de señales no cambia.

Nota: Cuando se muestra la imagen instantánea 
antes de haber modificado los ajustes del 
procesador, ésta se hallará oculta detrás de 
la curva actual. La imagen instantánea queda 
visible tan pronto se modifica la forma de la 
curva, al cambiar los valores de ajuste.

FIGURA 5-2: Captura de una imagen instantánea

FIGURA 5-3: Modificación de la curva de respuesta

FIGURA 5-4: Ocultado de la imagen instantánea
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Importación de archivos ASCII
Importación de archivos ASCII

En las ventanas del procesador con ecualizador y la ventana de respuesta combinada podrán mostrarse datos prove-
nientes de un archivo ASCII, como se muestra en la ilustración siguiente de una ventana “PEQ10+CS”.

Utilice la función de importación de archivos ASCII para desplegar información de frecuencia en función de magnitud 
medida con los sistemas Smaart o TEF. Si se invierten los datos, se puede usar la representación gráfica como una 
guía visual para fijar los parámetros de los ecualizadores. La pantalla sólo muestra los valores de amplitud correspon-
dientes a las frecuencias contenidas en el archivo. No interpola una línea entre los puntos medidos. En consecuencia, 
puede haber espacios vacíos en la vista, particularmente a frecuencias bajas.

La función de importación de archivos ASCII es compatible con los siguientes formatos:

• Mediciones de función de transferencia hechas con SIA-Smaart® (versiones 2/x y 3.x) y SIA SmaartLive™.
• Mediciones de TDS en todas las versiones del software TEF™ para los entornos Windows y DOS, y medi-

ciones de EFC en software TEF SLX.

Guardado de archivos en formato ASCII

Archivos Smaart
Para exportar una medición usando el software Smaart, haga mediciones en el modo de función de trans-
ferencia. Luego seleccione [File>ASCII Save] (archivo>guardar como ASCII) del menú del programa
Smaart. 

FIGURA 5-5: Importación de archivos ASCII
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Importación de archivos ASCII
Archivos TEF
Para exportar una medición usando el software TEF de TDS: 
1.Seleccione [File>Save] del menú del programa TEF TDS. 
2.Introduzca la información del archivo y haga clic en [Save].
3.En la ventana “Save TDS File”, seleccione el tipo de archivo “ASCII”.

Controles y características de importación

Importar
Haga clic en este botón para importar archivos ASCII creados por los programas Smaart o TEF.
Cuando aparece el cuadro de diálogo “Open File”, seleccione el archivo que se desea importar.

Los datos del archivo importado se despliegan en la gráfica de respuesta. Cuando se importa un archivo
TDS o EFC creado por TEF, el valor promedio de magnitud se representa como 0 dB y los otros valores
de magnitud se gradúan de modo correspondiente. Por omisión, los archivos de función de transferencia
creados por Smaart no se compensan. Los valores de magnitud se centran alrededor del eje de 0 dB, tal
como ocurre con los datos generados por Smaart.

Refrescar
Haga clic en este botón para volver a importar el último archivo que se importó. Si se hacen
mediciones nuevas con los programas Smaart o TEF y se guardan en un archivo con el mismo

nombre, se puede pulsar el botón [REFRESH] (refrescar) para importar la medición nueva sin tener que
abrir el cuadro de diálogo de abrir archivos. 

Mostrar
Haga clic en este botón para ocultar o mostrar la vista del archivo importado. El botón [SHOW] se
ilumina en verde cuando se despliega la imagen de un archivo.

Compensación
Indica la cantidad por la cual se ha compensado la vista respecto a los valores reales de ampli-
tud contenidos en el archivo ASCII. Por omisión, la medición de TDS o EFC hecha con TEF
estará compensada según su valor promedio de amplitud, de modo que éste quede centrado

respecto al eje de 0 dB en la gráfica de respuesta.

Invertir
Haga clic en esta casilla para invertir los datos desplegados respecto al eje x. La vista invertida
entonces puede usarse como guía visual para fijar los parámetros de ecualizadores. [INVERT] se

selecciona por omisión.

Ayuda
Haga clic en este botón para acceder a la ayuda interactiva para la importación de archivos
ASCII generados por los programas Smaart y TEF.

Nota: El botón [REFRESH] NO modifica el valor de compensación del archivo original. Si el valor promedio 
de magnitud de un archivo TDS o EFC de TEF varía, la vista refrescada todavía estará compen-
sada según el valor promedio original. Además, la compensación añadida usando la caja de texto 
[OFFSET] (compensación) no se altera cuando se hace clic en el botón [REFRESH].
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Gráfica de respuesta combinada

En esta ventana se resumen las curvas de respuesta de los procesadores incluidos en la trayectoria de señal selec-
cionada, para ayudarle a conseguir una ecualización uniforme en toda la sala. Para acceder a esta ventana seleccione 
[View>Combined Response Graph] (ver>gráfica de respuesta combinada) del menú principal.

Características de la ventana

1) Selector de fila de entrada
Se listan en él las filas de entrada, con el mismo nombre que reciben en el diagrama de flujo de señales.
Seleccione la fila cuya respuesta combinada desea ver.

2) Selector de fila de salida
Se listan en él las filas de salida, con el mismo nombre que reciben en el diagrama de flujo de señales. Si
se seleccionan una fila de salida y una de entrada, se visualizará la respuesta combinada para esa trayec-
toria de señal.

3) Selector de procesador
Por omisión, la respuesta de ecualizadores, DFR y redes de cruce se combina en la gráfica de respuesta.
Los ecualizadores incluyen procesadores PEQ, GEQ y CUT/SHELF (atenuadores/limitadores).  Las redes
de cruce incluyen la red de cruce de 2 vías y el procesador del subwoofer. Los DFR incluyen todos los
procesadores DFR monofónicos y estereofónicos.

4) Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta combinada actual haciendo
clic en el botón [TAKE] y luego desplegarla en el fondo de la imagen para fines de comparación haciendo
clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la imagen instantánea.

1 2 3

4

5

67

FIGURA 5-6: Ventana “Combined Response Graph”
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Gráfica de respuesta combinada
Para una descripción más detallada de la característica de imagen instantánea, vea la sección Imágenes
instantáneas en la página 36. 

5) Importación de archivos ASCII
Esta función le permite importar datos de frecuencia de SIA Smaart y Gold Line TEF hacia la gráfica de
respuesta. Una vez colocados en la gráfica, podrá usar estos datos gráficos como referencia para moldear
la curva de respuesta de cualquiera de los procesadores en la trayectoria de señal. Vea la página 37 para
ver las instrucciones sobre cómo importar archivos ASCII.

6) Gráfica de respuesta
Esta pantalla se actualiza a medida que se cambian los valores de ajuste de los procesadores y sus posi-
ciones en la trayectoria de señal especificada.

7) Indicador de polaridad
Despliega la polaridad teniendo en cuenta la suma total de la trayectoria de señal. Si se selecciona una
entrada, se despliega la configuración en el bloque de ganancia de entrada. Si se selecciona una salida, el
indicador despliega la configuración en el bloque de matriz mezcladora, cualquier procesador de red de
cruce o subwoofer, y el bloque de ganancia de salida. Si se seleccionan ambos, una entrada y una salida,
se incluirán en el despliegue todos los ajustes de polaridad de la trayectoria.
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SECCION 6 Procesadores fijos
Estos procesadores componen las tres etapas diferentes de la estructura de ganancia del DFR22 (consulte la
página 17 para mayor información sobre este tema). Se les denomina procesadores fijos por los bloques de ganancia
y de mezcla del diagrama de flujo de señales no pueden moverse ni eliminarse.

Ganancia de entrada

La ventana “Input Gain” (ganancia de entrada) contiene controles individuales para ambos canales de entrada. Haga 
doble clic en el bloque de ganancia que se encuentra en el extremo izquierdo de cualquiera de las filas de canales de 
entrada para abrir esta ventana, como se ilustra abajo en la Figura 6-1.

1) Alternativas de escala
Utilice estos botones para fijar la escala de un canal de entrada de modo correspondiente al nivel de sal-
ida del equipo conectado antes del procesador de audio. Haga clic para seleccionar entre los niveles de –
10 dBV ó +4 dBu. El valor por omisión es +4 dBu.

2) Polaridad de la señal
Haga clic en este botón para invertir la polaridad de la señal que entra por la fila de canales de entrada. El
valor por omisión es el de polaridad normal.

+4 dBu seleccionado

–10 dBV seleccionado

Polaridad normal

Polaridad invertida

1

2

3

4

5

6

FIGURA 6-1: Ventana “Input Gain”
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Ganancia de entrada
3) Controles de ganancia
Utilice estos controles para ajustar el nivel de la señal de cada canal de entrada. Primero seleccione la
perilla del control y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado
en el cuadro de valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Con-
troles de nivel en la página 34. La gama de ajuste oscila de +10 dB a –infinito dB, y el valor por omisión es
de 0 dB, o ganancia unitaria.

4) Silenciamiento de canales
Haga clic en este botón para silenciar el canal. Cuando se activa el silenciamiento, el botón se ilumina en
rojo. El valor por omisión es el de desactivado.

5) Rótulo de canal
Utilice este cuadro de texto para personalizar el rótulo del canal de entrada en el diagrama de flujo de
señales. El valor por omisión es el rótulo “Untitled In” (entrada sin título) para cada canal de entrada.

6) Indicador de enlace
Visualiza el estado de enlace del canal de entrada. Todo valor de ajuste que se modifique en un canal
enlazado afecta al otro canal que pertenezca al mismo grupo de enlace. Para una explicación completa
del enlace y los grupos de enlace, consulte la sección Enlace en la página 24. 

Nota: Los controles de ganancia de entrada regulan el nivel de la señal después que la misma ha sido 
convertida a formato digital por el procesador de audio. Las señales cuyo nivel excede el umbral 
de entrada del procesador de audio deben ajustarse por medios externos. 

Silenciamiento activado

Silenciamiento desactivado

Canal enlazado

Canal no enlazado
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Matriz mezcladora
Matriz mezcladora

La ventana “Matrix Mixer” contiene controles para las conexiones de los puntos de mezcla del diagrama de flujo de 
señales, los cuales se organizan por medio de fichas de ventana diferentes para cada punto de mezcla de salida. 
Haga doble clic en cualquiera de los bloques de mezcla para abrir esta ventana, como se ilustra abajo en la Figura 6-2.

1) Fichas de ventana

2

3

4

5

6
7

1

FIGURA 6-2: Ventana “Matrix Mixer”

La ventana se abre con el enfoque colocado en la 
sección de salida correspondiente al bloque en donde 
se hizo doble clic. Haga clic en cualquier ficha para 
acceder a los controles del otro punto de mezcla 
de salida.

Las fichas de ventana corresponden a los puntos de 
mezcla de salida del diagrama de flujo de señales. 
Si se está usando una red de cruce o bifurcador, los 
títulos de las fichas indican que el procesador abarca 
ambos canales de salida, como se ilustra en la 
Figura 6-3.

FIGURA 6-3: Red de cruce en la ventana “Matrix Mixer”
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Matriz mezcladora
2) Selector de entradas
Haga clic en este botón para activar una conexión del punto de mezcla del canal de entrada correspondi-
ente en el diagrama de flujo de señales. El botón se ilumina en verde cuando se activa una conexión. Los
controles de las entradas desactivadas aparecen en gris. El valor por omisión es el de desactivado.

3) Polaridad de la señal

4) Controles de ganancia
Utilice estos controles para ajustar el nivel de la señal de cada canal. Primero seleccione la perilla del con-
trol y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado en el cuadro
de valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Controles de
nivel en la página 34. La gama de ajuste oscila de +10 dB a –infinito dB, y el valor por omisión es de 0 dB,
o ganancia unitaria.

5) Silenciamiento de canales

6) Rótulo de canal
Aquí se despliega el rótulo dado al canal, que se especificó en la ventana “Input Gain” (ganancia de
entrada) o “Output Gain” (ganancia de salida).

7) Indicador de enlace
Visualiza el estado de enlace del punto de matriz mezcladora. Cuando se enlazan bloques de mezcla se
enlazan todos los controles para cada bloque de mezcla, salvo el selector de entrada. Para una expli-
cación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24. 

Conexión activada

Conexión desactivada

Polaridad normal Haga clic en este botón para invertir la polaridad de la señal que 
entra por el punto de matriz mezcladora. El valor por omisión es el 
de polaridad normal.Polaridad invertida

Silenciamiento 
activado Haga clic en este botón para silenciar el canal. Cuando se activa el 

silenciamiento, el botón se ilumina en rojo. El valor por omisión es el de 
desactivado.Silenciamiento 

desactivado

Procesador enlazado

Procesador no enlazado
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Ganancia de salida
Ganancia de salida
La ventana “Output Gain” contiene controles individuales para ambos canales de salida. Haga doble clic en el
bloque de ganancia que se encuentra en el extremo derecho de cualquiera de las filas de canales de salida
para abrir esta ventana, como se ilustra abajo en la Figura 6-4.

1) Alternativas de escala
Utilice estos botones para fijar la escala de un canal de salida de modo correspondiente al nivel de salida
del equipo conectado después del procesador de audio. Haga clic para seleccionar entre los niveles de –
10 dBV ó +4 dBu. El valor por omisión es +4 dBu.

2) Polaridad de la señal
Haga clic en este botón para invertir la polaridad de la señal que sale por la fila de canales de salida. El
valor por omisión es el de polaridad normal.

3) Controles de ganancia
Utilice estos controles para ajustar el nivel de la señal de cada canal de salida. Primero seleccione la
perilla del control y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado
en el cuadro de valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Con-

+4 dBu seleccionado

–10 dBV seleccionado

Polaridad normal

Polaridad invertida
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FIGURA 6-4: Ventana “Output Gain”
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Ganancia de salida
troles de nivel en la página 34. La gama de ajuste oscila de +10 dB a –infinito dB, y el valor por omisión es
de 0 dB, o ganancia unitaria.

4) Atenuadores de salida
Haga clic en uno de estos botones para atenuar la señal de salida en –12 dB ó –18 dB.  Cada uno de los
botones se ilumina en rojo cuando se activa el atenuador seleccionado. El estado por omisión de estos
botones es desactivado.

5) Silenciamiento de canales
Haga clic en este botón para silenciar el canal. Cuando se activa el silenciamiento, el botón se ilumina en
rojo. El valor por omisión es el de desactivado.

6) Rótulo de canal
Utilice este cuadro de texto para personalizar el rótulo del canal de salida en el diagrama de flujo de
señales. El valor por omisión es el rótulo “Untitled Out” (salida sin título) para cada canal de salida.

7) Indicador de enlace
Visualiza el estado de enlace del canal de salida. Todo valor de ajuste que se modifique en un canal
enlazado afecta a todos los demás canales que pertenezcan al mismo grupo de enlace. Para una expli-
cación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24. 

Atenuador de 12 dB acti-
vado
Atenuador de 12 dB des-
activado

Nota: No es posible activar simultáneamente los atenuadores de –12 dB ó –18 dB en la misma salida.

Silenciamiento activado

Silenciamiento desactivado

Canal enlazado

Canal no enlazado
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SECCION 7 Procesadores modulares
En esta sección se describen las características y controles específicos de las ventanas de parámetros de cada uno
de los bloques procesadores. En algunos casos, varios bloques procesadores comparten controles casi idénticos,
tales como el expansor de atenuación y la compuerta. En estos casos, los procesadores se describen como un grupo,
utilizando una sola ventana de parámetros como el ejemplo que se ilustra. Los ajustes que sólo corresponden a un
procesador del grupo se identifican como tales en las descripciones de los controles.

Control automático de ganancia (AGC)

El AGC mantiene un nivel de volumen más constante en casos en que los conferenciantes hablan con distinta inten-
sidad. Actúa del mismo modo que lo haría un ingeniero de sonido usando el control de nivel para aumentar la ganan-
cia de la señal de entrada cuando su nivel es bajo y reducirla cuando su nivel es muy alto.

Función
Utilice este procesador en situaciones en las cuales se desea mantener un nivel de volumen constante, tales
como el caso de los micrófonos de podio y de atril, en los cuales la distancia del conferenciante al micrófono
varía. El AGC compensa los puntos más silenciosos aumentando la ganancia gradualmente. Si el conferen-
ciante entonces habla fuertemente por el micrófono, el AGC gradualmente reduce la ganancia. No obstante, si
un conferenciante cambia repentinamente su tono ya sea gritando, murmurando o acercándose mucho al
micrófono, el correspondiente pico o punto bajo en el nivel total pasará sin modificarse por el AGC. El AGC
sólo modifica la ganancia cuando detecta que hay actividad en la entrada. Esto evita que, sin quererse, la
ganancia cambie durante las pausas normales en la programación.

Nombre del 
bloque Descripción

AGC Control automático de ganancia

1

2

3 4 5
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FIGURA 7-1: Ventana AGC
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Control automático de ganancia (AGC)
Características de la ventana de parámetros
En esta sección se describen las características y controles de parámetros específicos al procesador del con-
trol automático de ganancia, como se ilustra arriba en la Figura 7-1. 

1) Línea de ganancia máxima
La cantidad máxima de amplificación que el AGC dará a la señal es +12 dB, según lo indica la línea de
ganancia máxima. Esto evita la modulación no deseada a causa del ruido y los problemas por realiment-
ación acústica que pueden ocurrir si se amplifican excesivamente las señales de poca intensidad. La línea
de ganancia máxima sólo aparece en la gráfica de la curva de transferencia cuando la combinación de los
valores de umbral, articulación y relación hace que el AGC imponga el límite de amplificación de +12 dB.

2) Gráfica de curva de transferencia
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como elemen-
tos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante representa
el cambio en el nivel de salida de la señal.

3) Control de umbral
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este control
puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior de la gráfica
de curva de transferencia, para cambiar el valor umbral.

4) Control de relación
La posición del control de relación corresponde con el valor de ajuste del control de relación. Este control
puede arrastrarse con el Mouse hacia arriba y abajo, a lo largo del borde derecho de la gráfica de curva de
transferencia, para cambiar el valor de relación.

5) Medidor de reducción de ganancia
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal de entrada
con los valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse
seleccionando la función [Options>Gain Reduction Meter] (opciones>medidor de reducción de ganancia)
del menú. Su valor por omisión es de activado.

6) Controles de ganancia
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama de
valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión es de 0
dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección Controles de
nivel en la página 34.

7) Control de articulación
La posición del control de articulación corresponde con el valor de ajuste del control de articulación. Este
control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde inferior de la
gráfica de curva de transferencia, para cambiar el valor de articulación.

8) Medidor de curva de transferencia
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel relativo
de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro actual. Esta
característica puede desactivarse y activarse seleccionando la función [Options>Transfer Curve Meter]
(opciones>medidor de curva de transferencia) del menú. Su valor por omisión es de activado.

Nota: Se puede perjudicar el rendimiento del software si se tienen demasiados medidores activos en el 
procesador de audio. Se puede desactivar el medidor de la curva de transferencia, o el medidor de 
reducción de ganancia, o ambos, con el menú [Options].
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Control automático de ganancia (AGC)
Indicador de umbral excedido.

Umbral
Indica el nivel de ganancia que la señal debe alcanzar antes que el procesador la ampli-
fique. Las señales cuyo nivel es inferior al umbral pasan por el procesador con ganancia uni-
taria. El valor puede cambiarse por medio de los botones de flecha, escribiendo un valor
específico, o usando el control de umbral que está en la parte superior de la gráfica de la

curva de transferencia. La gama de valores disponibles oscila de –60 dB a +20 dB en incrementos de 0,5
dB, con un valor por omisión de 0 dB.

Relación
Indica la cantidad de reducción de ganancia que se obtiene en la salida del procesador, en
relación con el nivel de entrada que excede el valor de articulación. Un ajuste de 4:1, por
ejemplo, significa que un aumento de 4 dB en el nivel del material sonoro produce un

aumento de 1 dB en el nivel de salida del procesador. El valor puede cambiarse por medio de los botones
de flecha, escribiendo un valor específico, o usando el control de relación que está en el lado derecho de
la gráfica de la curva de transferencia. La gama de valores disponibles oscila de 1:1 a 10:1 en incrementos
de una décima, con un valor por omisión de 2:1.

Ataque
Indica el tiempo que el procesador espera antes de responder a un aumento o disminución
en los niveles de entrada, una vez que la señal de entrada excede el nivel de umbral. Los
valores disponibles oscilan de 0,2 a 3 s, y el valor por omisión es de 2 segundos.

Extinción
Indica el tiempo que el procesador espera antes de retornar a ganancia unitaria, una vez que
el nivel de entrada aumenta o disminuye acercándose al valor de articulación. Los valores
disponibles oscilan de 0,5 a 5 s, y el valor por omisión es de 5 segundos.

Articulación
El valor de articulación es el nivel de salida deseado para el AGC. Es un punto de tran-
sición que determina si la señal de entrada se amplifica o se reduce. Las señales cuyo
nivel es menor que el de articulación (pero mayores que el valor de umbral) son amplifica-
das, mientras que las señales menores son atenuadas. El valor puede cambiarse por

medio de los botones de flecha, escribiendo un valor específico, o usando el control de articulación que
está en la parte inferior de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de
–60 dB a +20 dB en incrementos de 0,5 dB, con un valor por omisión de 0 dB.

Ajuste en fábrica
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste en
fábrica.

El nivel de la señal ha excedido el umbral Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque procesador 
excede el umbral especificadoEl nivel de la señal no ha alcanzado el umbral
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Derivación
Haga clic en este botón para que la señal pase sin ser modificada. Cuando se activa la derivación, el botón
se ilumina en rojo. El valor por omisión es el de desactivado.

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Derivación activada

Derivación desactivada

Procesador enlazado

Procesador no enlazado
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Compresor/Limitador

Los compresores y limitadores reducen el nivel de salida de la señal en relación con el nivel de entrada, una vez 
que el nivel de entrada excede cierto valor umbral. El procesador de audio ofrece los tipos siguientes de compre-
sores y limitadores:

Función
Utilice el compresor para ajustar la escala de salida de una señal de modo que la misma quede adecuada para
equipos cuyo rango dinámico es más estrecho, tales como un amplificador, grabadora de cinta, o altavoz.
Utilice el limitador para proteger el sistema contra descargas repentinas de sonidos intensos que pudieran
dañar los altavoces. Al retardar la señal 1 ms, el limitador de tope de picos tiene un tiempo de acometida de 0
que le permite tener un control aun más preciso sobre los picos transitorios. El compresor y limitador funcionan
de modo similar; sin embargo, el limitador típicamente se ajusta para un tiempo de ataque más rápido y una
relación de compresión más alta. 

Nombre del 
bloque Descripción

COMP Compresor
Sft COMP Compresor de articulación suave
LIM Limitador
Sft LIM Limitador de articulación suave
ST COMP

Igual que el anterior: para uso 
en dos canales que forman un 
par estereofónico.

Sft ST COMP
ST LIM

Sft ST LIM

PEAK LIM Limitador de tope de picos (de 
respuesta anticipada)

1

2 3 4

5

67
FIGURA 7-2: Ventana Sft ST COMP
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Los tipos siguientes de procesadores se encuentran disponibles como limitadores y compresores:

• Articulación suave - Estos procesadores proporcionan una transición gradual de la señal sin compresión a 
la señal con compresión. Consumen un porcentaje mayor de recursos de DSP que los que no tienen la 
opción de articulación suave.

• Estereofónico - Estos procesadores le permiten preservar la imagen sonora estereofónica colocando dos 
bloques que funcionan como un solo procesador en dos canales diferentes. Los dos canales procesa-
dores reaccionan con reducciones idénticas en su ganancia cuando la señal de entrada de uno de los 
canales excede el valor umbral. Estos procesadores consumen un porcentaje más alto de recursos de 
DSP que los procesadores monofónicos.

Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros de los compresores y limitadores
usando el Sft LIM COMP a manera de ejemplo, como se ilustra arriba en la Figura 7-2. Todos los procesa-
dores descritos en esta sección funcionan de modo muy similar. Las diferencias entre sus características y sus
funciones se indican, según corresponda.

1) Gráfica de curva de transferencia
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como elemen-
tos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante representa
el cambio en el nivel de salida de la señal.

2) Control de umbral
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este control
puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior de la gráfica
de curva de transferencia, para cambiar el valor umbral.

3) Control de relación
La posición del control de relación corresponde con el valor de ajuste del control de relación. Este control
puede arrastrarse con el Mouse hacia arriba y abajo, a lo largo del borde derecho de la gráfica de curva de
transferencia, para cambiar el valor de relación.

4) Medidor de reducción de ganancia
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal de entrada
con los valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse
seleccionando la función [Options>Gain Reduction Meter] (opciones>medidor de reducción de ganancia)
del menú. Su valor por omisión es de activado.

5) Controles de ganancia
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama de
valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión es de 0
dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección Controles de
nivel en la página 34.

6) Selectores de medidor de curva de transferencia (sólo procesadores estereofónicos)
Mediante estos botones se puede seleccionar el canal o canales cuya medición de curva de transferencia
desea ver. Cada uno de los botones se ilumina en verde cuando se activa el medidor de cada canal.

7) Medidor de curva de transferencia
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel relativo
de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro actual. Esta
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característica puede desactivarse y activarse seleccionando la función [Options>Transfer Curve Meter]
(opciones>medidor de curva de transferencia) del menú. Su valor por omisión es de activado.

Indicador de umbral excedido

Umbral
Indica el nivel de ganancia que la señal debe alcanzar antes que el procesador le aplique
compresión. El valor puede cambiarse por medio de los botones de flecha, escribiendo un
valor específico, o usando el control de umbral que está en la parte superior de la gráfica
de la curva de transferencia. La gama de valores disponibles oscila de –60 dB a +20 dB en

incrementos de 0,5 dB, con un valor por omisión de 0 dB.

Relación
Indica la cantidad de reducción de ganancia que se obtiene en la salida del procesador, en
relación con el nivel de entrada. Un ajuste de 4:1, por ejemplo, significa que un aumento de
4 dB en el nivel del material sonoro produce un aumento de 1 dB en el nivel de salida del

procesador. El valor puede cambiarse por medio de los botones de flecha, escribiendo un valor específico,
o usando el control de relación que está en el lado derecho de la gráfica de la curva de transferencia. La
gama de valores disponibles oscila de 1:1 a infinidad:1 en incrementos de una décima, con un valor por
omisión de 2:1 para los compresores y de 10:1 para los limitadores. El limitador de tope de picos tiene una
relación fija de infinito:1.

Ataque
Indica el tiempo que el procesador espera antes de empezar a reducir la ganancia, una vez
que el nivel de la señal de entrada excede al nivel de umbral. La gama de valores disponi-
bles oscila de 1 ms a 200 ms, con un valor por omisión de 5 ms para los compresores y 2

ms para los limitadores. El limitador de tope de picos tiene un tiempo de acometida fijo de 0 ms.

Extinción
Indica el tiempo que el procesador espera antes de volver a ganancia unitaria, una vez que
el nivel de la señal de entrada cae por debajo del nivel de umbral. La gama de valores dis-
ponibles oscila de 50 ms a 1000 ms, con un valor por omisión de 100 ms para los compre-

sores, 50 ms para los limitadores, y 20 ms para el limitador de tope de picos.

Articulación
En los procesadores de articulación suave, este control despliega una lista que permite seleccionar ya sea
una compresión de articulación suave o fuerte. El valor por omisión es el de “SOFT” (suave). En los com-
presores y limitadores estándar, este control se encuentra desactivado.

Nota: Se puede perjudicar el rendimiento del software si se tienen demasiados medidores activos en 
el DFR22. Se puede desactivar el medidor de la curva de transferencia, o el medidor de reduc-
ción de ganancia, o ambos, con el menú [Options].

El nivel de la señal ha excedido el umbral Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque procesador 
excede el umbral especificadoEl nivel de la señal no ha alcanzado el 

umbral

Procesador de 
articulación suave

Seleccione “SOFT” (suave) o “HARD” (fuerte) de la 
lista que se despliega.

Procesador estándar El control está desactivado.
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Ajuste en fábrica
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste en
fábrica.

Derivación

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Procesadores de articulación suave
Los ejemplos siguientes ilustran la diferencia entre el ajuste de articulación fuerte y articulación suave de com-
presión. Los demás parámetros en este ejemplo permanecen ajustados a valores idénticos.

Una configuración de articulación suave, ilustrada en
la Figura 7-3, es útil cuando se trabaja con relaciones
de compresión elevadas. La articulación suave
aumenta gradualmente la relación de compresión de
1:1, a aproximadamente 12 dB por debajo del umbral,
hasta la relación especificada, a aproximadamente 20
dB por encima del umbral.Este aumento gradual en la
relación hace que el efecto de la compresión sea
menos notorio que el ajuste de articulación fuerte.

El ajuste de articulación fuerte, ilustrada en la 
Figura 7-4, inmediatamente activa la relación de com-
presión especificada, una vez que el nivel de la señal 
excede el valor umbral. Este ajuste es particularm-

ente útil para un limitador, porque evita que los picos transitorios excedan el valor 
umbral sin afectar los niveles de señal por debajo del umbral.

Derivación activada Haga clic en este botón para que la señal pase sin ser 
modificada. Cuando se activa la derivación, el botón se 
ilumina en rojo. El valor por omisión es el de desactivado.Derivación desactivada

Nota: Si la derivación está activada en el limitador de tope de picos, no se deriva el retardo 
de 1 ms

Procesador enlazado

Procesador no enlazado

Nota: Si la situación requiere el uso de la articulación fuerte, se pueden conservar 
recursos de DSP si se usa un procesador estándar en lugar de un procesador de 
articulación suave.

FIGURA 7-3: Opción de 
articulación suave

FIGURA 7-4: Opción de 
articulación fuerte
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Procesadores estereofónicos
Los procesadores estereofónicos tienen las mismas características y funciones que los monofónicos, e
incluyen algunas características adicionales.

• Las modificaciones hechas a uno de los dos canales de un procesador afectan al otro canal también.
• Los dos canales procesadores reaccionan con reducciones idénticas en su ganancia cuando la señal de 

entrada de uno de los canales excede el valor umbral.
• Los medidores dobles de curva de transferencia despliegan el nivel de entrada del canal A en rojo y el del 

canal B en azul.
• Los selectores de medidor le permiten desplegar el medidor de curva de transferencia del canal A, del 

canal B, de ambos canales, o ninguno.
• Los dos canales A y B tienen indicadores de nivel umbral excedido.
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Red de cruce/bifurcador/subwoofer

La red de cruce divide el espectro de frecuencias de la señal de entrada en varias bandas y encamina cada banda a 
un canal de salida diferente. El bifurcador distribuye la señal de entrada en dos salidas, sin procesarla más. El sub-
woofer es un solo filtro pasabajos. Es completamente configurable, por lo que puede también emplearse como filtro 
pasabanda o pasaaltos.

Función
Utilice la red de cruce para dividir la gama de frecuencias de la señal de entrada utilizando dos filtros y luego
distribuir cada banda de frecuencias a un canal de salida separado para diferentes tipos de altavoces. Utilice
el bifurcador si sólo necesita distribuir una misma señal a ambas salidas. Utilice el subwoofer para aislar una
sola banda de frecuencias antes de enviar la señal hacia una salida. La red de cruce, bifurcador y subwoofer
son sólo para procesar canales de salida, y no pueden colocarse en las filas de canales de entrada. Consulte
la sección Adición de procesadores: Red de cruce, bifurcador y subwoofer en la página 23 para mayor infor-
mación sobre la colocación de estos procesadores en el diagrama de flujo de señales. 

Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros de la red de cruce y el subwoofer
usando el XOVER 2 a manera de ejemplo, como se ilustra arriba en la Figura 7-5. Las características del sub-
woofer son idénticas, salvo el número de filtros de banda de paso. El bifurcador no cuenta con ventana de
parámetros puesto que no procesa la señal sino que sencillamente la encamina.

Nombre del 
bloque Descripción

XOVER 2 Red de cruce de 2 vías
SPLIT 2 Bifurcador de 2 vías
SUB Subwoofer

1

2

3

4 5 6 7

FIGURA 7-5: Ventana XOVER2 
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1) Controles de banda de paso
Hay un conjunto de controles por cada canal de salida relacionado con las bandas de paso.

2) Rótulos de canales de salida
Los rótulos que aparecen en la parte superior de las columnas de los controles de las bandas de paso
están codificados por colores que corresponden a las curvas de paso de bandas en el graficador de
respuesta. Indican a cuál canal de salida se encamina cada banda de paso. 

3) Graficador de respuesta
Esta zona de la ventana despliega una representación gráfica de los filtros de banda de paso y puntos de
cruce, los cuales pueden manipularse haciendo clic y arrastrándolos con el Mouse.

4) Bandas de paso
Cada banda tiene puntos de control en sus esquinas de ambos lados que pueden arrastrarse hacia la
izquierda o la derecha para ajustar las frecuencias de corte superior e inferior de modo independiente.
También hay un punto de control de ganancia en el centro de cada banda que puede arrastrarse hacia
arriba o hacia abajo para ajustar el nivel de salida de la banda de paso. Cuando se selecciona un punto de
control, el círculo que lo representa se llena con una bola de color para indicar que es el control activo. Las
pendientes de los filtros superior e inferior se definen con los controles de banda de paso que están en la
sección inferior de la ventana.

5) Punto de control de ganancia
Arrastre este control hacia arriba o hacia abajo para fijar la ganancia de la banda de paso. La posición del
punto de control corresponde al valor de ajuste del control [GAIN].

6) Punto de control de red de cruce
Este punto de control indica la frecuencia del punto de cruce entre dos bandas de paso. Se puede arras-
trarlo hacia la izquierda y la derecha para ajustar simultáneamente las frecuencias de corte de los filtros
cuyas pendientes se intersecan. Cuando se selecciona el punto de control de una red de cruce, se repre-
senta en verde para indicar que es el control activo, y los puntos de control de las frecuencias de corte cor-
respondientes se llenan para indicar que están seleccionados. Los puntos de control de las frecuencias de
corte mantienen sus posiciones relativas cuando se desliza el punto de control de la red de cruce.

7) Puntos de control de frecuencias de corte
Arrastre estos controles hacia la izquierda o la derecha para fijar las frecuencias de corte de la banda de
paso. La posición de estos puntos de control corresponde al valor de ajuste de los controles [LOW CORNER
FREQ] (frecuencia de corte inferior) y [UPPER CORNER FREQ] (frecuencia de corte superior).

Ajuste y despliegue de ganancias/normalización de gráfica
Estos botones se seleccionan para desplegar de modo alternativo las
bandas de paso con sus niveles reales de ganancia, y con una repre-
sentación normalizada. El valor por omisión es [SET AND SHOW GAINS
ON PLOT] (ajuste y despliegue de ganancias en gráfica).

Cuando los niveles de ganancia de las bandas de paso son muy difer-
entes entre sí, el punto de cruce aparece desplazado de su posición
real, como lo ilustra la Figura 7-6. Utilice el modo de gráfica normal-
izada cuando es necesario ver la posición precisa del punto de cruce,
como se ilustra en la Figura 7-7.

Nota: Para observar el efecto de la red de cruce en la trayectoria de señal, seleccione [View>Combined 
Response Curve] (ver>curva de respuesta combinada) del menú principal. Para mayor información con-
sulte la sección Gráfica de respuesta combinada en la página 39.

FIGURA 7-6: [SET AND SHOW GAINS 
ON PLOT]
© 2003 Shure Incorporated Guía del software DFR22 57
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• Haga clic en el botón [SET AND SHOW GAINS ON PLOT] para 
desplegar y ajustar los niveles de ganancia de las bandas de 
paso. En este modo, los niveles de los filtros se representan 
en el graficador de respuesta y los puntos de control de 
ganancia quedan visibles en las bandas de paso.

• Haga clic en el botón [NORMALIZE PLOT] para representar las 
bandas de paso con ganancia unitaria con el graficador de 
respuesta. Este modo no afecta los niveles reales de ganancia.

Ajuste en fábrica
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste en
fábrica.

Silenciamiento

Polaridad

Frecuencia de corte inferior
Indica el valor de ajuste de la frecuencia de corte inferior de la banda de paso. La gama de
valores disponibles depende del valor al cual se ha ajustado la frecuencia de corte superior,
puesto que estas dos frecuencias no pueden traslaparse entre sí. El valor puede cambiarse

haciendo clic en los botones de flecha, usando el teclado, o escribiendo un valor específico. Los valores
por omisión de las bandas de paso se listan a continuación. 

Tipos de filtros inferior/superior
Esto indica la pendiente de atenuación del filtro correspondiente a la frecuencia de corte de
la banda de paso. Seleccione un valor del menú, como se indica a continuación. El valor

por omisión es un filtro Linkwitz-Riley de 24 dB/octava.

Silenciamiento 
activado Haga clic en este botón para silenciar la salida de la banda corre-

spondiente. Cuando se activa el silenciamiento, el botón se ilumina 
en rojo. El valor por omisión es desactivado.Silenciamiento 

desactivado

Polaridad normal Haga clic en este botón para invertir la polaridad de la señal que 
sale de la red de cruce. El valor por omisión es el de polaridad 
normal.Polaridad inversa

Banda 1 SALIDA

Banda 2 2,0 kHz

Abreviatura Descripción
6 Butt Butterworth de 6 dB/oct
6 Bessel Bessel de 6 dB/oct
12 Butt Butterworth de 12 dB/oct
12 Bess Bessel de 12 dB/oct
12 L-R Linkwitz-Riley de 12 dB/oct
18 Butt Butterworth de 18 dB/oct
18 Bessel Bessel de 18 dB/oct
24 Butt Butterworth de 24 dB/oct
24 Bess Bessel de 24 dB/oct
24 L-R Linkwitz-Riley de 24 dB/oct

FIGURA 7-7: [NORMALIZE PLOT}
© 2003 Shure Incorporated Guía del software DFR22 58



Red de cruce/bifurcador/subwoofer
Frecuencia de corte superior
Indica el valor de ajuste de la frecuencia de corte superior de la banda de paso. La gama
de valores disponibles depende del valor al cual se ha ajustado la frecuencia de corte infe-
rior, puesto que estas dos frecuencias no pueden traslaparse entre sí. El valor puede cam-

biarse haciendo clic en los botones de flecha, usando el teclado, o escribiendo un valor específico. Los
valores por omisión de las bandas de paso se listan a continuación. 

Ganancia
Utilice los controles de ganancia para ajustar los niveles de ganancia de salida. La gama
de valores disponibles oscila entre –18 dB y +12 dB, en incrementos de 0,5 dB; el valor
por omisión es de 0 dB. El valor puede cambiarse siguiendo las convenciones que se
explican en la sección Controles de nivel en la página 34.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Teclas de control
Se pueden usar teclas especiales para hacer ajustes finos a la posición de los puntos de control del grafi-
cador de respuesta. Haga clic en un punto de control para seleccionarlo, y después utilice las combina-
ciones de teclas siguientes.

Banda 1 2,0 kHz
Banda 2 SALIDA

Procesador enlazado

Procesador no enlazado

Tecla Ajuste de frecuencia

�
Reduce la frecuencia el equivalente de un 
pixel en la pantalla

�
Aumenta la frecuencia el equivalente de un 
pixel en la pantalla

Mayús + � Reduce la frecuencia por 1/3 octava
Mayús + � Aumenta la frecuencia por 1/3 octava

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor de la misma 
cambia en aproximadamente 1/100 de octava, ó 1%.

Tecla Ajuste de ganancia
� Aumenta la ganancia en 0,5 dB
� Reduce la ganancia en 0,5 dB

Mayús + �
o Re página Aumenta la ganancia en 3 dB

Mayús + �
o Av página Reduce la ganancia en 3 dB

Barra espacia-
dora o clic con
botón derecho

Ajusta la ganancia a 0 dB
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Filtros atenuadores y limitadores
Filtros atenuadores y limitadores

Los filtros atenuadores y limitadores amplifican o atenúan la respuesta general de un sistema a frecuencias altas y 
bajas, y atenúa progresivamente los extremos superior e inferior del espectro de frecuencias.

Función
Utilice este procesador cuando sea necesario combinar filtros atenuadores con ecualización de frecuencias
altas y bajas de amplio espectro para la sala. Los filtros atenuadores de frecuencias altas y bajas ofrecen una
amplia variedad de alternativas de pendiente que oscilan entre los –6 dB/octava y los –24 dB/octava. También
se puede ajustar la pendiente de la frecuencia de corte de los filtros limitadores a ya sea 6 dB/octava ó 12 dB/
octava.

Características de la ventana de parámetros
En esta sección se describen las características y controles de parámetros específicos al procesador de filtros
atenuadores y limitadores, como se ilustra arriba en la Figura 7-8.

Nombre del 
bloque Descripción

CUT/SHELF Filtros atenuadores/limitadores de frecuencias altas 
y bajas

1

2

3

4

FIGURA 7-8: Ventana CUT/SHELF
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Filtros atenuadores y limitadores
1) Gráfica de respuesta
Esta curva es una representación gráfica del resultado que producen las posiciones de los puntos de con-
trol de filtro fijadas en el graficador de respuesta.

2) Graficador de respuesta
Esta zona de la ventana de parámetros despliega una representación gráfica de los puntos de control de
los filtros atenuadores y limitadores, los cuales pueden manipularse haciendo clic y arrastrándolos con el
Mouse. Cuando se abre la ventana de parámetros inicialmente, los puntos de control del filtro aparecen en
sus posiciones especificadas en fábrica, en los límites extremos superior e inferior del espectro. Haga clic
en un punto de control para ver su curva de respuesta y ajustar sus parámetros.

3) Filtros atenuadores
Los filtros atenuadores se representan por medio de puntos de control en el borde inferior del graficador
de respuesta y líneas punteadas verticales dibujadas sobre sus frecuencias centrales. El valor determi-
nado en fábrica es “OUT” (desactivado) y el tipo de filtro determinado en fábrica es Butterworth de 6 dB/
octava.

4) Filtros limitadores
Los filtros atenuadores/limitadores de frecuencias altas y bajas aparecen a lo largo de un eje horizontal
que está en el centro del graficador de respuesta. El valor determinado en fábrica es “OUT” y el tipo de filtro
determinado en fábrica es de 6 dB/octava.

Frecuencia
Indica la frecuencia del punto de filtro elegido. El valor puede cambiarse haciendo clic
en los botones de flecha, usando el teclado, o escribiendo un valor específico. La

gama de frecuencias oscila de 25 Hz a 20 kHz, y el valor determinado en fábrica es “OUT” (desactivado).

Tipo
Indica el tipo de pendiente del filtro seleccionado. Los valores ofrecidos por el
menú varían según si el filtro es atenuador o limitador, como se indica a con-
tinuación.

* Indica el valor fijado en fábrica

Ganancia
Indica el valor de ajuste actual de la ganancia del filtro limitador seleccionado. La gama
de valores disponibles oscila entre –18 dB y +18 dB, en incrementos de 0,5 dB; el

valor por omisión es de 0 dB. El valor puede cambiarse siguiendo las convenciones que se explican en la
sección Controles de nivel en la página 34. Cuando se trabaja con un filtro atenuador, este control queda
desactivado y despliega la palabra “CUT”.

Nota: La curva no representa el efecto cumulativo de los diferentes bloques procesadores 
colocados en la trayectoria de señales. Para acceder a esta ventana seleccione 
[View>Combined Response Curve] (ver>curva de respuesta combinada) del menú princi-
pal. Para mayor información consulte la sección Gráfica de respuesta combinada en la 
página 39.

Limitador Atenuador

6 dB/octava*
12 dB/octava

Butterworth de 6 dB/oct* Butterworth de 18 dB/oct*
Bessel de 6 dB/oct Bessel de 18 dB/oct
Butterworth de 12 dB/oct Butterworth de 24 dB/oct
Bessel de 12 dB/oct Bessel de 24 dB/oct
Linkwitz-Riley de 12 dB/oct Linkwitz-Riley de 24 dB/oct
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Filtros atenuadores y limitadores
Suprimir
Haga clic en este botón para volver a ajustar el filtro a los valores determinados en fábrica. Se
abre el cuadro de diálogo “Clear” (suprimir) (Figura 7-20 en la página 85), el cual le brinda la

alternativa de suprimir los ajustes de todos los filtros, o suprimir sólo los ajustes del filtro seleccionado.

Derivación

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Importación de archivos ASCII
Esta función le permite importar datos de frecuencia de SIA Smaart y Gold Line TEF hacia
la gráfica de respuesta. Una vez colocados en la gráfica, podrá usar estos datos gráficos
como referencia para moldear la curva de respuesta del procesador. Consulte la página 37
para ver las instrucciones sobre cómo importar archivos ASCII.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Ajuste fino de los parámetros
Los parámetros del filtro seleccionado pueden ajustarse con precisión usando cualquiera de los métodos
siguientes:

• Escriba un número en cualquiera de los cuadros de valores de parámetros
• Utilice los botones de flecha (o el menú) junto a los cuadros de valores de parámetros
• Utilice las teclas de control

Teclas de control
Se pueden usar las combinaciones de teclas siguientes para hacer ajustes finos al filtro seleccionado.

Derivación activada Haga clic en este botón para que la señal pase sin ser modifi-
cada. Cuando se activa la derivación, el botón se ilumina en 
rojo. El valor por omisión es el de desactivado.Derivación desactivada

Procesador enlazado

Procesador no enlazado

Tecla Resultado

�
Reduce la frecuencia el equivalente de un 
pixel en la pantalla

�
Aumenta la frecuencia el equivalente de un 
pixel en la pantalla

� Aumenta la ganancia en 0,5 dB
� Reduce la ganancia en 0,5 dB

Mayús + � Reduce la frecuencia por 1/3 octava
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Filtros atenuadores y limitadores
Copiar y pegar
Los valores de ajuste de los puntos de control del filtro pueden copiarse y pegarse entre ventanas de filtros
“Cut and Shelf” (atenuadores y limitadores).

Para copiar y pegar filtros:
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los métodos siguientes:

• Ctrl + Clic.
• Utilice el comando [Edit>Select All] (editar>seleccionar todo) del menú.

2. Utilice el comando [Edit>Copy] (editar>copiar) del menú.
3. Abra la ventana de filtros “Cut and Shelf” (atenuadores y limitadores) en donde se desea pegar los valores.
4. Utilice el comando [Edit>Paste] (editar>pegar) del menú.

Mayús + � Aumenta la frecuencia por 1/3 octava
Mayús + �

o Re página Aumenta la ganancia en 3 dB

Mayús + �
o Av página Reduce la ganancia en 3 dB

Barra espacia-
dora o clic con
botón derecho

Ajusta la ganancia a 0 dB

Supr Reposiciona el o los filtros seleccionados a 
sus valores de ajuste en fábrica

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor de la 
misma cambia en aproximadamente 1/100 de octava, ó 1%

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en rosado y 
los valores de sus parámetros quedan enclavados. Para quitar una selección de 
unidades múltiples seleccionadas, pulse la tecla Esc o haga clic en un control que no 
forme parte del grupo seleccionado.
© 2003 Shure Incorporated Guía del software DFR22 63



Retardo
Retardo

El procesador de retardo almacena la señal temporalmente en la memoria de retardo, y la deja pasar luego de tran-
scurrido el intervalo especificado. El procesador de audio ofrece los tipos siguientes de retardo:

Función
Utilice los bloques de retardo para alinear las señales sonoras reproducidas por altavoces diferentes de modo
que lleguen simultáneamente a los oídos de los miembros de la audiencia. Los bloques de retardo también
pueden usarse para eliminar problemas de cancelación de fase entre altavoces instalados. El retardo puede
calcularse por tiempo, por distancia y en incrementos de la temperatura ambiente. 

Características de la ventana de parámetros
En esta sección se explican las características de los procesadores de retardo usando el DLY150 a manera de
ejemplo, como se ilustra arriba en la Figura 7-9. Las características de los demás retardos son idénticas, salvo
el tiempo máximo de retardo que ofrecen.

Unidades
Utilice este control para especificar si los parámetros deben expresarse en
unidades del sistema inglés o métrico. El valor por omisión es el sistema métrico.

Nombre del 
bloque Descripción

DLY5ms Retardo de 5 milisegundos máximo
DLY150ms Retardo de 150 milisegundos máximo
DLY500ms Retardo de 500 milisegundos máximo
DLY2s Retardo de 2 segundos máximo

Nota: Cada tipo de bloque de retardo consume la cantidad máxima de memoria de retardo que indica 
el nombre del bloque, sin importar cuánto sea el retardo que se utiliza en realidad. Para conser-
var los recursos del procesador de audio, seleccione el procesador de retardo cuyo tiempo se 
aproxime más al tiempo de retardo requerido.

FIGURA 7-9: Ventana de retardo de 150 ms
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Tiempo
Utilice este control para especificar el retardo en milisegundos. La gama de
valores oscila entre 0 y el tiempo máximo de retardo del bloque, en este caso, 150
ms. El valor por omisión es 0.

Distancia
Utilice este control para especificar el retardo según la distancia. La gama de
valores varía, dependiendo del tiempo máximo de retardo; el valor por omisión
siempre es cero. Seleccione la unidad de medida apropiada con los botones

que están a la derecha del control. Cuando se seleccionan unidades del sistema inglés, se puede seleccio-
nar entre pulgadas y pies. Cuando se seleccionan unidades métricas, la distancia se expresa en metros.

Temperatura de aire
Utilice este control cuando se fija el retardo según la distancia, puesto que
la velocidad del sonido se ve afectada por la temperatura del aire. La gama
de temperaturas va de -25°C a 50°C (-13°F a 122°F). Cuando se seleccio-

nan unidades del sistema inglés, la temperatura se expresa en °F. Cuando se seleccionan unidades del
sistema métrico, la temperatura se expresa en °C. La temperatura por omisión es de 20°C (69°F).

Derivación

Suprimir
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste en
fábrica.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Derivación activada Haga clic en este botón para que la señal pase sin ser modifi-
cada. Cuando se activa la derivación, el botón se ilumina en 
rojo. El valor por omisión es el de desactivado.Derivación desactivada

Procesador enlazado

Procesador no enlazado
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Reductor digital de realimentación (DFR)
Reductor digital de realimentación (DFR)

El DFR utiliza el algoritmo de filtro supresor adaptable patentado de Shure, que puede distinguir entre sonidos de real-
imentación y los que no lo son.  Detecta automáticamente la realimentación y activa filtros supresores de banda estre-
cha en las frecuencias en que ésta ocurre. Ningún sistema de sonido (la combinación de micrófonos, mezclado, 
procesamiento de señales, amplificadores de potencia y altavoces) tiene una respuesta de frecuencia totalmente 
plana. Cuando se aumenta el volumen de un sistema de sonido, las frecuencias en las que ocurren los picos serán las 
primeras en sobrepasar el umbral de realimentación. El DFR atenúa dichas frecuencias, haciendo horizontal la gráfica 
de respuesta del sistema de sonido. El sistema podrá entonces funcionar a un nivel total más alto. El procesador de 
audio DFR22 ofrece los tipos siguientes de DFR:

Función
Utilice el DFR como el procesador inicial de cualquier canal de entrada que reciba la señal de un micrófono, en
donde la realimentación causa problemas. Cuando el DFR detecta realimentación, inserta en la trayectoria de
sonido un filtro bajo y estrecho, reduciendo la ganancia en la frecuencia en la que se da la realimentación.
Este filtro se denomina filtro supresor debido a la estrecha sección del espectro de frecuencias que afecta.
Puede usar el factor Q del filtro, desde el menú [Options] del procesador DFR, para especificar la amplitud de
la sección en la que se activarán los nuevos filtros. Para mayor información sobre el ancho de banda de los fil-
tros supresores consulte la sección Filtros de factor Q alto y factor Q bajo en la página 70

Cuando se detecta la presencia de realimentación en cualquiera de los canales, el DFR estereofónico activa
un filtro supresor en ambos canales y a la misma frecuencia y profundidad. De este modo logra mantener la
imagen estereofónica.

Nombre del 
bloque Descripción

DFR5 Reductor digital de realimentación de 
5 bandas

DFR10 Reductor digital de realimentación de 
10 bandas

DFR16 Reductor digital de realimentación de 
16 bandas

ST DFR5
Igual que el anterior: para uso 
en dos canales que forman un 
par estereofónico.

ST DFR10

ST DFR16

1

FIGURA 7-10: Ventana del DFR10

2
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Reductor digital de realimentación (DFR)
Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros del reductor digital de realiment-
ación, usando el DFR10 a manera de ejemplo, como se ilustra arriba en la Figura 7-10. Las características de
los demás DFR son idénticas, salvo el número de filtros supresores disponibles y la funcionalidad estere-
ofónica.

1) Gráfica de respuesta
Esta curva es una representación gráfica del efecto combinado de los filtros supresores activos en el proc-
esador (resaltados en amarillo).

2) Filtro seleccionado actualmente

Esta línea aparece en la gráfica de respuesta, en la frecuencia del filtro actualmente seleccionado, que 
aparece señalado entre dos flechas rojas en la fila de filtros de realimentación.

Frecuencia
Indica la frecuencia del filtro elegido. El valor puede cambiarse haciendo clic en los bot-
ones de flecha, usando el teclado, o escribiendo un valor específico. La gama de fre-
cuencias oscila de 25 Hz a 20 kHz, y el valor determinado en fábrica es “OUT”
(desactivado).

Profundidad
Indica la reducción en la ganancia que introduce el filtro elegido. La gama de valores dis-
ponibles de ganancia oscila entre 0 dB y –18 dB, en incrementos de 0,5 dB; el valor por
omisión es de 0 dB.

Tipo
Indica el tipo de ancho de banda del filtro elegido. Seleccione “HIGH Q” (factor Q alto) o
“LOW Q” (FACTOR Q BAJO) del menú desplegable. El valor por omisión es “HIGH Q”. Para

mayor información consulte Filtros de factor Q alto y factor Q bajo en la página 70.

Filtros supresores de realimentación
Los controles de los filtros supresores de realimentación se despliegan por
medio de una hilera de indicadores tipo LED. Se puede especificar el número de
filtros fijos y dinámicos deslizando los corchetes rojos hacia la izquierda o la
derecha con el Mouse. Los filtros activos se representan en amarillo y aparecen
en la gráfica de respuesta. Para una explicación más detallada consulte la sec-

ción Designación de filtros en la página 70.

Bloquear
Haga clic en este botón para evitar tanto la colocación de filtros nuevos como el aumento en la atenuación
de filtros existentes. Utilice esta función para impedir que el DFR coloque filtros nuevos, para material
sonoro que contenga realimentación deseada, o sonidos muy semejantes a la realimentación (tales como
efectos de guitarra, tonos sintetizados, flauta y órganos de tubos). El botón se ilumina en rojo cuando se
activa la función de bloqueo. El valor por omisión es el de desactivado.

Nota: La curva no representa el efecto cumulativo de los diferentes bloques procesadores colocados en 
la trayectoria de señales. Para acceder a esta ventana seleccione [View>Combined Response 
Curve] (ver>curva de respuesta combinada) del menú principal. Para mayor información consulte 
la sección Gráfica de respuesta combinada en la página 39.

Bloqueo activado

Bloqueo desactivado
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Reductor digital de realimentación (DFR)
Derivación
Haga clic para desactivar los filtros supresores del DFR. La derivación bloquea además el DFR, evitando
la activación de nuevos filtros. Cuando se activa la derivación, el botón se ilumina en rojo. El valor por
omisión es el de desactivado.

Suprimir
Haga clic en este botón para suprimir los ajustes de los filtros. Se abre el cuadro de diálogo
“Clear” (suprimir) (Figura 7-20 en la página 85), el cual le brinda la alternativa de suprimir los
ajustes de todos los filtros, o suprimir sólo los ajustes del filtro seleccionado.

Reposición automática
Haga clic en este botón para abrir el cuadro de diálogo “Auto Clear”, como se explica en la página 72.
Mediante esta función se puede indicar si el DFR debe o no suprimir los filtros dinámicos que se han asig-
nado y cuándo debe hacerlo, y eliminar los cambios en la profundidad de filtros fijos.  El botón se ilumina
en verde cuando esta función se activa. El valor por omisión es el de desactivado.

Panel delantero
Use este control para asignar el procesador DFR a los controles y LED del panel
delantero. Cuando se asigna un DFR al panel delantero, los filtros activos harán que se
iluminen los LED en la fila o filas que se haya indicado, y el procesador se controlará

mediante los botones del panel delantero. Consulte la Guía de instalación para una descripción de los bot-
ones del panel delantero. Sólo puede asignarse un DFR por cada una de las filas del panel delantero. El
valor por omisión es el de “Unassigned” (sin asignar). 

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Derivación activada

Derivación desactivada

Reposición automática 
activada
Reposición automática 
desactivada

Procesador Configuración

DFR 
monofónico:

[Unassigned] (sin asignar)
[Row A] (fila A)
[Row B] (fila B)

DFR estere-
ofónico:

[Unassigned] (sin asignar)
[Rows A & B] (filas A y B)

Nota: En el diagrama de flujo de señales, cuando se copia y pega un bloque DFR que se ha asignado 
al panel delantero, no se asignará el bloque que se acaba de pegar. En el diagrama de flujo de 
señales, cuando se corta y pega un bloque DFR que se ha asignado al panel delantero, éste se 
mantendrá asignado.
© 2003 Shure Incorporated Guía del software DFR22 68
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Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Configuración básica del DFR
Con el DFR (o cualquier otro procesador reductor de realimentación) no podrá aumentar la ganancia por
encima de los límites físicos del sistema de sonido. En la mayoría de los casos, después de haber instalado de
4 a 8 filtros supresores se llega a un punto en el cual el rendimiento empieza a perjudicarse. Esto se debe a
que, en general, en la curva de respuesta de frecuencia de un sistema sobresalen sólo unos cuantos picos. En
la mayoría de los casos se puede anticipar, al emplear el DFR, una mejora de 6 a 9 dB en la ganancia antes
del punto de realimentación. Si está identificando las frecuencias de realimentación de un sistema y nota que
ésta se produce simultáneamente en varias frecuencias, incluso si la ganancia se aumenta lentamente, esto
significa que ha llegado al punto en el cual el rendimiento empieza a perjudicarse. Si después de llegar a este
punto la ganancia del sistema antes de realimentación sigue siendo insuficiente, deberán modificarse otros
factores del sistema de sonido, como la colocación de micrófonos o altavoces.

Hay dos métodos básicos que permiten configurar el DFR para reducir la realimentación: el método de identifi-
cación de frecuencias de realimentación y el método de funcionamiento seguro, descritos a continuación.

• Método de identificación de frecuencias de realimentación: Con este método se utiliza el DFR como 
medida preventiva contra la realimentación en canales de entrada que funcionan cerca del punto de reali-
mentación y que requieren un margen adicional de estabilidad. Al usar este método, se eleva la ganancia 
del canal de entrada más allá de su nivel normal para provocar la realimentación en el sistema. El DFR 
entonces activa los filtros apropiados. Después, cuando se reduce la ganancia de entrada a su nivel 
apropiado, el sistema queda estable y utilizable.

• Método de funcionamiento seguro: Con este método se usa el DFR como medida adicional de preven-
ción de la realimentación en un sistema que funciona de modo estable. Sencillamente se coloca el proce-
sador DFR en la trayectoria de la señal, sin definir ninguno de sus parámetros. Este método se usa en 
sistemas que ya tienen suficiente ganancia antes del punto de realimentación, pero que requieren protec-
ción contra la realimentación que se produce ocasionalmente debido al uso de micrófonos no estacionar-
ios o controles de ganancia ajustables por el usuario.

Para identificar las frecuencias de realimentación del sistema: 
1. Suprima los filtros activos haciendo clic en el botón [CLEAR].
2. El cuadro de diálogo “Clear” aparece.
3. Seleccione [Clear All Filters] (suprimir todos los filtros) y haga clic en [OK].
4. Active todos los micrófonos. 
5. Aumente lentamente la ganancia del sistema de sonido mientras habla frente a los micrófonos, hasta que 

ocurra realimentación en la primera frecuencia. El procesador DFR insertará un filtro supresor para aten-
uar dicha frecuencia. 

6. Cuando haya desaparecido la realimentación en el sistema, podrá aumentar más el volumen y repetir el 
proceso en otras frecuencias. Como valores típicos, podrá aumentar la ganancia entre 3 y 9 dB por 
encima del nivel en el que ocurrió la realimentación por primera vez.

7. Configure los filtros colocados como “fixed” (fijos). (Consulte la sección sobre Designación de filtros, más 
adelante.) Los filtros dinámicos restantes se colocarán según se los necesite cuando el sistema se 
encuentre en uso. 

Procesador enlazado

Procesador no enlazado

Nota: Los filtros fijos pueden copiarse a un bloque de ecualizador paramétrico (PEQ) para permitir la colo-
cación de un número mayor de filtros dinámicos en la ventana del DFR.
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Designación de filtros
Por omisión, la mitad de los filtros del procesador DFR se configuran como fijos, y la mitad restante como
dinámicos. No obstante, podrá indicarse cuántos filtros del número total disponible permanecerán fijos y cuán-
tos se designarán dinámicamente según se detecte la realimentación. Utilice un número mayor de filtros fijos
en canales de entrada conectados a micrófonos estacionarios. En esta situación, las características acústicas
de la sala definen las frecuencias dominantes de realimentación, las cuales no cambian de modo significativo.
Utilice un número mayor de filtros dinámicos en canales de entrada conectados a micrófonos inalámbricos o
de mano. En esta situación, las frecuencias de realimentación cambian significativamente cuando el usuario
del micrófono se desplaza por la sala o por el escenario. La atenuación de los filtros fijos y dinámicos aumen-
tará a medida que se detecta más realimentación.

• Fixed - La frecuencia de un filtro fijo no cambiará a menos que se suprima manualmente el ajuste de todos 
los filtros.

• Dynamic - Si después de haber activado todos los filtros de realimentación se detectan frecuencias de 
realimentación nuevas, el DFR activa en éstas los filtros dinámicos, avanzando de los más antiguos a los 
más nuevos.

Se puede designar la cantidad de filtros fijos y dinámicos utilizando
una de las dos técnicas que se explican a continuación: 

Para usar el cuadro de diálogo “Fixed”:
1. Seleccione [Options>Fixed filters allocation] (opciones>desig-

nación de filtros fijos) del menú de la ventana del DFR.
2. Se visualiza el cuadro de diálogo “Fixed” como se ilustra a la 

derecha en la Figura 7-11.
3. Escriba el número de filtros fijos que se desea designar. El 

número de filtros dinámicos se ajusta de modo correspondiente.
4. Haga clic en [OK].

Para cambiar la designación de filtros con el Mouse:
1. Coloque el cursor entre los corchetes rojos, como se indica a la derecha 

en la Figura 7-12.
2. El cursor se visualiza como el símbolo de ajuste de tamaño horizontal: 

3. Haga clic y arrastre hacia la izquierda para aumentar el número de filtros 
dinámicos, o hacia la derecha para aumentar el número de filtros fijos.

Filtros de factor Q alto y factor Q bajo
El DFR ofrece filtros supresores de dos anchos diferentes, como se ilustra más abajo en la Figura 7-13. Por
omisión, los filtros en el DFR se activan como filtros [HIGH Q] (con factor Q alto). A medida que un filtro con fac-
tor Q alto actúa con más profundidad, el factor Q aumenta hasta un valor de 101 (1/70 de una octava).

Nota: Para designar filtros del panel delantero, pulse el botón de 
reposición automática para que los filtros actualmente activos se 
establezcan como filtros fijos y los inactivos como filtros dinámicos. 
Para mayor información sobre el uso de los controles del panel 
delantero del DFR22, consulte la Guía de instalación. 

FIGURA 7-11: Cuadro de diálogo “Fixed”

Coloque el cursor aquí

o aquí

FIGURA 7-12: Cambio de 
designación de filtros con el Mouse
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También se pueden definir filtros para activarse con [LOW Q] (factor Q bajo).
Los filtros con factor Q bajo afectan a una gama de frecuencias un poco
más amplia, al mantener un valor Q de 14,42 (1/10 de una octava), a
medida que actúan con más profundidad.

• Para modificar el ajuste de un filtro existente, haga clic en el filtro para 
seleccionarlo y utilice el menú desplegable [TYPE].

• Utilice el menú [Options] para seleccionar el factor Q alto o bajo para 
todos los filtros dinámicos nuevos que se coloquen.

Adición, modificación y eliminación de filtros
Para colocar o modificar manualmente un filtro supresor fijo:
1. Haga clic en un filtro fijo activo (resaltado en amarillo) o, para activar un filtro nuevo, seleccione el filtro 

inmediatamente a la derecha del último filtro activo.
2. Ajuste la frecuencia suprimida, la profundidad y el tipo según sea necesario.
3. Las modificaciones hechas se reflejan en la gráfica de respuesta.

Para eliminar todos los filtros supresores activos:
1. Haga clic en el botón [CLEAR].
2. Se despliega el cuadro de diálogo “Clear”, como se ilustra en la 

Figura 7-14.
3. Seleccione [Clear All Filters] (suprimir todos los filtros) y haga clic en [OK].
4. Esto elimina todos los filtros supresores y deja la gráfica de respuesta 

horizontal.
- O -

1. Utilice el comando [Edit>Select All] (editar>seleccionar todo) del menú.
2. Todos los filtros colocados se resaltan en rosado para indicar que han 

sido seleccionados.
3. Pulse la tecla Supr.
Para eliminar filtros supresores específicos
1. Haga clic en el indicador de un filtro para seleccionarlo, o mantenga pulsada la tecla Ctrl y haga clic en 

varios filtros para seleccionarlos simultáneamente.
2. Pulse la tecla Supr - O -

Haga clic en el botón [CLEAR] para abrir el cuadro de diálogo “Clear” y seleccione la opción [Clear Selected 
Filter(s)] (suprimir filtros seleccionados).

Copiar y pegar
Los filtros supresores pueden copiarse y pegarse entre las ventanas de procesador DFR. El software del
DFR22 también ofrece la capacidad de copiar y pegar cualquier filtro activo de la ventana de DFR a la ventana
de un ecualizador paramétrico (PEQ o PEQ + CS). Al desplazar los filtros fijos a la ventana de un PEQ, se
pueden designar más filtros dinámicos con el bloque de DFR. Para conservar recursos de DSP se puede tam-
bién pegar filtros del DFR al PEQ, y eliminar luego el bloque DFR.

Para copiar y pegar filtros:
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los métodos siguientes:

• Mantenga pulsada la tecla Ctrl  y haga clic en cada filtro que desea seleccionar.
• Utilice el comando [Edit>Select All] (editar>seleccionar todo) del menú.

Nota: Sólo se puede seleccionar un filtro activo, o el filtro inactivo adyacente, avan-
zando de izquierda a derecha.

Nota: Es posible que el ancho de banda de los filtros de DFR que se copian a un bloque de PEQ no 
coincida exactamente con el del filtro original; se empleará el ancho de banda que mejor se 
aproxime al del filtro original.

Q alto

Q bajo
FIGURA 7-13: Opciones de ancho de 

banda de supresión

FIGURA 7-14: Cuadro de diálogo 
“Clear”
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2. Utilice el comando [Edit>Copy] (editar>copiar) del menú.
3. Abra la ventana del procesador DFR o PEQ en donde se desea pegar los valores del filtro. Asegúrese de 

seleccionar un bloque procesador con suficientes filtros para aceptar los que acaba de copiar.
4. Utilice el comando [Edit>Paste] (editar>pegar) del menú.

Reposición automática
Por omisión, el DFR retiene el estado de sus filtros cuando se cambia de configuración prefijada, o al
desconectar y volver a conectar la alimentación. No obstante, podrá configurarse el DFR para que borre
automáticamente los filtros dinámicos y los cambios en la profundidad de los filtros fijos, según los parámetros
que se indiquen en el cuadro de diálogo “Auto Clear”, que se ilustra más abajo en la Figura 7-15. Podrá acced-
erse a este cuadro haciendo clic en el botón [AUTO CLEAR] de la ventana del DFR.

Si se ha seleccionado la casilla [Enable Auto Clear] (activar reposición automática) a partir del cuadro de diál-
ogo “Auto Clear”, y se cambia la configuración prefijada o se desconecta y vuelve a conectar la alimentación,
los filtros DFR volverán al estado que tenían al activar la reposición automática.  Puede además indicarse el
período específico tras el cual se eliminarán los filtros dinámicos y los cambios en la profundidad de supresión
de los filtros fijos.

Para activar la reposición automática:
1. Identifique las frecuencias de realimentación del sistema según 

se explica en la sección Configuración básica del DFR en la 
página 69.

2. Ajuste todos los filtros activos como filtros [FIXED] (fijos), según se 
explica en la sección Designación de filtros en la página 70.

3. Haga clic en el botón [AUTO CLEAR].
4. Se despliega el cuadro de diálogo “Auto Clear”, como se ilustra 

en la Figura 7-15.
5. Haga clic en la casilla [Enable Auto Clear] (activar reposición 

automática).
6. Si desea que cada cambio en los filtros se desactive después de 

cierto tiempo, haga clic en la casilla [on timeout] (al cumplirse el 
plazo) e indique dicho período, de 0,1 a 99,0 horas. El valor por omisión es 12 horas. Cada filtro tiene su pro-
pio temporizador, que se inicia a partir del momento en que se configura o se hace más profundo su efecto.

7. Haga clic en [OK].
8. El botón [AUTO CLEAR] de la ventana del DFR se ilumina en verde cuando está activada la reposición 

automática.

Para desactivar la reposición automática:
1. Haga clic en el botón [AUTO CLEAR].
2. Dentro del cuadro de diálogo “Auto Clear”, haga clic de nuevo en la casilla [Enable Auto Clear] para desactivar 

la reposición automática. Los controles de reposición automática aparecerán como inactivos (en tono gris).
3. Haga clic en [OK].
4. En la ventana de DFR los botones de [AUTO CLEAR] aparecerán como inactivos, también en gris.

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en rosado y los 
valores de sus parámetros quedan enclavados. Para quitar una selección de unidades múlti-
ples seleccionadas, haga clic en cualquier control que no forme parte del grupo seleccionado.

Nota: Para instrucciones sobre la manera de fijar estos parámetros mediante los controles del panel 
delantero del DFR22, consulte la Guía de instalación.

Nota: Después de haber efectuado estos pasos la reposición automática estará activada, pero sola-
mente para el procesador DFR actual. Si se desea que otros procesadores DFR supriman 
automáticamente los cambios en los filtros, debe activarse la reposición automática en cada una 
de las ventanas de parámetros de éstos.

FIGURA 7-15: Cuadro de diálogo “Auto Clear”
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Atenuador automático de música

El atenuador automático de música proporciona un medio fácil para usar el DFR22 en un sistema de audio que 
requiere la función de buscapersonas. Cuando hay una señal de buscapersonas presente, el atenuador reduce el vol-
umen de las otras señales.

Función
Coloque el atenuador automático en una fila de canales de entrada para designarla como portador de la señal
de buscapersonas. Cuando la intensidad de la señal de buscapersonas excede el umbral indicado, el atenua-
dor reduce el volumen de las otras señales presentes en cada punto de mezcla de salida con el que esté
conectado. No atenuará las señales presentes en los puntos de mezcla que no estén conectados a la señal de
buscapersonas. Podrá enviarse la señal de buscapersonas a canales de salida en el diagrama de flujo de
señales, la ventana “Matrix Mixer” o haciendo clic en las casillas [Paging Channel] de la ventana “Ducker”.

Nombre del 
bloque Descripción

DUCK Atenuador automático de música

Nota: El atenuador automático sólo puede colocarse en un canal de entrada. No coloque 
más de un atenuador automático en cada canal. Para evitar que se escuchen los rui-
dos extraños recibidos por el canal de buscapersonas, coloque una compuerta delante 
del atenuador automático en el diagrama de flujo señales.

1

2

3

4

FIGURA 7-16: Ventanilla DUCK
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Características de la ventana de parámetros

1) Gráfica de curva de transferencia
La gráfica de la curva de transferencia muestra el nivel de umbral como un elemento gráfico cuya posición
puede ajustarse con el Mouse.

2) Control de umbral
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este control
puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior de la gráfica
de curva de transferencia, para cambiar el valor umbral.

3) Medidor de reducción de ganancia
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal atenuada con
los valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse seleccio-
nando la función [Options>Gain Reduction Meter] (opciones>medidor de reducción de ganancia) del
menú. Su valor por omisión es de activado.

4) Medidor de curva de transferencia
En el modo en vivo, este medidor muestra el nivel de entrada de la señal de buscapersonas, de modo que
se puede fijar el umbral por encima del nivel del ruido ambiental. Esta característica puede desactivarse y
activarse seleccionando la función [Options>Transfer Curve Meter] (opciones>medidor de curva de trans-
ferencia) del menú. Su valor por omisión es de activado.

Indicador de umbral excedido.

Umbral
Esto regula el nivel de ganancia que la señal de buscapersonas debe alcanzar antes de que
el procesador atenúe las señales afectadas por el atenuador automático. El valor puede cam-
biarse haciendo clic en los botones de flecha o escribiendo un valor específico de entre +20

dB y –60 dB. El valor por omisión es 0 dB.

Atenuación
Este control regula la cantidad de reducción aplicada a las señales afectadas por el atenuador
automático cuando el nivel de la señal de buscapersonas excede el umbral. El valor puede
cambiarse haciendo clic en los botones de flecha o escribiendo un valor específico de –1 dB a

–INF. El valor por omisión es –40 dB.

Ataque
Regula el tiempo que el procesador necesita para reducir completamente la ganancia de las
señales atenuadas, después de que el nivel de la señal de buscapersonas haya excedido el
umbral. El tiempo de ataque puede cambiarse haciendo clic en los botones de flecha o escri-
biendo un valor específico. Los valores disponibles oscilan entre 1 y 5000 ms.

Nota: Se puede perjudicar el rendimiento del software si se tienen demasiados medidores activos en 
el DFR22. Se puede desactivar el medidor de la curva de transferencia, o el medidor de reduc-
ción de ganancia, o ambos, con el menú [Options].

El nivel de la señal ha excedido el umbral Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque procesador 
excede el umbral especificado.El nivel de la señal no ha alcanzado el 

umbral
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Retención
Regula el tiempo por el cual el procesador continúa atenuando las señales con el atenuador
automático, una vez que el nivel de la señal de buscapersonas haya caído por debajo del
umbral. Este valor puede cambiarse haciendo clic en los botones de flecha o escribiendo un
valor específico. Los valores disponibles oscilan entre 1 ms y 10.000 ms.

Liberación
Regula el tiempo que el procesador requiere para devolver las señales atenuadas a su nivel
anterior una vez transcurrido el tiempo de retención. Este valor puede cambiarse haciendo
clic en los botones de flecha o escribiendo un valor específico. Los valores disponibles oscilan
entre 1 ms y 10.000 ms.

Ajuste en fábrica
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste
en fábrica.

Derivación

Canales de buscapersonas
Seleccione la casilla correspondiente a cada canal de salida al cual se desea
enviar la señal de buscapersonas. El efecto es el mismo que se obtiene al

emplear el diagrama de flujo de señales o la matriz mezcladora para encaminar la señal desde esta
entrada hacia las salidas. Cualquier otra señal que se encamine hacia los puntos de mezcla de salida
seleccionados será atenuada por la señal de buscapersonas.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Derivación activada Haga clic en este botón para que la señal pase sin ser modi-
ficada. Cuando se activa la derivación, el botón se ilumina en 
rojo. El valor por omisión es el de desactivado.Derivación desactivada

Procesador enlazado

Procesador no enlazado
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Compuerta/expansor de atenuación

La compuerta y el expansor de atenuación reducen el nivel de salida de la señal, en relación con el de entrada, una 
vez que el nivel de la señal de entrada cae por debajo de un umbral especificado.

Función
Utilice estos procesadores para reducir o eliminar los ruidos de fondo no deseados. La compuerta silencia la
señal de entrada una vez que su nivel cae por debajo del umbral especificado. El expansor de atenuación
reduce gradualmente la ganancia una vez que el nivel de la señal de entrada cae por debajo del umbral espe-
cificado, proporcionando una reducción menos perceptible que la compuerta. La compuerta es ideal para elim-
inar ruidos de nivel bajo que de otro modo causarían distracciones durante el programa. Seleccione el
expansor de atenuación para reducir el ruido de fondo en situaciones en las cuales la compuerta interrumpiría
el programa.

Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros del expansor de atenuación y la
compuerta usando el DOWN EXP a manera de ejemplo, como se ilustra en la Figura 7-17. Ambos procesa-
dores funcionan de manera muy similar. Las diferencias entre sus características y sus funciones se indican,
según corresponda.

Nombre del 
bloque Descripción

DOWN EXP Expansor de atenuación
GATE Compuerta

1

2 3

4

56
FIGURA 7-17: Ventana DOWN EXP
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1) Gráfica de curva de transferencia
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como elemen-
tos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante representa
el cambio en el nivel de salida de la señal.

2) Control de umbral
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este control
puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior de la gráfica
de curva de transferencia, para cambiar el valor umbral.

3) Medidor de reducción de ganancia
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal de entrada
con los valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse
seleccionando la función [Options>Gain Reduction Meter] (opciones>medidor de reducción de ganancia)
del menú. Su valor por omisión es de activado.

4) Controles de ganancia
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama de
valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión es de 0
dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección Controles de
nivel en la página 34.

5) Medidor de curva de transferencia
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel relativo
de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro actual. Esta
característica puede desactivarse y activarse seleccionando la función [Options>Transfer Curve Meter]
(opciones>medidor de curva de transferencia) del menú. Su valor por omisión es de activado.

6) Control de relación
La posición del control de relación corresponde con el valor de ajuste del control de relación. Para cambiar
el valor de la relación, deslice el control hacia la derecha o la izquierda a lo largo del borde inferior de la
gráfica de curva de transferencia.

Indicador de umbral excedido

Umbral
Indica el nivel debajo del cual debe caer la señal de entrada antes que el procesador la
atenúe. El valor puede cambiarse por medio de los botones de flecha, escribiendo un valor
específico, o usando el control de umbral que está en el borde superior de la gráfica de la
curva de transferencia. La gama de valores oscila de –80,0 dB a 0 dB en incrementos de
0,5 dB, y su valor por omisión es de –65,0 dB para la compuerta y –40,0 dB para el expan-
sor de atenuación.

Nota: Se puede perjudicar el rendimiento del software si se tienen demasiados medidores activos en 
el DFR22. Se puede desactivar el medidor de la curva de transferencia, o el medidor de reduc-
ción de ganancia, o ambos, con el menú [Options].

El nivel de la señal ha excedido el umbral Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque procesador 
excede el umbral especificadoEl nivel de la señal no ha alcanzado el umbral
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Relación
Indica la cantidad de reducción de ganancia que se obtiene en la salida del procesador, en
relación con el nivel de entrada. Una relación de 4:1, por ejemplo, significa que una reduc-
ción de 1 dB en el nivel del material sonoro produce una reducción de 4 dB en el nivel de sal-

ida del procesador. El valor puede cambiarse por medio de los botones de flecha, escribiendo un valor
específico, o usando el control de relación que está en el borde inferior de la gráfica de la curva de trans-
ferencia. La gama de valores disponibles oscila de 1:1 a infinito:1 en incrementos de una décima, con un
valor por omisión de infinito:1 para la compuerta y de 4:1 para el expansor de atenuación.

Ataque
Indica el tiempo que el procesador espera antes de volver a ganancia unitaria, una vez que
el nivel de la señal de entrada excede el nivel de umbral. La gama de valores disponibles
oscila de 1 ms a 200 ms, con un valor por omisión de 2 ms para la compuerta y 20 ms para

el expansor de atenuación.

Extinción
Indica el tiempo que toma el procesador para alcanzar el nivel de reducción de ganancia
especificado. El valor puede cambiarse haciendo clic en los botones de flecha o escribiendo
un valor específico. La gama de valores disponibles oscila de 50 ms a 1000 ms, con un valor

por omisión de 100 ms para la compuerta y 50 ms para el expansor de atenuación.

Retención
Indica el tiempo que el procesador espera antes de empezar a reducir la ganancia, una vez
que el nivel de la señal de entrada cae por debajo del nivel de umbral. El valor puede cambi-
arse haciendo clic en los botones de flecha o escribiendo un valor específico. Los valores

disponibles oscilan de 0 a 500 ms, y el valor por omisión es de 0.

Ajuste en fábrica
Haga clic en este botón para reposicionar el procesador a sus valores por omisión de ajuste en
fábrica.

Derivación

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Derivación activada Haga clic en este botón para que la señal pase sin ser modi-
ficada. Cuando se activa la derivación, el botón se ilumina en 
rojo. El valor por omisión es el de desactivado.Derivación desactivada

Procesador enlazado

Procesador no enlazado
© 2003 Shure Incorporated Guía del software DFR22 78



Ecualizador gráfico
Ecualizador gráfico

Los ecualizadores gráficos distribuyen un conjunto fijo de filtros de banda ancha y de factor Q constante a lo largo del 
espectro de frecuencias, cada uno de los cuales tiene controles individuales de amplificación/atenuación. El procesa-
dor de audio ofrece los tipos siguientes de ecualizadores gráficos:

Función
Utilice este procesador para la ecualización de banda ancha de una sala. El ancho de banda total del procesa-
dor y el ancho de banda de los filtros individuales dependen del tipo de ecualizador gráfico que se seleccione.
El GEQ10 tiene diez filtros de una octava entre 31,5 Hz y 16 kHz, mientras que el GEQ30 tiene treinta filtros de
1/3 de octava entre 25 Hz y 20 kHz. El GEQ10 se ilustra más arriba en la Figura 7-18.

Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros del ecualizador gráfico, usando el
GEQ10 a manera de ejemplo. El GEQ30 es idéntico, salvo el número de bandas que tiene disponibles y la
gama total de frecuencias que cubren. 

1) Controles de nivel de bandas de frecuencias
Los controles de nivel de cada banda de frecuencias pueden ajustarse arrastrando sus perillas hacia
arriba o hacia abajo con el Mouse o haciendo clic en el punto de la escala graduada correspondiente al
nivel deseado. Se puede amplificar o atenuar cualquier banda entre –18 dB y +12 dB en incrementos de

Nombre del 
bloque Descripción

GEQ10 Ecualizador gráfico de 10 bandas
GEQ30 Ecualizador gráfico de 30 bandas

1

2

FIGURA 7-18: Ventana GEQ10
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0,5 dB. Para mayor información en cuanto al ajuste de los controles de nivel de banda, consulte la sección
Controles de nivel en la página 34.

2) Gráfica de respuesta
En esta curva se hace una representación gráfica de los resultados que producen los ajustes de las ban-
das de frecuencias, y el tipo de factor Q seleccionado para el filtro.

Frecuencia
Indica la banda de frecuencias actual que se está ajustando. Se puede seleccionar una
banda de frecuencias diferente haciendo clic en los botones de flecha. Por omisión, la
selección es la banda de frecuencias más bajas.

Ganancia
Indica el valor de ajuste actual de la ganancia de la banda de frecuencias selec-
cionada. La gama de valores disponibles oscila entre –18 dB y +12 dB, en incrementos
de 0,5 dB; el valor por omisión es de 0 dB. El valor puede cambiarse siguiendo las con-
venciones que se explican en la sección Controles de nivel en la página 34.

Tipo de factor Q del filtro
Indica el tipo de factor Q que se ha designado para todas las bandas de fre-
cuencias. Utilice la lista del menú para cambiar el valor. El valor por omisión es

“COMBINING” (combinada).

Derivación

Respuesta plana
Haga clic en este botón para fijar la ganancia de todas las bandas de frecuencias en cero.

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Importación de archivos ASCII
Esta función le permite importar datos de frecuencia de SIA Smaart y Gold Line TEF hacia
la gráfica de respuesta. Una vez colocados en la gráfica, podrá usar estos datos gráficos

Nota: La curva no representa el efecto cumulativo de los diferentes bloques procesadores colocados en 
la trayectoria de la señal. Para acceder a esta ventana seleccione [View>Combined Response 
Curve] (ver>curva de respuesta combinada) del menú principal. Para mayor información consulte 
la sección Gráfica de respuesta combinada en la página 39.

COMBINADA
Calcula un promedio de las pendientes entre las bandas de fre-
cuencias, creando una curva de ecualización uniforme.

NO COMBINADA
Aísla el resultado del control de cada banda de frecuencias, pro-
porcionando un ajuste más independiente de la ganancia.

Derivación activada Haga clic en este botón para que la señal pase sin ser modi-
ficada. Cuando se activa la derivación, el botón se ilumina en 
rojo. El valor por omisión es el de desactivado.Derivación desactivada
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como referencia para moldear la curva de respuesta del procesador. Consulte la página 37 para ver las
instrucciones sobre cómo importar archivos ASCII.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Copiar y pegar
Se puede usar el menú [Edit] para copiar y pegar valores de ajuste de bandas de frecuencias entre ecual-
izadores gráficos del mismo tipo.

Procesador enlazado

Procesador no enlazado

Nota: No es posible pegar valores de ajuste entre procesadores GEQ10 y GEQ30
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Los ecualizadores paramétricos le permiten especificar la colocación, tipo y ancho de banda de varios filtros en cual-
quier parte del espectro de frecuencias entre 25 Hz y 20 kHz. El procesador de sistema ofrece los tipos siguientes de 
ecualizadores paramétricos:

Función
Utilice este procesador para una ecualización precisa de la respuesta de la sala, sin necesariamente afectar
las frecuencias cercanas. Seleccione el ecualizador paramétrico según el número de bandas de frecuencias
que es necesario ajustar, y según si hay que incluir filtros atenuadores o limitadores en el bloque procesador.
Se pueden conservar los recursos de DSP si se selecciona la cantidad menor de filtros que llene sus
necesidades.

Nombre del 
bloque Descripción

PEQ3
Estos procesadores ofrecen filtros de picos/supresores solamentePEQ5

PEQ7

PEQ10

PEQ3+CS
Estos procesadores ofrecen filtros de picos/supresores, y además un filtro atenu-
ador o limitador de frecuencias bajas y otro filtro atenuador o limitador de frecuen-
cias altas

PEQ5+CS
PEQ7+CS

PEQ10+CS

Nota: El número que aparece en el nombre del bloque indica el número máximo de filtros de picos/
supresores que ese procesador ofrece.

1

2

3 4

6

FIGURA 7-19: Ventana PEQ10 + CS

5
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Características de la ventana de parámetros
En esta sección se explican las características y controles de parámetros de los procesadores tipo ecualizador
paramétrico usando el PEQ10+CS a manera de ejemplo, como se ilustra en la página anterior en la Figura 7-
19. Las características de los demás ecualizadores paramétricos varían únicamente en el número de bandas
que ofrecen y en la disponibilidad de filtros atenuadores/limitadores.

1) Gráfica de respuesta
Esta curva es una representación gráfica del resultado que producen las posiciones de los puntos de con-
trol de filtros fijadas en el graficador de respuesta.

2) Graficador de respuesta
Esta zona de la ventana de parámetros es en donde se colocan y ajustan los filtros paramétricos. Repre-
senta gráficamente a los filtros de picos/supresores con puntos de control circulares y a los filtros atenua-
dores/limitadores con puntos de control cuadrados. Cuando se abre inicialmente la ventana del
procesador, el graficador de respuesta no contiene puntos de filtro y, si corresponde, los filtros atenua-
dores/limitadores aparecen en sus posiciones de ajuste en fábrica. Haga clic en un punto de control de fil-
tro para ver su curva de respuesta y ajustar sus parámetros. Consulte las instrucciones de adición de
puntos de filtro en la sección Cómo trabajar con los filtros en la página 85. 

3) Puntos de filtro
Los filtros de picos/supresores se despliegan en el graficador de respuesta como puntos con controles
ajustables del ancho de banda a sus lados. Haga clic una vez en el punto de control del filtro para selec-
cionarlo, y luego ajustar sus valores con el Mouse, el teclado, o con los cuadros de valores.

4) Filtro seleccionado
Cuando un filtro está seleccionado, aparece resaltado en verde. Su curva actual también aparece resal-
tada en verde en la gráfica de respuesta, respecto a cero.

5) Puntos de control de ancho de respuesta de filtros
Haga clic y arrastre los puntos de control hacia la izquierda o la derecha para disminuir o ampliar el ancho
de banda en que actúa el filtro seleccionado. La posición del punto de control corresponde al valor de
ajuste del control [WIDTH] (ancho).

6) Filtros atenuadores/limitadores
Los filtros atenuadores/limitadores de frecuencias altas y bajas se representan por medio de puntos cuad-
rados. Cada punto cuadrado puede usarse como un filtro atenuador o limitador, dependiendo de su
posición vertical en el graficador de respuesta. Cuando se abre la ventana de parámetros por primera vez,
los puntos cuadrados funcionan como filtros limitadores de frecuencias altas y bajas, ajustados en fábrica
con una ganancia de 0 dB a 20 kHz y 20 Hz, respectivamente. Se convierten en filtros atenuadores
cuando se les arrastra hasta el borde inferior del graficador de respuesta.

Frecuencia
Indica la frecuencia del punto de filtro elegido. El valor puede cambiarse haciendo clic
en los botones de flecha, usando el teclado, o escribiendo un valor específico. La gama

de frecuencias válidas oscila de 25 Hz a 20 kHz, con un valor por omisión de 1 kHz cuando se añade un
punto nuevo de filtro.

Nota: La curva no representa el efecto cumulativo de los diferentes bloques procesadores colocados 
en la trayectoria de la señal. Para acceder a esta ventana seleccione [View>Combined 
Response Curve] (ver>curva de respuesta combinada) del menú principal. Para mayor infor-
mación consulte la sección Gráfica de respuesta combinada en la página 39.
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Ancho/Pendiente/Tipo
La función de este control varía según el tipo de filtro que se encuentre seleccionado, como se indica más
adelante. En un filtro atenuador, hay dos alternativas de pendiente que pueden seleccionarse del menú
desplegable. Cuando se selecciona un filtro de picos/supresor, se puede usar el menú desplegable con
valores predeterminados, o especificar el ancho de banda con una precisión de una milésima de octava
escribiendo el valor deseado. Este control no permite ajustar los filtros limitadores.

Ganancia
Indica el valor de ajuste actual de la ganancia del filtro seleccionado. La gama de
valores disponibles oscila entre –18 dB y +18 dB, en incrementos de 0,5 dB; el valor por

omisión es de 0 dB. Cuando se trabaja con un filtro atenuador, este control queda desactivado y despliega
la palabra “CUT”.

Nuevo
Haga clic en este botón para añadir un nuevo filtro de picos/supresor al graficador de respuesta.
Cuando se abre la ventana por primera vez, el número que aparece debajo del botón indica la
cantidad de puntos de filtro que el ecualizador paramétrico seleccionado ofrece. Este número
disminuye a medida que se añaden puntos de filtro al graficador de respuesta. Cuando se ha uti-
lizado el número máximo de filtros del procesador, este botón queda inactivo.

Suprimir
Haga clic en este botón para suprimir los ajustes de los filtros. Se abre el cuadro de diálogo
“Clear”, el cual le brinda la alternativa de suprimir los ajustes de todos los filtros, o suprimir sólo

los ajustes del filtro seleccionado. Para mayor información consulte la sección Cómo trabajar con los
filtros en la página 85.

Derivación

Imagen instantánea
Esta característica le permite capturar una imagen de la curva de respuesta actual, haciendo
clic en el botón [TAKE], y luego desplegarla en el fondo de la imagen para fines de comparación
haciendo clic en el botón [SHOW]. El botón [SHOW] se ilumina en verde cuando se despliega la
imagen instantánea. Para una descripción más detallada de la característica de imagen
instantánea, vea la sección Imágenes instantáneas en la página 36.

Tipo de filtro Apariencia Gama de valores

Picos/supresor
De 1/70 de octava a 4 octavas; valor por omisión: 2/3 
de octava
De Q = 100,99 a Q = 0,27, valor por omisión: Q = 2,14

Atenuador –6 dB/octava y –12 dB/octava, valor por omisión: –6 dB/
octava

Limitador Ninguno

Derivación activada Haga clic en este botón para que la señal pase sin ser modifi-
cada. Cuando se activa la derivación, el botón se ilumina en rojo. 
El valor por omisión es el de desactivado.Derivación desacti-

vada
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Importación de archivos ASCII
Esta función le permite importar datos de frecuencia de SIA Smaart y Gold Line TEF hacia la
gráfica de respuesta. Una vez colocados en la gráfica, podrá usar estos datos gráficos como
referencia para moldear la curva de respuesta del procesador. Consulte la página 37 para ver
las instrucciones sobre cómo importar archivos ASCII.

Indicador de enlace
Visualiza el estado de enlace del procesador. Todo valor de ajuste que se modifique en un procesador
enlazado afecta a todos los demás procesadores que pertenezcan al mismo grupo de enlace. Para una
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 24.

Cómo trabajar con los filtros
Cuando se abre por primera vez la ventana de parámetros de un ecualizador paramétrico, el graficador de
respuesta no muestra filtros de picos/supresores. Añada los filtros según los necesite, hasta el número máx-
imo disponible en el bloque procesador seleccionado.

Para añadir un punto circular de filtro nuevo:
1. Haga clic en el botón [NEW].
2. Aparece un punto circular de filtro a 0 dB, con una frecuencia por omisión de 1 kHz y un ancho de banda 

de 2/3 de octava.

Para eliminar todos los puntos de filtro:
1. Haga clic en el botón [CLEAR] o seleccione [Edit>Clear Filters] de la 

barra de menús de la ventana de parámetros.
2. Se visualiza el cuadro de diálogo “Clear”, como se ilustra a la dere-

cha en la Figura 7-20.
3. Seleccione [Clear All Filters] y haga clic en [OK]. Esto elimina 

todos los filtros del graficador de respuesta y retorna los filtros 
atenuadores/limitadores a sus valores por omisión.

Para eliminar puntos de filtro específicos:
1. Haga clic en un punto de filtro para seleccionarlo, o mantenga pul-

sada la tecla Ctrl  y haga clic en varios filtros para seleccionarlos 
simultáneamente.

2. Pulse la tecla Supr - O - haga clic en el botón [CLEAR] para abrir el cuadro de diálogo “Clear” y seleccione 
la opción [Clear Selected Filter(s)].

Ajuste de los filtros en el graficador de respuesta
Los ajustes de un filtro pueden cambiarse arrastrando sus puntos de control con el Mouse.

Para ajustar la ganancia y frecuencia:
1. Coloque el cursor sobre el centro del punto de control circular o cuadrado del filtro.

2. El cursor se visualiza como el símbolo de desplazamiento:

3. Haga clic y arrastre el filtro hacia la izquierda o la derecha para ajustar su frecuencia, y hacia arriba o 
hacia abajo para ajustar su ganancia.

Procesador enlazado

Procesador no enlazado

Nota: No es posible eliminar los puntos de control de los filtros atenuadores/limitadores. Sin embargo, 
es posible retornarlos a sus ajustes en fábrica utilizando el botón [CLEAR] o la tecla Supr.

Nota: El graficador de respuesta visualiza la curva sólo del filtro seleccionado. La curva del efecto 
combinado se visualiza en la gráfica de respuesta.

FIGURA 7-20: Cuadro de diálogo “Clear”
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Para ajustar el ancho de banda del punto de filtro:
1. Coloque el cursor sobre cualquiera de los puntos de control de ancho de banda del filtro.
2. El cursor se visualiza como el símbolo de ajuste de tamaño horizontal: 
3. Haga clic y arrastre el punto de control hacia la izquierda o la derecha para ajustar el ancho de banda.

Ajuste fino de los parámetros
Los parámetros del filtro seleccionado pueden ajustarse con precisión usando cualquiera de los métodos
siguientes:

• Escriba un número en cualquiera de los cuadros de valores de parámetros
• Utilice los botones de flecha (o el menú) junto a los cuadros de valores de parámetros
• Utilice las teclas de control

Teclas de control
Se pueden usar las combinaciones de teclas siguientes para hacer ajustes finos al filtro seleccionado.

Copiar, cortar y pegar
Los filtros pueden copiarse, cortarse y pegarse entre dos ventanas de ecualizadores paramétricos, si se
cumplen las condiciones siguientes:

• Hay un número suficiente de filtros disponibles en la ventana de parámetros en donde se desea pegar 
un filtro.

• Los valores de ajuste de filtros atenuadores/limitadores sólo pueden copiarse entre procesadores del 
tipo PEQ+CS.

Para copiar y pegar filtros:
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los métodos sigu-

ientes:
• Ctrl + Clic.
• Utilice el comando [Edit>Select All] (editar>seleccionar todo) del menú.

2. Utilice el comando [Edit>Copy] (editar>copiar) del menú.
3. Abra la ventana del ecualizador paramétrico en donde se desea pegar los valores del filtro.
4. Utilice el comando [Edit>Paste] (editar>pegar) del menú.

Tecla Resultado

� Reduce la frecuencia el equivalente de un pixel en la pantalla

� Aumenta la frecuencia el equivalente de un pixel en la pantalla

� Aumenta la ganancia en 0,5 dB

� Reduce la ganancia en 0,5 dB

Mayús + � Reduce la frecuencia por 1/3 octava

Mayús + � Aumenta la frecuencia por 1/3 octava

Ctrl + � Reduce el ancho de banda de un filtro en intervalos pequeños

Ctrl + � Aumenta el ancho de banda de un filtro en intervalos pequeños

Mayús + �
o Re página Aumenta la ganancia en 3 dB

Mayús + �
o Av página Reduce la ganancia en 3 dB

Barra espaciadora o clic con
botón derecho Ajusta la ganancia a 0 dB

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor de la 
misma cambia en aproximadamente 1/100 de octava, ó 1%

Nota: El comando de cortar no se encuentra disponible para los filtros atenuadores/limitadores.

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en rosado y los valores de sus parámetros 
quedan enclavados. Para quitar una selección de unidades múltiples seleccionadas, haga clic en cualquier control 
de la ventana de parámetros, o en un filtro que no forme parte del grupo seleccionado.
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SECCION 8 Clavijas de control
El conector de clavijas del panel trasero del procesador de audio DFR22 permite conectar los equipos físicos externos
que se deseen, tales como interruptores y potenciómetros para ajustar el volumen, silenciar canales y seleccionar
configuraciones prefijadas. También puede emplearse para realizar la interface con las tarjetas de control lógico Cre-
stron o AMX. Este tipo sencillo de control permite al usuario controlar funciones específicas sin necesidad de una
computadora.

Descripción general de las clavijas de control
El control por dispositivos externos puede establecerse en tres niveles diferentes: conexiones externas, configuración 
de clavijas y designación de procesadores. En la ilustración más abajo el dispositivo se ha configurado para el sigu-
iente control externo:

• Conmutación uno a uno entre dos configuraciones prefijadas.
• Ajuste de la ganancia total de salida del sistema, mediante un potenciómetro.
• Silenciamiento de un canal de entrada, mediante un interruptor de enganche.

Nivel uno: Conexiones externas

Cuando el dispositivo se instala inicialmente, determine el tipo de controles externos que se requieren para el
sistema de sonido y conecte el equipo físico necesario del modo correspondiente. Consulte las instrucciones
y diagramas de alambrado en la Guía de instalación.

Nivel dos: Configuración de clavijas

En el software del DFR22, use la sección “Pin Configuration” (configuración de clavijas) de la ventana de
“Control Pins” (clavijas de control) para seleccionar el equipo físico que está conectado al dispositivo. Esta
configuración se guarda como un ajuste global en el dispositivo, y también puede guardarse como un archivo
de computadora. Consulte las instrucciones en la sección “Pin Configuration” (configuración de clavijas) en la
página 91.

Nivel tres: Designación de procesador

Una vez que el dispositivo ha sido configurado para reconocer los controles externos, designe los canales de
entrada y de salida de las conexiones de control. Use la sección “Processor Mapping” (designación de proce-
sadores) en la ventana de “Control Pins” del software del DFR22. Cada configuración prefijada se designa a
una dirección específica de procesador. Para mayor información consulte la sección “Processor Mapping”
(designación de procesador) en la página 95.

FIGURA 8-1: Los tres niveles de control por dispositivos externos
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Guía sobre las clavijas de control

En esta guía se brindan instrucciones paso por paso para configurar el DFR22 para su control externo. Puede además 
accederse a esta guía haciendo clic en el botón [Tutorial] (guía) en la esquina superior derecha de la ventana “Control 
Pins”, de modo que pueden seguirse las instrucciones a medida que se realizan estos pasos.  Para una explicación 
más completa de las características y funciones de la ventana “Control Pins”, consulte la sección Ventana “Control 
Pins” en la página 91.

A. Entre al modo de diseño y abra la ventana “Control Pins”.
Haga clic en el botón [Design Mode] (modo de diseño) ubicado en la barra de control de la ventana principal y
seleccione [Devices>Control Pin Configuration] (dispositivos>configuración de clavijas de control) del menú
principal.

B. ¿Está configurando las clavijas de control para una selección de configuraciones prefijadas?
• NO: avance hasta el paso D.
• SÍ: especifique el número de configuraciones prefijadas seleccionará en el campo [# Presets].

C. ¿Qué tipo de control se empleará para la conmutación de configuraciones prefijadas?
Indique su selección mediante el menú desplegable, en el campo [Encoding Type] (tipo de codificación).

• Prioridad: una configuración prefijada por clavija de control (use interruptores momentáneos o de enga-
nche). Esta opción conmuta entre un máximo de cuatro configuraciones prefijadas.

• Binario: activa configuraciones prefijadas específicas mediante una combinación de clavijas abiertas y 
cerradas (use interruptores de enganche).

• DRS-10/especial: Interruptor giratorio de 10 posiciones que cambia las configuraciones prefijadas según 
el valor de una resistencia. El DRS-10 es un accesorio opcional de Shure. También puede crearse un cir-
cuito a la medida.  La correspondencia entre el valor de las resistencias y las configuraciones prefijadas se 
da en una tabla en la página 93. Esta opción conmuta entre un máximo de diez configuraciones prefijadas 
y emplea una clavija de control.

Los bloques de conexión en la ventana “Control Pins” designarán el número de clavijas necesarias para conm-
utar las configuraciones prefijadas según los valores que se indiquen en los campos [# Presets] y [Encoding
Type]. Estas clavijas aparecen como el bloque de control de configuraciones prefijadas, en el lado izquierdo de
la ventana.

Nota: Cuando se configuran las clavijas de control para la conmut-
ación de configuraciones prefijadas, se desactiva el selector 
de éstas en el panel delantero del DFR22.

N° máx. de 
configuraciones 
prefijadas

N° de 
clavijas

2 1
4 2
8 3

16 4
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NOTA IMPORTANTE SOBRE LA CONMUTACION DE CONFIGURACIONES PREFIJADAS:
Después de haber habilitado el control de configuraciones prefijadas
usando las clavijas de control, dichas configuraciones no podrán modific-
arse a partir de la computadora o del selector del panel delantero del
DFR22. No obstante, el indicador del panel delantero seguirá indicando la
configuración prefijada que está activa.

Si se necesita conmutar configuraciones prefijadas a partir de la computa-
dora o del panel delantero del DFR22 después de haber habilitado las
clavijas de control, será necesario primero desactivar el bloque de control
de configuraciones prefijadas, a partir de la ventana “Control Pins”.

Para desactivar el bloque de control de configuraciones prefijadas:
1. Haga clic y mantenga pulsada la flecha que está a la derecha del bloque de control de configuraciones 

prefijadas, y seleccione [Disable] (desactivar) del menú desplegable.
2. Cuando se desactiva el bloque, aparece una marca de verificación junto a esta función del menú.  En 

el modo en vivo, el cambio se efectúa en el mismo momento en que se selecciona [Disable]. Si se está 
en modo de diseño, será necesario guardar de nuevo la configuración de clavijas, seleccionando para 
ello [Configuration>Store to Device] (configuración>guardar en el dispositivo) a partir del menú de la 
ventana “Control Pins”.

3. Cuando termine de seleccionar las configuraciones prefijadas desde la computadora, seleccione [Dis-
able] de nuevo para restablecer que el control de selección de éstas se realice por las clavijas de control.

D. ¿Se controlará la ganancia mediante las clavijas de control? 
• NO: avance hasta el paso E.
• SÍ: seleccione un potenciómetro para uno de los bloques de conexión, o 

un interruptor momentáneo en cada uno de los dos bloques de conexión; 
uno para aumentar la ganancia y el otro para reducirla.

Encontrará un menú desplegable a la derecha de cada bloque de conexión.
Para hacer su selección, haga clic y sostenga el botón en la lista de conex-
iones disponibles de equipo físico. Seleccione [Moment] para un interruptor
momentáneo o [Pot] para un potenciómetro.

E. ¿Se controlará el silenciamiento de canales mediante las clavijas 
de control? 
• NO: avance hasta el paso F.
• SÍ: seleccione [Moment] o [Switch] a partir del menú desplegable del bloque de conexión, según los sigu-

ientes parámetros:
> Para producir un silenciamiento al pulsar un interruptor momentáneo, y desactivarlo al volverlo a pul-

sar, seleccione [Moment].
> Para producir un silenciamiento al pulsar y mantener oprimido un interruptor momentáneo, y desacti-

varlo al dejar de pulsar, seleccione [Switch].
> Para activar el silenciamiento en la posición uno y desactivarlo en la posición dos mediante un inter-

ruptor de enganche, seleccione [Switch].

F. Guardar la configuración de clavijas en el dispositivo.
1. Seleccione [Configuration>Store to Device] a partir del menú de la ventana “Control Pins”.
2. Si aparece el cuadro de diálogo “Select Device”, haga clic para seleccionar el DFR22 y luego haga clic 

en [OK].

Nota: Es posible también guardar una configuración de clavijas en la computadora, si no se ha conectado 
al dispositivo, y guardarla en el dispositivo más tarde.  Consulte las instrucciones en la sección “Pin 
Configuration” (configuración de clavijas) en la página 91.

FIGURA 8-2: Desactivación del 
bloque de control de 

configuraciones prefijadas

FIGURA 8-3: Menú desplegable de 
bloque de conexión
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G. ¿Se han guardado todas las configuraciones prefijadas en el dispositivo?
• SÍ: avance hasta el paso H.
• NO: configure y guarde las configuraciones prefijadas en el dispositivo. Para mayor información consulte la 

sección Cómo crear una configuración prefijada en la página 17 y la sección Configuraciones prefijadas 
del dispositivo en la página 30.

H. Si no lo ha hecho aún, efectúe la conexión física del equipo físico de control con las clavijas 
de control del DFR22, de acuerdo a la configuración de éstas que se indicó en la ventana 
“Control Pins”.
• Si se está usando las clavijas de control sólo para la conmutación de configuraciones prefijadas, éste ha 

sido el último paso.
• Si está usando las clavijas de control para el ajuste de ganancia o silenciamiento, continúe con el paso I.

I. Entre al modo en vivo y abra la ventana “Control Pins”.
Haga clic en el botón [Live Mode] (modo en vivo) de la barra de control de la ventana principal y seleccione 
[Devices>Control Pin Configuration] del menú principal.

J. ¿Está empleando potenciómetros?
• NO: avance hasta el paso L.
• SÍ: calibre cada potenciómetro. Haga clic en el botón [Calibrate] debajo del 

bloque de control de potenciómetros, para lanzar la función de calibración. Cada 
potenciómetro debe calibrarse por separado.

 K. Ajuste la gama de ganancias para cada potenciómetro.
1. Haga clic en el botón [Gain Range] (gama de ganancias).
2. Se visualiza el cuadro de diálogo “Range Edit” (editar gamas).
3. Indique los valores mínimo y máximo. 
4. Haga clic en [OK].

L. Asigne los canales de entrada y salida a las conexiones de control.
Los canales de entrada y salida aparecen listados debajo de cada bloque de conexión de clavijas de control.
Haga clic en la casilla de cada canal para efectuar su control.

M. ¿Está empleando interruptores momentáneos para el control de ganancia? 
• NO: avance hasta el paso N.
• SÍ: ajuste el valor de incremento y los valores de ganancia mínimo y máximo.

1. Haga clic en el botón [Gain Up Limit] (límite máximo de ganancia) o [Gain Down Limit] (límite mínimo 
de ganancia).

2. Aparecerá el cuadro de diálogo “Set Gain Maximum” o “Set Gain Minimum”.
3. Indique los valores de incremento y de límite de ganancia.
4. Haga clic en [OK].

Para mayor información consulte Interruptores momentáneos en la página 96.

N. Repita los pasos K a M para cada configuración prefijada guardada en el dispositivo DFR22.

Nota: Si no se calibra un potenciómetro, la calibración por omisión será de 100k 
con variación para audio.

FIGURA 8-4: Botón de 
calibración
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Ventana “Control Pins”

La ventana “Control Pins” es una interface que permite configurar las clavijas de control de modo general, a nivel de 
dispositivo, y designar procesadores de ganancia de entrada y salida para cada unidad de control de modo individual 
para cada configuración prefijada. Acceda a esta ventana seleccionando la función [Devices>Control Pins Configura-
tion] del menú de la ventana principal.

1. Controles de conmutación de configuraciones prefijadas: Use estos controles para indicar cuántas 
configuraciones prefijadas se conmutarán y qué tipo de equipo físico de control se encargará de hacerlo. 
Escriba el número de configuraciones prefijadas primero, y después indique el tipo de codificación.

2. Bloque de control de configuraciones prefijadas: Se hace aquí un despliegue gráfico de las clavijas de 
control que se designan a la conmutación de configuraciones prefijadas. Sus características y present-
ación cambiarán según los ajustes que se hayan indicado en los controles de conmutación de configura-
ciones prefijadas. 

3. Bloque de conexión: En cada bloque se indica el tipo de equipo físico de control que se especificó para 
cada clavija correspondiente. 

4. Menú desplegable de bloque de conexión: Use este menú para indicar el tipo de control para el bloque 
de conexión.

5. Configuración de clavijas: Los valores de ajuste de esta parte de la ventana corresponden al DFR22 a 
nivel de dispositivo. Para mayor información consulte más abajo la sección de configuración de clavijas. 

6. Designación de procesadores: Los valores de ajuste de esta parte de la ventana son exclusivas para 
cada configuración prefijada. Para mayor información consulte “Processor Mapping” (designación de 
procesador) en la página 95.

“Pin Configuration” (configuración de clavijas)

Utilice esta sección de la ventana “Control Pins” para configurar el DFR22 de modo que reconozca correctamente las 
clavijas de control que estén conectadas a equipos externos. Cuando se abre la ventana inicialmente, todas las conex-
iones están desactivadas y no existe diferencia entre las funciones de las clavijas. Una vez que se definen cuántas 
clavijas se utilizarán para el control de configuraciones prefijadas, la pantalla las distribuye al control de configura-

1

2

3 4

5

6

FIGURA 8-5: Ventana “Control Pins”
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“Pin Configuration” (configuración de clavijas)
ciones prefijadas, y las clavijas restantes pueden designarse para controlar la ganancia y el silenciamiento de canales 
de entrada y salida.

Estos valores de ajuste se guardan a nivel del dispositivo. No se guardan con configuraciones prefijadas ni archivos de 
escena, y no cambian cuando se conmuta entre configuraciones prefijadas en el dispositivo. Esta configuración puede 
guardarse en un archivo de computadora si se está trabajando sin estar conectado al DFR22, o como copia de 
respaldo.

Ajustes de la codificación de configuraciones prefijadas
Si se piensa emplear las clavijas de control para conmutar entre configuraciones prefijadas, deberá especific-
arse el valor de dichos controles antes de ajustar cualquier otro parámetro en la ventana “Control Pins”.

Número de configuraciones prefijadas
Use este control para indicar el número de configuraciones prefijadas que se selecciona-
rán mediante las clavijas de control. Podrán seleccionarse de 1 a 16, siendo 1 el valor por
omisión. Escriba un número en esta casilla entes de seleccionar el [Encoding Type] (tipo
de codificación).

Tipo de codificación
Use este control para indicar el modo en que las configuraciones prefijadas se seleccio-
narán mediante las clavijas de control. Los valores de ajuste disponibles varían según el
número de configuraciones prefijadas que se ha especificado en el cuadro de valores [#
Presets], como se explica más abajo. El valor por omisión es “None” (ninguna).

Codificación prioritaria o uno a uno

Mediante este ajuste se designa cada conexión de clavija al número de una con-
figuración prefijada única. De este modo se podrá conmutar entre un máximo de
cuatro configuraciones prefijadas. Use interruptores momentáneos o de enga-
nche para este tipo de codificación.

En el bloque de control de configuraciones prefijadas aparecerá un cuadro de
texto correspondiente a cada clavija de control. Los valores por omisión corre-
sponden a las configuraciones prefijadas uno a cuatro. Podrá indicar números dis-
tintos haciendo clic en cada cuadro de texto y escribiendo un número de uno a
dieciséis.  Si el usuario pulsa accidentalmente una combinación de interruptores
al hacer una selección, el dispositivo cambiará a la configuración prefijada en la
posición [Highest Priority] (nivel de prioridad más alto).

Nota: Hay que estar en modo de diseño para crear o modificar la configuración de las clavijas.

Nota: Después de haber establecido la conmutación de configuraciones prefijadas mediante las clavi-
jas de control, se desactiva el selector de éstas en el panel delantero y la computadora no podrá 
emplearse para cambiarlas. En el modo en vivo podrán desactivarse las clavijas de control haci-
endo clic en el bloque de control de configuraciones prefijadas, o seleccionando [Disable] (des-
activar) del menú desplegable a la derecha de dicho bloque de control. Cuando está desactivado 
el bloque aparecerá como inactivo, en color gris. Para restablecer el control externo de configu-
raciones prefijadas, en el modo en vivo, seleccione de nuevo “Disable”, o haga clic en el bloque 
de control de configuraciones prefijadas.

FIGURA 8-6: Bloque de 
control de 

configuraciones 
prefijadas para 

codificación prioritaria
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Codificación binaria

Este ajuste permite seleccionar configuraciones prefijadas mediante un ajuste
binario en las entradas de control, como aparece debajo del bloque de control de
configuraciones prefijadas.  De este modo se podrá conmutar entre hasta 16
configuraciones prefijadas. Use interruptores de enganche para este tipo de
codificación. El código binario corresponde al estado lógico en las entradas de
las clavijas de control.

• 0 lógico = clavija con voltaje
• 1 lógico = clavija puesta a tierra

Cada ajuste binario de las clavijas de control tiene su correspondi-
ente cuadro de texto. Los valores por omisión empiezan en configu-
ración prefijada uno para el ajuste binario 0, y aumentan hasta llegar
a dieciséis, para el ajuste binario 1111. Podrá cambiar la configu-
ración seleccionada por los distintos valores lógicas haciendo clic en
cada uno de los cuadros de texto y escribiendo el número de otra
configuración prefijada, de uno a dieciséis. Consulte en el Apéndice
A: Tablas de codificación binaria para los valores por omisión de las
configuraciones prefijadas.

Codificación del interruptor DRS10 ó el interruptor especial

Usando este ajuste se pueden seleccionar configuraciones prefijadas
según un valor correspondiente de resistencia, en la entrada de las clavijas
de control. Se podrá seleccionar un máximo de diez configuraciones prefija-
das usando este tipo de codificación. El DRS10 es un accesorio opcional de
Shure. También puede crearse un circuito especial. 

Bloques de conexión
El número de bloques de conexión que aparece en la ventana
depende de cuántas clavijas están disponibles después de haber
especificado el control de configuraciones prefijadas. Asigne
equipo físico de control a una clavija haciendo una selección del
menú desplegable que aparece en el lado derecho del bloque. La
unidad de control puede activarse y desactivarse de modo alter-
nado haciendo clic en el bloque con el botón izquierdo del Mouse,
o seleccionando la función [Disable] del menú desplegable.

Interruptor de enganche [Switch]
Seleccione el interruptor de enganche para silenciar canales de entrada y de salida. Esta selec-
ción se usa generalmente para una unidad de control externo que se conmuta entre dos posi-
ciones. También puede usarse con un interruptor de contacto momentáneo, en cuyo caso el
canal permanece silenciado mientras se mantenga oprimido el interruptor y el silenciamiento se
desactiva al soltarlo.

N° DE CONFIGU-
RACIÓN PREFIJADA 

VALOR DE 
RESISTENCIA

N° DE CONFIGU-
RACIÓN PREFIJADA 

VALOR DE 
RESISTENCIA

1 97 k� – ��� 6 7,8 – 9,3 k�
2 44 – 60 k� 7 5,2 – 6,3 k�
3 26 – 32 k� 8 3,3 – 4,1 k�
4 17 – 20 k� 9 1,9 – 2,5 k�
5 11,3 – 13,6 k� 10 0,63 – 1,1 k�

Nota: En modo de diseño, para activar o desactivar las conexiones del equipo, deberá primero guardar 
en el dispositivo la configuración de clavijas.

FIGURA 8-7: Bloque de 
control de configuraciones 

prefijadas para 
codificación binaria

Codificación binaria de configu-
raciones prefijadas

N° máx. de configu-
raciones prefijadas

N° de 
clavijas

2 1
4 2
8 3

16 4

FIGURA 8-8: Bloque de control 
de configuraciones prefijadas 

para codificación del interruptor 
DRS10 ó el especial

Conexión
activada

Conexión 
desactivada

FIGURA 8-9: Bloques de conexión
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Interruptor de contacto momentáneo [Moment]
Seleccione el interruptor momentáneo para silenciar canales de entrada y de salida. Esta selec-
ción es para un interruptor momentáneo externo que activa o desactiva el silenciamiento cada
vez que se oprima. También puede usarse para incrementar o reducir la ganancia. Si se usa

para incrementar la ganancia, será necesario indicar primero la ganancia mínima y máxima, así como el
valor del incremento, para cada configuración prefijada. Para mayor información consulte la sección Inter-
ruptores momentáneos en la página 96.

Potenciómetro [Pot]
Utilice los controles de potenciómetro para ajustar la ganancia de entrada o salida. Haga clic en
el botón [Calibrate] para calibrar el la entrada de control dentro de la gama del potenciómetro
conectado. Si no se calibra un potenciómetro, la calibración por omisión será de 100k con vari-
ación para audio, con una tolerancia de +/–20%.

Creación de una nueva configuración de clavijas de control para el dispositivo
1. Entre al modo de diseño.
2. Seleccione [Devices>Control Pin Configuration] (dispositivos>configuración de clavijas de control) del 

menú principal.
3. La ventana “Control Pins” se abre.
4. Configure el control de configuraciones prefijadas.

a) Escriba la cantidad de configuraciones en el cuadro de valores [# Presets].
b) Seleccione el tipo de codificación del menú [Encoding Type].
c) Aparece el bloque de clavijas de control de configuraciones prefijadas.
d) Si se está utilizando codificación prioritaria o binaria, escriba los números correctos de configura-

ciones prefijadas bajo el bloque de control.
5. Configure las clavijas restantes como unidades de control externo haciendo la selección correspondi-

ente del menú que está a la derecha de cada bloque de conexión.
6. Seleccione la opción [Configuration>Store to Device] (configuración>guardar en dispositivo) del menú.
7. Si aparece el cuadro de diálogo “Select Devices”, seleccione el dispositivo y luego haga clic en [OK].
8. La configuración de las clavijas se guarda en el dispositivo

Cómo guardar la configuración de clavijas de control en la computadora
1. Efectúe los pasos 1 – 5 anteriores.
2. Seleccione la opción [Configuration>Save to PC] (configuración>guardar en computadora) del menú.
3. Se despliega el cuadro de diálogo “Save Config As” (guardar configuración como).
4. Seleccione el directorio deseado, escriba el nombre que se desea dar al archivo y haga clic en [OK].
5. La configuración se guarda en la computadora en un archivo cuya extensión es “.d22pin”.

Cómo editar una configuración de clavijas de control en el dispositivo
1. Entre al modo de diseño.
2. Seleccione [Devices>Control Pin Configuration] del menú principal.
3. La ventana “Control Pins” se abre.
4. Seleccione la opción [Configuration>Recall From Device] (configuración>recuperar del dispositivo) 

del menú.
5. Si aparece el cuadro de diálogo “Select Devices”, seleccione el dispositivo y luego haga clic en [OK].
6. La ventana “Control Pins” aparece indicando la configuración actual de las clavijas.
7. Haga las modificaciones que sean necesarias.
8. Seleccione la opción [Configuration>Store to Device] (configuración>guardar en dispositivo) del menú.
9. Si aparece el cuadro de diálogo “Select Devices”, seleccione el dispositivo y luego haga clic en [OK].
10. La configuración de las clavijas se guarda en el dispositivo.
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“Processor Mapping” (designación de procesador)

Utilice esta sección de la ventana “Control Pins” para definir cuáles canales de entrada y de salida serán controlados 
por el equipo externo. Los canales de entrada y salida aparecen listados en una columna debajo de cada bloque de 
conexión al cual se ha asignado una unidad de control. Para que los equipos externos puedan controlar la ganancia y 
el silenciamiento de canales, cada configuración prefijada del dispositivo debe designarse a las conexiones de control.

Los procesadores pueden designarse en modo en vivo o en modo de diseño. Cuando se está en modo en vivo, la barra 
de títulos de esta sección de la ventana aparece en azul; en modo de diseño, aparece en negro. En el modo en vivo, los 
cambios en la designación de procesadores se guardan directamente y se aplican a la configuración prefijada vigente.

Designación de las unidades de control a los canales de entrada y salida
Cualquier combinación de canales de entrada y salida puede designarse a una unidad de control. Para los
interruptores momentáneos, son tres las posibles funciones de designación para cada canal: incrementar
ganancia, reducir ganancia, y silenciamiento. Cada canal de entrada o de salida puede designarse sólo a una
de estas tres funciones a la vez. Por ejemplo, no puede designarse simultáneamente el mismo canal para
incrementar ganancia y silenciamiento.

Para designar un canal de entrada o salida a una unidad de control:

• Haga clic en una casilla para designar el canal de entrada o salida correspondiente a la unidad de control.
• Haga clic de nuevo en la casilla para anular su selección.

Ajuste de controles de ganancia
Además de la designación de canales de entrada y salida al control de ganancia, deberá también indicarse la
gama de valores dentro de la cual el usuario podrá ajustar la ganancia. Ya que esto forma parte de la desig-
nación de procesadores, estos valores se guardan individualmente junto con cada configuración prefijada.

Potenciómetros
Debajo de cada bloque de control de potenciómetro encontrará el botón
[Set Gain Range] (ajustar gama de ganancia). Si no se especifica dicha
gama para cada control, pasará al valor por omisión, que es de �� dB a
+10 dB.

Para ajustar la gama de ganancia de un potenciómetro:
1. Haga clic en el botón [Set Gain Range] (ajustar gama de ganancia).
2. Se visualiza el cuadro de diálogo “Range Edit” (editar gamas).
3. Escriba los ajustes mínimo y máximo permitidos para ganancia. El 

nivel mínimo es �� dB y el máximo es +10 dB.
4. Haga clic en [OK].

Nota: Antes de crear una designación de procesadores, es necesario configurar las clavijas de con-
trol y guardar dicha configuración en el dispositivo.

Casilla de procesador seleccionada 
para designación.

Casilla deseleccionada.

FIGURA 8-10: Designación de 
procesadores con potenciómetros
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Interruptores momentáneos
Debajo de cada bloque de control de interruptores momentáneos
encontrará los botones [Set Gain Max] (ajustar ganancia máx.) y
[Set Gain Min] (ajustar ganancia mín.). Además de ajustar la
ganancia mínima y máxima de un interruptor momentáneo dis-
puesto como control de ganancia, estos botones permiten fijar el
incremento, en dB, por el que el control aumenta o reduce la
ganancia. Cuando se oprime un control de ganancia, de inmediato
aumenta o reduce la ganancia según la cantidad indicada. Cuando
se oprime y se mantiene oprimido un control de ganancia, de inme-
diato aumenta o reduce la ganancia según la cantidad indicada.
Después de un retardo de 1000 ms, continuará aumentando o
reduciendo la ganancia cada 120 ms que el control se mantenga
oprimido.

Si no se especifica la ganancia máxima y el incremento para un
control de aumento de ganancia, se empleará el valor por omisión,
que es de +10 dB en incrementos de 2 dB. Si no se especifica la
ganancia mínima y el incremento para un control de reducción de
ganancia, se empleará el valor por omisión, que es de �� dB en
incrementos de 2 dB.

Para ajustar los límites de ganancia de un interruptor momentáneo:
1. Haga clic para seleccionar un canal de entrada o salida para control de aumento de ganancia.
2. Haga clic en el botón [Gain Up Limit] (límite máximo de ganancia).
3. Aparece el cuadro de diálogo “Set Gain Maximum” (fijar ganancia máx.).
4. Escriba el límite máximo de ganancia (máximo de +10 dB).
5. Escriba el incremento por el que aumentará la ganancia cada vez que se oprima el interruptor 

(máximo de 10 dB). 
6. Haga clic en [OK].
7. Haga clic para seleccionar un canal de entrada o salida para control de reducción de ganancia.
8. Haga clic en el botón [Gain Down Limit] (límite mínimo de ganancia).
9. Aparece el cuadro de diálogo “Set Gain Minimum” (fijar ganancia mín.).
10. Escriba el límite mínimo de ganancia (mínimo de -� dB). 
11. Escriba el incremento por el que se reducirá la ganancia cada vez que se oprima el interruptor (máx-

imo de 10 dB). 
12. Haga clic en [OK].

Cómo crear la designación de procesadores
Al designar equipo externo a las entradas y salidas que se desea controlar, se crea la designación de procesa-
dores. Podrá usarse cualquiera de los métodos siguientes:

• En el modo en vivo, se crea una designación de procesadores para cada configuración prefijada 
del dispositivo, una por una.

• En el modo de diseño, abra un archivo de configuración prefijada de la computadora, o recupérela 
del dispositivo, y guarde entonces con ella una designación de procesadores. 

Para crear una designación de procesadores en el modo en vivo:
1. Entre al modo en vivo y pase a la configuración que desea modificar.
2. Seleccione [Devices>Control Pin Configuration] (dispositivos>configuración de clavijas de control) del 

menú principal.
3. Se abre la ventana “Control Pins” con los canales de entrada y salida indicados bajo los bloques de conexión.
4. Por cada bloque de conexión designado, haga clic en las casillas de designación de procesadores, junto a 

los canales que serán controlados por el equipo conectado.

FIGURA 8-11: Designación de 
procesadores por interruptores 

momentáneos
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“Processor Mapping” (designación de procesador)
5. Indique la gama de ganancia de los potenciómetros y los limites y el incremento de ganancia de cualquier 
interruptor momentáneo que se emplee para control de ganancia. 

6. La designación se guarda automáticamente con la configuración prefijada en el dispositivo cada vez que 
se efectúe un cambio en el modo en vivo. 

7. Para crear otra designación de procesadores, pase a otra configuración prefijada (no es necesario cerrar 
la ventana “Control Pins”).

Para crear una designación de procesadores en el modo de diseño:
1. Entre al modo de diseño.
2. Haga clic en el botón [Open] de la barra de control de la ventana principal.
3. Se visualiza el cuadro de diálogo “Open Preset” (abrir configuración prefijada).
4. Seleccione el archivo deseado de configuración prefijada y haga clic en [OK].
5. La configuración prefijada seleccionada se visualiza en el diagrama de flujo de señales.
6. Seleccione [Devices>Control Pin Configuration] (dispositivos>configuración de clavijas de control) de la 

ventana principal.
7. La ventana “Control Pins” se abre.
8. Cargue la configuración de clavijas apropiada usando uno de los métodos siguientes:

• Seleccione la opción [Configuration>Open from PC] (configuración>abrir archivo de la computadora) 
del menú y abra un archivo con extensión “.d22pin” que haya guardado en la computadora.

• Si se está conectado al DFR22, seleccione la opción [Configuration>Recall from Device] (configu-
ración>recuperar del dispositivo) del menú.

• Si no ha creado una configuración de clavijas, consulte la sección “Pin Configuration” (configuración 
de clavijas) en la página 91.

9. Por cada bloque de conexión designado, haga clic en las casillas de designación de procesadores, junto a 
los canales que serán controlados por el equipo conectado.

10. Retorne a la ventana principal (no es necesario cerrar la ventana “Control Pins”).
11. Guarde el archivo de configuración prefijada en la computadora (consulte las instrucciones en la sección 

Modificación de archivos de configuración prefijada en la página 29).

Nota: Deberá crearse una designación de procesadores para cada configuración prefijada del disposi-
tivo con la que se desea que funcionen las unidades control.
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SECCION 9 Seguridad
La seguridad es una característica opcional que le permite al instalador, u otro administrador de seguridad, restringir el
acceso del usuario a los ajustes del DFR22 mediante el panel delantero o la computadora.

Bloqueo de panel delantero

El acceso a los controles del panel delantero puede bloquearse de modo que 
el usuario no pueda cambiar los ajustes del procesador DFR ni modificar 
configuraciones prefijadas. Para bloquear todos los controles del panel 
delantero, coloque en su posición hacia abajo el quinto interruptor DIP en el 
panel trasero del dispositivo.  Mediante el software se puede sobrepasar el 
interruptor DIP y bloquear selectivamente controles específicos, dejando abi-
erto el acceso a otros.

Para un bloqueo selectivo del acceso al panel delantero:
1. Seleccione [Security>Front Panel Lockout] (seguridad>bloqueo 

del panel delantero) del menú principal.
2. Se despliega el cuadro de diálogo “Front Panel Lockout”, como 

se ilustra en la Figura 9-1.
3. Haga clic en la casilla [Override and Disable Dip Switch] (sobre-

paso y desactivación del interruptor DIP).
4. Haga clic en las casillas que están junto a cada control del panel delantero cuyo acceso desea bloquear a 

los usuarios.

Podrá emplear una contraseña para proteger los valores de bloqueo, de modo que solo el administrador de seguridad 
pueda modificar el bloqueo del panel delantero con la computadora. Para más información, consulte la siguiente sec-
ción sobre acceso por computadora.

Restricción del acceso por computadora

El administrador es el individuo que fija la contraseña del dispositivo y el nivel de acceso al cual funcionará después 
de haberlo instalado. Hay tres niveles de acceso diferentes para los usuarios del dispositivo:

Nivel uno
Cuando el dispositivo se fija al nivel uno, el usuario tiene acceso sin restricciones a las funciones del proc-
esador de audio, salvo dos funciones que siempre están protegidas por la contraseña del administrador:

1. Fijación del nivel de seguridad del dispositivo.
2. Cambio de la contraseña del administrador.

Nivel dos
Cuando se fija el dispositivo en nivel dos, el usuario tiene acceso limitado a las funciones, según lo define
el administrador de seguridad. Se puede permitir el acceso a las funciones siguientes del DFR22 en nivel
dos:

• Cambios en la configuración prefijada por medio de la computadora.
• Cambios en el encaminamiento de señales de la matriz mezcladora.
• Cambios a la configuración de bloqueo del panel delantero.
• Acceso para modificar los ajustes de los procesadores que no han sido bloqueados por el administra-

dor (para mayor información consulte la sección Seguridad de procesadores individuales en la 
página 101).

Nota: Para cambiar la configuración de seguridad (salvo la seguridad de los procesadores individuales) 
es necesario estar conectado al dispositivo.

FIGURA 9-1: Cuadro de diálogo 
“Front Panel Lockout”
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Restricción del acceso por computadora
Nivel tres
Este nivel permite acceso de sólo lectura a los ajustes del DFR22 para la configuración activa actual.

Establecimiento de seguridad del dispositivo
El establecimiento del nivel de seguridad debe ser la fase final de la configuración del dispositivo. Hay dos
pasos principales para configurar la seguridad del dispositivo: 

1. Creación de una contraseña
2. Determinación del nivel de acceso del usuario

Creación de una contraseña
Antes de poder fijar el nivel de acceso de los usuarios en el dispos-
itivo, es necesario establecer una contraseña que proteja su nivel
de acceso como administrador de seguridad.

Para crear una contraseña:
1. Seleccione [Security>Set Password] (seguridad>establecer 

contraseña) del menú principal.
2. Se visualiza el cuadro de diálogo “Create Password” (crear 

contraseña), como se ilustra en la Figura 9-2.
3. Escriba una contraseña en el campo [Administrator Password] 

(contraseña del administrador).
4. Utilice la tecla Tab para avanzar al campo [Confirm Password] 

(confirmar contraseña) y escríbala de nuevo.
5. Llene los campos [Administrator Name] (nombre del administrador) y [Phone or Contact info] (teléfono 

o información de contacto).

Fijación del nivel de acceso del usuario
Una vez que se ha creado la contraseña, el dispositivo se fija
automáticamente en el nivel uno de acceso del usuario. Si es nece-
sario restringir el acceso al dispositivo, fije el nivel de acceso
apropiado.

Para fijar el nivel de acceso del usuario:
1. Seleccione [Security>Level] (seguridad>nivel) del menú principal.
2. Se visualiza el cuadro de diálogo “Input Password” (escribir 

contraseña) como se ilustra a la derecha en la Figura 9-3.
3. Escriba la contraseña y haga clic en [OK].
4. Se visualiza el cuadro de diálogo “Set Security Level” (fijar nivel 

de seguridad), como se ilustra en la Figura 9-4.
5. Haga clic en el botón que está a la izquierda del nivel deseado.
6. Especifique las opciones personalizadas para el nivel dos, si 

corresponde.
7. Haga clic en [OK].

Nota: La función de seguridad sólo afecta el acceso a través del software y el panel delantero. 
No restringe el control por dispositivo externo a través de las clavijas de control.

Nota: Todos los campos del cuadro de diálogo “Create Password” tienen un límite de quince 
caracteres de largo.

FIGURA 9-2: Cuadro de diálogo 
“Create Password”

FIGURA 9-3: Cuadro de diálogo 
“Input Password”

FIGURA 9-4: Cuadro de diálogo 
“Set Security Level”
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Restricción del acceso por computadora
Modificación de seguridad del dispositivo
En caso tal que sea necesario hacer modificaciones a la configuración del dispositivo o a la seguridad después
de haber restringido el acceso, primero es necesario volver a fijar el nivel de acceso de seguridad al nivel uno.

Cambio del nivel de acceso
Siga las instrucciones anteriores para fijar el nivel de acceso.

Cambio de la contraseña
Para cambiar una contraseña existente:
1. Seleccione [Security>Set Password] (seguridad>establecer con-

traseña) del menú principal.
2. Se visualiza el cuadro de diálogo “Set Password”, como se ilustra 

en la Figura 9-5. El cursor estará dentro del campo [Old Pass-
word] (contraseña anterior).

3. Introduzca la contraseña actual.
4. Pulse la tecla Tab para avanzar al campo [Administrator Pass-

word] y escriba la contraseña nueva.
5. Utilice la tecla Tab para avanzar al campo [Confirm Password] 

(confirmar contraseña) y escriba de nuevo la nueva contraseña.
6. Llene los campos [Administrator Name] (nombre del administra-

dor) y [Phone or Contact info] (teléfono o información de contacto), de ser necesario.
7. Haga clic en [OK].

Eliminación de restricciones de seguridad
Las funciones de seguridad del dispositivo pueden reposicionarse completamente a su estado de fábrica
para permitir que otros individuos definan niveles de acceso de usuario.

Para eliminar la protección por contraseña:
1. Seleccione [Security>Set Password] (seguridad>establecer contraseña) del menú principal.
2. Se visualiza el cuadro de diálogo “Set Password”, como se ilustra más arriba en la Figura 9-5.
3. Escriba la contraseña actual en el campo [Old Password].
4. Si se desea, borre el nombre del administrador y la información de contacto.
5. Deje los campos [Administrator Password] y [Confirm Password] en blanco.
6. Haga clic en [OK].
7. Se eliminan todas las restricciones de acceso.

Nota: Se requiere la contraseña del administrador para efectuar estas funciones.

Nota: Todos los campos del cuadro de diálogo “Set Password” tienen un límite de quince 
caracteres de largo.

Nota: Los atributos de seguridad de los procesadores individuales permanecen inalterados, pero 
no se encuentran en efecto hasta que se ponga el dispositivo en nivel de acceso dos.

FIGURA 9-5: Cuadro de diálogo 
“Set Password”
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Restricción del acceso por computadora
Seguridad de procesadores individuales
El sistema de seguridad de procesadores individuales bloquea el acceso a bloques procesadores específicos
en una configuración prefijada. Se puede bloquear el acceso a un solo bloque, a bloques múltiples, o a todos
los bloques de una configuración prefijada. Esta función se utiliza, por ejemplo, si se desea que el usuario
pueda cambiar el ajuste de la ganancia, pero no los ajustes de un ecualizador paramétrico. Un procesador blo-
queado puede abrirse para supervisar sus niveles o ver sus valores de ajuste.

Si bien el nivel de acceso del usuario es específico según el dispositivo, el nivel de seguridad de los bloques
procesadores individuales es específico para cada configuración prefijada. Además, el nivel de seguridad de
cada procesador individual es un atributo independiente de cada bloque. Por ejemplo, se puede fijar el atributo
de bloqueo de un bloque, y si se copia dicho bloque, el atributo de seguridad también se incluye en la copia. El
atributo permanece sin importar si se está trabajando en modo de diseño o en modo en vivo.

Para bloquear bloques procesadores:
1. Ponga el dispositivo en modo en vivo.
2. Verifique que el dispositivo ha sido fijado al nivel de seguridad 1.
3. Haga clic sobre un bloque procesador para seleccionarlo, o mantenga pulsada la tecla Ctrl y haga clic 

sobre varios bloques para seleccionarlos.
4. Seleccione [Security>Level 2>Lock Selected] (seguridad>nivel 2>bloqueo seleccionado) del menú princi-

pal.
5. Aparece una marca de verificación junto a esta función del menú para indicar que el procesador seleccio-

nado está bloqueado.
6. Fije el dispositivo al nivel de acceso dos, como se explica en la sección Fijación del nivel de acceso del 

usuario en la página 99.

Nota: La seguridad de procesadores individuales sólo aplica para el caso de acceso por computadora. 
No afecta al acceso a los ajuste de procesadores si hechos mediante el panel delantero o las 
clavijas de control.
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SECCION 10 Impresión de informes
El software del DFR22 le permite imprimir informes que documentan todas las configuraciones prefijadas y valores de
ajuste almacenados en el dispositivo. Estos informes han sido diseñados para los usos siguientes.

1. Para documentar la configuración del dispositivo para el cliente y el usuario.
2. Para proporcionar copias impresas de respaldo que permitan reconstruir la configuración del dispositivo, 

de ser necesario.

Para imprimir informes con el DFR22:
1. Seleccione [Edit>Print] (editar>imprimir) del menú principal.
2. Se visualiza el cuadro de diálogo “Choose Report” (seleccionar 

informe), como se ilustra a la derecha en la Figura 10-1.
3. Haga clic para seleccionar el tipo de informe que desea imprimir.
4. Aparece un cuadro de diálogo que corresponde al tipo de informe 

elegido.
5. Especifique la información que desea incluir en el informe, según 

se describe en la sección siguiente.
6. Haga clic en [OK].
7. Se visualiza el cuadro de diálogo de impresión de Windows.

Información del dispositivo

La información del dispositivo indica toda la información a nivel del dispositivo, salvo la contraseña de seguridad. 
Cuando se abre el cuadro de diálogo “Device Information” (información del dispositivo), seleccione el dispositivo para 
el cual se desea imprimir el informe de la lista ofrecida por el menú [Device]. Introduzca la información pertinente al 
dispositivo seleccionado y haga clic en [OK]. La información que se introduce aquí aparece sólo en el reporte impreso; 
no se almacena para uso futuro. Vea la página 104 para una muestra de este informe.

Nota: Los informes se envían directamente a una impresora, en lugar de a un archivo, por lo cual es 
necesario estar conectado a una impresora para poder usar esta función.

FIGURA 10-1: Cuadro de diálogo 
“Choose Report”

FIGURA 10-2: Cuadro de diálogo “Device”
© 2003 Shure Incorporated Guía del software DFR22 102



Información de configuraciones prefijadas e información de configuración prefijada actual
Información de configuraciones prefijadas e información de 
configuración prefijada actual

El informe de configuraciones prefijadas contiene los detalles de una configuración prefijada específica que ha sido 
almacenada en el dispositivo. Cuando se abre el cuadro de diálogo “Individual Presets from Device” (configuraciones 
prefijadas individuales del dispositivo), seleccione el dispositivo para el cual se desea imprimir el informe de la lista 
ofrecida por el menú desplegable [Device]. Después seleccione la configuración prefijada para la cual se desea 
imprimir un informe y haga clic en [OK]. Vea las páginas 105 y 106 para una muestra de este informe.

El informe de configuración prefijada actual es idéntico. Incluye los detalles de la configuración prefijada desplegada 
en la pantalla en el momento.

Información de procesadores

El informe de procesadores contiene los valores de ajuste de uno o más 
bloques procesadores. El cuadro de diálogo “Individual Processor Blocks” 
(bloques procesadores individuales) muestra una lista de todos los proce-
sadores fijos y opcionales de la configuración prefijada actual. Haga clic en 
un procesador para seleccionarlo, o mantenga pulsada la tecla Mayús y 
haga clic en varios procesadores para seleccionarlos, y luego haga clic en 
[OK].Vea la página 107 para una muestra de este informe.

FIGURA 10-3: Cuadro de diálogo 
“Individual Presets from Device”

FIGURA 10-4: Cuadro de diálogo 
“Currently Displayed Preset”

FIGURA 10-5: Cuadro de diálogo 
“Individual Processor Blocks”
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Muestras de informes
Muestras de informes

DEVICE INFORMATION

Location: 4325 W. Division, Chicago

Client: Sacred Heart School

Designer: Bob Reiling

Installer: RC Communications

System Description:

Main Gymnasium Audio Processor

Installation Information:

ShureLink Device ID: 15

Device Name: Gymnasium

Hardware Information:

Control Input Configuration:
Pin-1: Encoding Type: Priority, Mapped to preset: 1
Pin-2: Encoding Type: Priority, Mapped to preset: 2
Pin-3: Switch
Pin-4: Potentiometer

Preset Information:
Total Presets: 4

Preset 1 Concert
Preset 2 Assembly
Preset 3 Game
Preset 4 Dance

1 of 1 February 1, 2003, 11:11AM
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Muestras de informes
PRESET INFORMATION:

Preset ID: 2

Preset Name: Assembly

Description: Preliminary tuning.

Control Input Pin Mapping:
Pin-1: Reserved for Preset Control - See Device Information
Pin-2: Reserved for Preset Control - See Device Information
Pin-3: Mutes: Input 1 2
Pin-4: Gains: Input 1 2, Gain Range: -inf to 0 dB

1 of 2 February 1, 2003, 11:12AM
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Muestras de informes
Drag and Drop Processors:

Input-1, Slot-1, Processor: DFR16
Input-1, Slot-2, Processor: PEQ 10CS
Input-1, Slot-3, Processor: GEQ30
Input-1, Slot-4, Processor: LIM
Input-1, Slot-5, Processor: N/A

Input-2, Slot-1, Processor: DFR16
Input-2, Slot-2, Processor: PEQ 10CS
Input-2, Slot-3, Processor: GEQ30
Input-2, Slot-4, Processor: LIM
Input-2, Slot-5, Processor: N/A

Output-1, Slot-1, Processor: DLY 2s
Output-1, Slot-2, Processor: N/A
Output-1, Slot-3, Processor: N/A
Output-1, Slot-4, Processor: N/A
Output-1, Slot-5, Processor: N/A
Output-1, Slot-6, Processor: N/A

Output-2, Slot-1, Processor: DLY 2s
Output-2, Slot-2, Processor: N/A
Output-2, Slot-3, Processor: N/A
Output-2, Slot-4, Processor: N/A
Output-2, Slot-5, Processor: N/A
Output-2, Slot-6, Processor: N/A

2 of 2 February 1, 2003, 11:13AM
© 2003 Shure Incorporated Guía del software DFR22 106



Muestras de informes
PROCESSOR INFORMATION:

Input Gain Block
Security: Unlocked
Input-1: Name: Music, Operating Level: +4 dBu, Polarity: +, Gain: –4.5dB, Mute: Off, Link Group N/A
Input-2: Name: Speech, Operating Level: +4 dBu, Polarity: +, Gain: 0.0dB, Mute: Off, Link Group N/A

1 of 2 February 1, 2003, 11:12AM

Input-1, Slot-1, Processor: DFR16
Name: DFR 16, Link Group: N/A, Security: Unlocked
Bypass: Off
Autoclear: Disabled
Front Panel Assignment: ROW A
Fixed Filters: 3, New Filters: High
Filter: 1, Freq: 65Hz, Depth: –3.0dB, Type: HighQ
Filter: 2, Freq: 171Hz, Depth: –3.0dB, Type: HighQ
Filter: 3, Freq: 2.5kHz, Depth: –3.0dB, Type: HighQ

Input-1, Slot-2, Processor: PEQ10CS
Name: PEQ with CS, Link Group: N/A, Security: Unlocked
Bypass: Off
Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB
Filter: H, Type: Shelf, Freq: 10kHz, Gain: -18.5dB
Filter: 3, Freq: 4.3kHz, Gain: –9.0dB, Width(oct): 2/3, Width(Q): 2.14
Filter: 4, Freq: 0.7kHz, Gain: –4.5dB, Width(oct): 1.249, Width(Q): 1.12
Filter: 5, Freq: 0.2kHz, Gain: –9.0dB, Width(oct): .350, Width(Q): 4.11
Filter: 6, Freq: 0.1kHz, Gain: –6.0dB, Width(oct): 1, Width(Q): 1.41
Filter: 7, Freq: 6.8kHz, Gain: –6.0dB, Width(oct): 1/6, Width(Q): 8.65

Input-1, Slot-3, Processor: GEQ30
Name: Graphic EQ, Link Group: N/A, Security: Unlocked
Bypass: Off, Filters Type: Combining
Filter: 31.5 Hz, Gain: 1.5dB Filter: 800 Hz, Gain: –1.5dB Filter: 8kHz, Gain: 3.0 dB
Filter: 250 Hz, Gain: 0.5dB Filter: 3.15kHz, Gain: –0.5dB Filter: 16 kHz, Gain: 0.5dB

Input-1, Slot-4, Processor: LIM
Name: Limiter, Link Group: N/A, Security: Unlocked
Bypass: Off
Threshold: 9.5 dB, Attack: 2ms, Ratio: 100.0, Decay: 50ms
Input Gain: 0.00, Output Gain: 0.00
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SECCION 11 Apéndice A: Tablas de codificación binaria
Las tablas siguientes ilustran la codificación binaria para las configuraciones prefijadas del DFR22. Utilice este
sistema de codificación en las clavijas de las entradas de control para seleccionar la configuración prefijada deseada
en el dispositivo.

Nota: 0 = Clavija con voltaje, 1 = Clavija puesta a tierra

TABLE 1. Codificación binaria con una clavija

N° DE CONFIGU-
RACIÓN PREFIJADA

CLAVIJA 
1

1 0
2 1

TABLE 2. Codificación binaria con dos clavijas

N° DE CONFIGU-
RACIÓN PREFIJADA

CLAVIJA 
1

CLAVIJA 
2

1 0 0
2 0 1
3 1 0
4 1 1

TABLE 3. Codificación binaria con tres clavijas

N° DE CONFIGU-
RACIÓN PREFIJADA

CLAVIJA 
1

CLAVIJA 
2

CLAVIJA 
3

1 0 0 0
2 0 0 1
3 0 1 0
4 0 1 1
5 1 0 0
6 1 0 1
7 1 1 0
8 1 1 1
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TABLE 4. Codificación binaria con cuatro clavijas

N° DE CONFIGU-
RACIÓN PREFIJADA

CLAVIJA 
1

CLAVIJA 
2

CLAVIJA 
3

CLAVIJA 
4

1 0 0 0 0
2 0 0 0 1
3 0 0 1 0
4 0 0 1 1
5 0 1 0 0
6 0 1 0 1
7 0 1 1 0
8 0 1 1 1
9 1 0 0 0

10 1 0 0 1
11 1 0 1 0
12 1 0 1 1
13 1 1 0 0
14 1 1 0 1
15 1 1 1 0
16 1 1 1 1
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SECCION 12 Apéndice B: Utilización de recursos de 
DSP por cada procesador
La tabla siguiente indica el porcentaje de recursos de DSP que cada procesador utiliza. Los recursos de DSP se deter-
minan por la combinación específica de procesadores que se está utilizando.

Categoría Nombre del 
bloque Descripción % DSP

Ecualizadores 
gráficos

GEQ10 Ecualizador gráfico de 10 bandas 4,5

GEQ30 Ecualizador gráfico de 30 bandas 9,8

Ecualizadores 
paramétricos

PEQ 3 Ecualizador paramétrico de 3 bandas 2,6

PEQ 5 Ecualizador paramétrico de 5 bandas 3,2

PEQ 7 Ecualizador paramétrico de 7 bandas 3,7

PEQ 10 Ecualizador paramétrico de 10 bandas 4,5

PEQ 3 + CS Ecualizador paramétrico de 3 bandas con filtros 
atenuadores/limitadores 3,2

PEQ 5 + CS Ecualizador paramétrico de 5 bandas con filtros 
atenuadores/limitadores 3,7

PEQ 7 + CS Ecualizador paramétrico de 7 bandas con filtros 
atenuadores/limitadores 4,2

PEQ 10 + CS Ecualizador paramétrico de 10 bandas con filtros atenua-
dores/limitadores 5,0

CUT/SHELF Filtros atenuadores/limitadores de frecuencias altas y bajas 3,4

Reductores de 
realimentación

DFR 5 Reductor digital de realimentación de 5 bandas 14,3

DFR 10 Reductor digital de realimentación de 10 bandas 15,9

DFR 16 Reductor digital de realimentación de 16 bandas 17,8

ST DFR 5 Reductor digital estereofónico de realimentación de 
5 bandas 28,6

ST DFR 10 Reductor digital estereofónico de realimentación de 10 ban-
das 31,7

ST DFR 16 Reductor digital estereofónico de realimentación de 16 ban-
das 35,5

Retardos DLY 5ms Retardo de 5 ms máximo 4,7

DLY 150ms Retardo de 150 ms máximo 4,7

DLY 500ms Retardo de 500 ms máximo 4,7

DLY 2s Retardo de 2 segundos máximo 4,7

Rango dinámico COMP Compresor 2,6

Sft COMP Compresor � de articulación suave opcional 2,9

ST COMP Compresor estereofónico 5,2

Sft ST COMP Compresor estereofónico � de articulación suave opcional 7,0

LIM Limitador 2,6

Sft LIM Limitador � de articulación suave opcional 2,9

ST LIM Limitador estereofónico 5,2

Sft ST LIM Limitador estereofónico� de articulación suave opcional 7,0

AGC Control automático de ganancia 7,7

GATE Compuerta 3,1

DOWN EXP Expansor de atenuación 3,1

PEAKLIM Limitador de picos 3,7

DUCK Atenuador automático de música 3,9

Redes de cruce XOVER 2 Red de cruce de 2 vías 3,2

SUB Subwoofer 4,5

Bifurcador SPLIT 2 Bifurcador de 2 vías 0,0
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SECCION 13 Apéndice C: Extensiones de archivos
La tabla siguiente indica las extensiones de los nombres de los archivos de diferentes tipos creados por el
software del DFR22.

Extensión de 
archivo Fuente

.agc Control automático de ganancia

.backup Respaldo de todo el dispositivo

.cdk Ganancias de entrada y salida

.comp Compresor

.cutshf Filtros atenuadores/limitadores de frecuencias altas y bajas

.d22 Archivo de configuración prefijada

.d22pin Configuración de clavijas de control

.dfr10 Reductor digital de realimentación de 10 bandas

.dfr16 Reductor digital de realimentación de 16 bandas

.dfr5 Reductor digital de realimentación de 5 bandas

.dly150ms Retardo de 150 ms máximo

.dly2s Retardo de 2 segundos máximo

.dly500ms Retardo de 500 ms máximo

.dly5ms Retardo de 5 ms máximo

.duck Atenuador automático de música

.exp Expansor de atenuación

.gate Compuerta

.geq10 Ecualizador gráfico de 10 bandas

.geq30 Ecualizador gráfico de 30 bandas

.lim Limitador

.mix Matriz mezcladora

.peaklim Limitador de tope de picos

.peq10 Ecualizador paramétrico de 10 bandas

.peq10cs Ecualizador paramétrico de 10 bandas con filtros atenuadores/limitadores

.peq3 Ecualizador paramétrico de 3 bandas

.peq3cs Ecualizador paramétrico de 3 bandas con filtros atenuadores/limitadores

.peq5 Ecualizador paramétrico de 5 bandas

.peq5cs Ecualizador paramétrico de 5 bandas con filtros atenuadores/limitadores

.peq7 Ecualizador paramétrico de 7 bandas

.peq7cs Ecualizador paramétrico de 7 bandas con filtros atenuadores/limitadores

.softcomp Compresor con articulación suave opcional

.softlim Limitador con articulación suave opcional

.softstcomp Compresor estereofónico con articulación suave opcional

.softstlim Limitador estereofónico con articulación suave opcional

.stcomp Compresor estereofónico

.stdfr10 Reductor digital estereofónico de realimentación de 10 bandas

.stdfr16 Reductor digital estereofónico de realimentación de 16 bandas

.stdfr5 Reductor digital estereofónico de realimentación de 5 bandas

.stlim Limitador estereofónico

.sub Subwoofer

.xover2 Red de cruce de 2 vías
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SECCION 14 Apéndice D: Guía para la localización de averías
Falla de comunicaciones entre la computadora y el DFR22:
Los mensajes siguientes se despliegan en la pantalla cuando el software DFR22 pierde comunicaciones con
el dispositivo.

“COM(port) is already in use or does not exist...” (el puerto COM está en uso o no existe)
Este mensaje aparece bajo las condiciones siguientes:

• Existe otro programa que está utilizando el puerto COM especificado.

Si el puerto COM está siendo utilizado por otro programa, si se sale de dicho programa, se resuelve el
problema. Un ejemplo de programa que mantiene un puerto COM ocupado es HotSync Manager y
otros programas similares utilizados para sincronizar la computadora y dispositivos de mano tales
como el Palm Pilot™. Puede ser difícil cerrar estos programas puesto que generalmente funcionan en
el fondo. Consulte el manual del usuario del programa. Las computadoras de escritorio generalmente
tienen más de un puerto serial físico en su equipo. En tal caso, si se selecciona un puerto COM difer-
ente y se conecta el cable de comunicaciones del P4800 a un puerto serial diferente, se puede
resolver el problema.

• El puerto serial de la computadora ha sido desactivado.

Ejecute el programa de configuración de la BIOS para activar el puerto serial. Al hacerlo, observe los
valores de ajuste del puerto serial (IRQ y dirección de E/S) y verifique que Windows tenga un puerto
COM configurado con esos mismos valores. Después, elija ese puerto COM con el software DFR22.

“Network not ready...” (interrupción de red)
Esto indica que el software del DFR22 abrió el puerto COM con éxito, pero no halló ningún dispositivo
conectado al mismo. Verifique que el DFR22 se encuentre encendido y que haya terminado su secuencia
de arranque antes de intentar comunicarse con la máquina. Si la computadora tiene más de un puerto
COM, verifique que se haya conectado el cable de la red al mismo puerto COM seleccionado en el cuadro
de diálogo “Select COM Port” (selección de puerto COM).

Verifique que se está utilizando un cable serial de comunicaciones con el alambrado correcto y que está
bien conectado a tanto la computadora como el DFR22. Consulte la Guía de instalación para mayor infor-
mación.

“No devices detected...” (no se detectaron dispositivos)
El software del DFR22 ha detectado un dispositivo distinto al DFR22 conectado al puerto COM seleccio-
nado. Este dispositivo puede ser un módem u otro dispositivo de comunicaciones en serie, tal como un
DFR11EQ. Si se selecciona el puerto COM al cual se ha conectado el P4800, se resuelve este problema.

El indicador de configuración prefijada del DFR22 presenta una “E” seguida de un 
número:

• Hay una configuración prefijada dañada en la memoria del dispositivo, la cual debe ser eliminada. Si 
el problema continúa después de haber seguido las instrucciones dadas a continuación, comu-
níquese con el Applications Group de Shure.

Para eliminar una configuración prefijada dañada:
1.Abra el software del DFR22, active el modo de diseño y seleccione la función [File>Delete Preset] 

(archivo>borrar configuración prefijada).
2. Elimine todas las configuraciones prefijadas que se visualicen como “**corrupted**”. Si la configu-

ración prefijada activa resulta ser la causante del problema, haga clic en [Cancel].
3. Seleccione [File>New>Blank] (archivo>nuevo>en blanco) para generar una configuración prefi-

jada en blanco, y luego seleccione [File>Store Preset] (archivo>guardar configuración prefijada) 
para sobreescribir la configuración prefijada activa con la configuración en blanco.
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• El proceso de actualización del firmware ha sido interrumpido. Esta condición puede resolverse sigu-
iendo las instrucciones dadas a continuación. Si el problema continúa, comuníquese con el Applica-
tions Group de Shure.

Para completar la actualización del firmware:
1. Apague el dispositivo y vuélvalo a encender.
2. Del menú [File], seleccione [Firmware Upgrade].
3. Cuando el software le presenta el indicativo de actualizar el código, haga clic en [Continue].

• Como última medida, reinicialice el sistema. De este modo se borran todas las configuraciones prefija-
das y ajustes del dispositivo y se restablecen sus valores por omisión.

Para reinicializar el sistema:
1. Apague el dispositivo.
2. Mantenga oprimidos los botones Press to Lock/Hold to Clear y Bypass de la hilera A mientras se 

enciende el DFR22.
3. El indicador de configuración prefijada contará regresivamente a medida que se efectúa la reini-

cialización.

No es posible seleccionar configuraciones prefijadas desde la computadora:
• Revise el nivel de seguridad del dispositivo. Para poder seleccionar configuraciones prefijadas desde 

la computadora, el dispositivo deberá estar fijado en nivel de seguridad 1, o nivel personalizado 2. 
Para mayor información consulte la sección Seguridad en la página 98.

• Si se ha activado la función de cambio de configuraciones prefijadas con clavijas de control, la unidad 
no responde a comandos de cambiar de configuración del software. Para resolver este problema, des-
active las clavijas de control de cambio de configuraciones prefijadas en la ventana “Control Pins”. 
Para mayor información consulte la sección “Pin Configuration” (configuración de clavijas) en la 
página 91.

No es posible seleccionar configuraciones prefijadas desde el panel delantero del 
dispositivo:

• El interruptor DIP número 5 del panel trasero está en posición hacia abajo. Súbalo para desbloquear 
los controles del panel delantero.

• El bloqueo del panel delantero está activado para el selector de configuraciones prefijadas en el soft-
ware del DFR22. Seleccione [Security>Front Panel Lockout] (seguridad>bloqueo del panel delantero) 
del menú principal, y deseleccione la casilla [Preset Selector] en el cuadro de diálogo “Front Panel 
Lockout”.

• Si se ha activado la función de cambio de configuraciones prefijadas mediante clavijas de control, la 
unidad no responderá a los cambios en las configuraciones hechos a partir del panel delantero. Para 
resolver este problema, desactive las clavijas de control de cambio de configuraciones prefijadas en la 
ventana “Control Pins”. Para mayor información consulte la sección Seguridad en la página 98.
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